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DISKLAIMER (DISCLAIMER)

Penerbit tidak menjamin kebenaran dan keakuratan isi/informasi yang tertulis di
dalam buku tek ini. Kebenaran dan keakuratan isi/informasi merupakan tanggung

jawab dan wewenang dari penulis.

Penerbit tidak bertanggung jawab dan tidak melayani terhadap semua komentar
apapun yang ada didalam buku teks ini. Setiap komentar yang tercantum untuk
tujuan perbaikan isi adalah tanggung jawab dari masing-masing penulis.

Setiap kutipan yang ada di dalam buku teks akan dicantumkan sumbernya dan
penerbit tidak bertanggung jawab terhadap isi dari kutipan tersebut. Kebenaran
keakuratan isi kutipan tetap menjadi tanggung jawab dan hak diberikan pada
penulis dan pemilik asli. Penulis bertanggung jawab penuh terhadap setiap
perawatan (perbaikan) dalam menyusun informasi dan bahan dalam buku teks
ini.

Penerbit tidak bertanggung jawab atas kerugian, kerusakan atau
ketidaknyamanan yang disebabkan sebagai akibat dari ketidakjelasan,
ketidaktepatan atau kesalahan didalam menyusun makna kalimat didalam buku
teks ini.

Kewenangan Penerbit hanya sebatas memindahkan atau menerbitkan
mempublikasi, mencetak, memegang dan memproses data sesuai dengan

undang-undang yang berkaitan dengan perlindungan data.
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KATA PENGANTAR

Puji syukur kami panjatkan kepada Tuhan yang Maha Esa atas tersusunnya
buku teks ini, dengan harapan dapat digunakan sebagai buku teks untuk siswa
Sekolah Menengah Kejuruan (SMK) Bidang Studi Teknologi Informasi dan
Komunikasi.

Penerapan kurikulum 2013 mengacu pada paradigma belajar kurikulum abad 21
menyebabkan terjadinya perubahan, yakni dari pengajaran (teaching) menjadi
BELAJAR (learning), dari pembelajaran yang berpusat kepada guru (teachers-
centered) menjadi pembelajaran yang berpusat kepada peserta didik (student-
centered), dari pembelajaran pasif (pasive learning) ke cara belajar peserta didik
aktif (active learning-CBSA) atau Student Active Learning-SAL.

Buku teks "Pengolahan Citra Digital” ini disusun berdasarkan tuntutan paradigma
pengajaran dan pembelajaran kurikulum 2013 diselaraskan berdasarkan
pendekatan model pembelajaran yang sesuai dengan kebutuhan belajar
kurikulum abad 21, yaitu pendekatan model pembelajaran berbasis peningkatan
keterampilan proses sains.

Penyajian buku teks untuk Mata Pelajaran " Pengolahan Citra Digital " ini disusun
dengan tujuan agar supaya peserta didik dapat melakukan proses pencarian
pengetahuan berkenaan dengan materi pelajaran melalui berbagai aktivitas
proses sains sebagaimana dilakukan oleh para ilmuwan dalam melakukan
eksperimen ilmiah (penerapan scientifik), dengan demikian peserta didik
diarahkan untuk menemukan sendiri berbagai fakta, membangun konsep, dan
nilai-nilai baru secara mandiri.

Kementerian Pendidikan dan Kebudayaan, Direktorat Pembinaan Sekolah
Menengah Kejuruan, dan Direktorat Jenderal Peningkatan Mutu Pendidik dan
Tenaga Kependidikan menyampaikan terima kasih, sekaligus saran kritik demi
kesempurnaan buku teks ini dan penghargaan kepada semua pihak yang telah
berperan serta dalam membantu terselesaikannya buku teks siswa untuk Mata
Pelajaran Pengolahan Citra Digital kelas Xl/Semester 1 Sekolah Menengah
Kejuruan (SMK).

I"

Jakarta, 12 Desember 2013
Menteri Pendidikan dan Kebudayaan

Prof. Dr. Mohammad Nuh, DEA
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GLOSARIUM

CDR adalah format file CorelDRAW

Citra bitmap adalah gambar yang sangat baik untuk merepresentasikan gambar
yang sangat komple ks dan detail, ukuran filenya tergantung dari ukuran gambar

dan resolusinya.

Citra vektor adalah merupakan gambar digitalyang berdasarkan persamaan

matematis.

CorelDraw adalah satu satu aplikasi pengolah citra vektor yang banyak

digunakan oleh editor grafis

Color palette adalah daftar pilihan warna yang berada disebelah kanan lembar

kerja CorelDraw

Outline Pen merupakan tool untuk menampilkan daftar yang berisi pilihan untuk
menentukan ketebalan garis tepi suatu objek dan menentukan warna garis tepi

suatu objek.

Pen tool merupakan tool untuk membuat garis lurus maupun garis lengkung

dengan tanda point / titik sebagai acuannya.

Pick tool adalah pada toolbox diatas untuk memilih, memiringkan / memutar,

serta mengubah ukuran gambar

Shape tool adalah tool untuk membuat berbagai bentuk objek seperti objek

bentuk kotak, lingkaran, segi banyak, dan objek-objek dengan bentuk lain.

Shortcut key adalah perintah singkat yang dilakukan dengan menekan tombol

dikeyboard untuk mewakili suatu perintah tertentu

Toolbox adalah bagian yang memuat tombol-tombol perintah yang digunakan

untuk membuat dan memaodifikasi objek.
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PETA KEDUDUKAN BAHAN AJAR

Peta kedudukan bahan ajar merupakan suatu diagram yang menjelaskan
struktur mata pelajaran dan keterkaitan antar mata pelajaran dalam satu
kelompok bidang studi keahlian. Gambar 1. menjelaskan peta kedudukan bahan
ajar untuk program studi keahlian Multimedia. Kelompok C1 merupakan
kelompok mata pelajaran wajib dasar bidang studi keahlian. C2 merupakan
kelompok mata pelajaran wajib dasar program keahlian dan C3 merupakan

kelompok mata pelajaran wajib paket keahlian.

C3 : Multimedia
Kena Proyek

rMuitmedia nteraiT! e

Teknik Pengambiian
Gambar Bargarak

-
I I
ResalgMultimesia Jeknik Anmas 1eEnik ADimas
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 EEEEEEEEEE——— -_”M.i Oporas Dosos
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Web { 1
- —— Perakitan SMuEas:
’ Komputet Dwita
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|
Permurograman Gred Komputor Frska

Daosar

Gambar 1. Peta Kedudukan Bahan Ajar Kelompok C3 Mata Pelajaran
Pengolahan Citra Digital
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Sementara itu peta konsep mata pelajaran menjelaskan struktur urutan
kegiatan belajar dan topik materi pelajaran. Gambar 2 dibawah ini menjelaskan

peta konsep mata pelajaran Pengolahan Citra Digital untuk kelas XI semester 2.

Sy A
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A D WO Ry
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Daph oy
™™
A W)
Iy Ol ot Gombyy n) -« o
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Gambar 2. Peta Konsep Mata Pelajaran Pengolahan Citra Digital Semester 2
Kelas Xl
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BAB 1 PENDAHULUAN

A. Diskripsi.

Pengolahan Citra Digital adalah salah satu mata pelajaran wajib dasar
program keahlian Teknik Komputer dan Informatika (TKI). Berdasarkan struktur
kurikulum mata pelajaran Pengolahan Citra Digital-2 disampaikan di kelas Xl
semester 2, 4 jam pelajaran per minggu. Untuk semester 2 topik materi
pembelajaran menekankan pada pengenalan citra vektor danpengolahan citra
bitmap

Dalam desain komunikasi visual, teks maupun obyek grafis serta warna
memainkan peranan sangat penting dalam keberhasilan suatu bentuk seni
komunikasi grafis. teks maupun obyek grafis serta warna bukan lagi sebagai
pelengkap statement visual, tetapi sudah menjadi sajian utama komunikasi grafis
yang berbentuk buku, katalog atau brosur. Sehingga sangat penting untuk
mempelajari teks maupun obyek grafis serta warnapada perancangan desain
grafis yang mengandung unsure estetika . Citra bitmap pengembangan karya
grafis sesuai dengan kaidah-kaidah pembuatan karya grafis.

Pembelajaran Pengolahan Citra Digital ini menggunakan metode
pendekatan scientifik. Dalam pendekatan ini praktikum atau eksperimen berbasis
sains merupakan bidang pendekatan ilmiah dengan tujuan dan aturan khusus,
dimana tujuan utamanya adalah untuk memberikan bekal ketrampilan yang kuat
dengan disertai landasan teori yang realistis mengenai fenomena yang akan kita
amati. Ketika suatu permasalahan yang hendak diamati memunculkan
pertanyaan-pertanyaan yang tidak bisa terjawab, maka metode eksperimen
ilmiah hendaknya dapat memberikan jawaban melalui proses yang logis. Proses-
proses dalam pendekatan scientifik meliputi beberapa tahapan (gambar 3) yaitu:
mengamati, hipotesis atau menanya, mengasosiasikan atau eksperimen,
mengumpulkan atau analisa data dan mengkomunikasikan. Proses belajar
pendekatan eksperimen pada hakekatnya merupakan proses berfikir ilmiah untuk

membuktikan hipotesis dengan logika berfikir.
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o Dk menghubungian pengeaun
Dty engan pergetatudn b

Gambar 3. Diagram Proses Metode Scientifik-Eksperimen Ilimiah

B. Prasyarat.

Untuk kelancaran pencapaian kompetensi dalam mata pelajaran
pengolahan citra digital ini dibutuhkan beberapa peryaratan baik pengetahuan
maupun ketrampilan dasar. Persyaratan tersebut antara lain ialah: peserta didik
mempunyai kompetensi dalam hal pemanfaatan teknologi informasi, seperti
mengoperasikan hardware komputer dan mengoperasikan perangkat lunak
aplikasi. Perangkat lunak aplikasi tersebut antar lain ialah pengolah data untuk
menganalisis data hasil eksperimen, pengolah kata untuk membuat laporan dan
aplikasi presentasi untuk mengkomunikasikan dan mempresentasikan hasil
laporan.
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C. Petunjuk Penggunaan.

Buku pedoman siswa ini disusun berdasarkan kurikulum 2013 yang
mempunyai ciri khas penggunaan metode scientific. Buku ini terdiri dari dua bab
yaitu bab satu pendahuluan dan bab dua pembelajaran. Dalam bab pendahuluan
beberapa yang harus dipelajari peserta didik adalah diskripsi mata pelajaran
yang berisi informasi umum, rasionalisasi dan penggunaan metode scientifik.
Selanjutnya pengetahuan tentang persyaratan, tujuan yang diharapkan,
kompetensi inti dan dasar yang akan dicapai serta test kemampuan awal.

Bab dua menuntun peserta didik untuk memahami deskripsi umum tentang
topik yang akan dipelajari dan rincian kegiatan belajar sesuai dengan kompetensi
dan tujuan yang akan dicapai. Setiap kegiatan belajar terdiri dari tujuan dan
uraian materi topik pembelajaran, tugas serta test formatif. Uraian pembelajaran
berisi tentang diskripsi pemahaman topik materi untuk memenuhi kompetensi
pengetahuan. Uraian pembelajaran juga menjelaskan deskripsi unjuk kerja atau
langkah-langkah logis untuk memenuhi kompetensi skill.

Tugas yang harus dikerjakan oleh peserta didik dapat berupa tugas
praktek, eksperimen atau pendalaman materi pembelajaran. Setiap tugas yang
dilakukan melalui beberapa tahapan scientifik yaitu : 1) melakukan pengamatan
setiap tahapan unjuk kerja 2) melakukan praktek sesuai dengan unjuk kerja 3)
mengumpulkan data yang dihasilkan setiap tahapan 4) menganalisa hasil data
menggunakan analisa diskriptif 5) mengasosiasikan beberapa pengetahuan
dalam uraian materi pembelajaran untuk membentuk suatu kesimpulan 6)
mengkomunikasikan hasil dengan membuat laporan portofolio. Laporan tersebut

merupakan tagihan yang akan dijadikan sebagai salah satu referensi penilaaian.

D. Tujuan Akhir.

Setelah mempelajari uraian materi dalam bab pembelajaran dan kegiatan
belajar diharapkan peserta didik dapat memiliki kompetensi sikap, pengetahuan
dan ketrampilan yang berkaitan dengan materi:

v' Citra vektor
v Aplikasi pengolah citra vektor
v' Penggabungan gambar bitmap

v' Pemberian efek pada gambar bitmap
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E. Kompetensi Inti dan Kompetensi Dasar.

1. Kompetensi Inti 1 : Menghayati dan mengamalkan ajaran agama yang

dianutnya.

Kompetensi Dasar :

1.1.

1.2.

1.3.

Memahami nilai-nilai keimanan dengan menyadari hubungan
keteraturan dan kompleksitas alam dan jagad raya terhadap kebesaran
Tuhan yang menciptakannya

Mendeskripsikan kebesaran Tuhan yang menciptakan berbagai sumber
energi di alam

Mengamalkan nilai-nilai keimanan sesuai dengan ajaran agama dalam

kehidupan sehari-hari.

2. Kompetensi Inti 2: Menghayati dan Mengamalkan perilaku jujur, disiplin,

tanggung jawab, peduli (gotong royong, kerjasama, toleran, damai), santun,

responsif dan proaktif dan menunjukan sikap sebagai bagian dari solusi atas

berbagai permasalahan dalam berinteraksi secara efektif dengan lingkungan

sosial dan alam serta dalam menempatkan diri sebagai cerminan bangsa

dalam menempatkan diri sebagai cerminan bangsa dalam pergaulan dunia.

Kompetensi Dasar:

2.1.

2.2.

Menunjukkan perilaku ilmiah (memiliki rasa ingin tahu; objektif; jujur;
teliti; cermat; tekun; hati-hati; bertanggung jawab; terbuka; kritis; kreatif;
inovatif dan peduli lingkungan) dalam aktivitas sehari-hari sebagai wujud
implementasi sikap dalam melakukan percobaan dan berdiskusi

Menghargai kerja individu dan kelompok dalam aktivitas sehari-hari
sebagai wujud implementasi melaksanakan percobaan dan melaporkan

hasil percobaan.

3. Kompetensi Inti 3: Memahami,menerapkan dan menganalisis pengetahuan

faktual, konseptual dan prosedural berdasarkan rasa ingintahunya tentang

ilmu pengetahuan, teknologi, seni, budaya, dan humaniora dalam wawasan

kemanusiaan, kebangsaan, kenegaraan, dan peradaban terkait penyebab

fenomena dan kejadian dalam bidang kerja yang spesifik untuk memecahkan

masalah.

Kompetensi Dasar:

3.6.
3.7.

Memahami citra vektor

Memahami cara menggabungkan gambar bitmap
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3.8. Memahami cara memberi efek pada gambar bitmap

4. Kompetensi Inti 4: Mengolah, menalar, dan menyaiji dalam ranah konkret dan
ranah abstrak terkait dengan pengembangan dari yang dipelajarinya di
sekolah secara mandiri, dan mampu melaksanakan tugas spesifik dibawah
pengawasan langsung.

Kompetensi Dasar:
4.6. Menyajikan data hasil pengamatan terhadap citra vektor
4.7. Melakukan penggabungan citra bitmap

4.8. Melakukan pengolahan citra bitmap (efek khusus)

F. Cek kemampuan awal.

/_7@ 1. Jelaskan pengertian citra vektor!

i 2. Sebutkan perbedaan-bedaan antara citra vektor dan bitmap

3. Sebutkan beberapa aplikasi untuk pengolahan citra vektor dan
bitmap

4. Jelas obyek-obyek grafis apa saja yang bisa dibuat di aplikasi
pengolahan citra vektor

5. Sebutkan efek-efek yang digunakan saat mengolah gambar bitmap




PENGOLAHAN CITRA DIGITAL

BAB 2 PEMBELAJARAN
A. Diskripsi

Pengolahan Citra Digital adalah salah satu mata pelajaran wajib dasar
program keahlian Teknik Komputer dan Informatika (TKI). Berdasarkan struktur
kurikulum mata pelajaran Pengolahan Citra Digital-2 disampaikan di kelas Xl
semester 2, 4 jam pelajaran per minggu. Untuk semester 2 topik materi
pembelajaran menekankan pada pengenalan citra vektor dan pengolahan citra
bitmap

Dalam desain komunikasi visual, teks maupun obyek grafis serta warna
memainkan peranan sangat penting dalam keberhasilan suatu bentuk seni
komunikasi grafis. teks maupun obyek grafis serta warna bukan lagi sebagai
pelengkap statement visual, tetapi sudah menjadi sajian utama komunikasi grafis
yang berbentuk buku, katalog atau brosur. Sehingga sangat penting untuk
mempelajari teks, grafis serta warna pada perancangan desain grafis yang
mengandung unsure estetika . Citra bitmap mendukung teori tipografi untuk
mengembangkan karya grafis sesuai dengan kaidah-kaidah pembuatan karya

grafis.
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B. Kegiatan Belajar

1.Kegiatan Belajar 1 : Memahami Konsep Citra Vektor

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 1 ini siswa diharapkan dapat :
1) Memahami konsep citra vektor
2) Memahami ciri-ciri citra vektor

3) Menganalisis perbedaan citra vektor dan bitmap

b. Uraian Materi
1) Pengertian Citra Vektor

Citra vektor/gambar vektor merupakan gambar digitalyang berdasarkan
persamaan matematis. Gambar Vektor terdiri dari penggabungan koordinat-
koordinat titik menjadi garis atau kurva untuk kemudian menjadi sebuah objek,
sehingga gambar tidak menjadi pecah walaupun diperbesar atau diperkecil.

Citra vektor adalah gambar yang dibuat dari unsur garis dan kurva yang
disebut vektor. Kumpulan dari beberapa garis dan kurva ini akan membentuk
suatu obyek atau gambar.

Citra vektor merepresentasikan gambarnya tidak dengan menggunakan pixel,
melaikan dengan kurva dan garis yang didefinisikan dalam persamaan
matematis. Persamaan matematis tersebut disebut dengan vektor. Sebagai
contoh menggambar segitiga maka didefinisikan persamaan matematis dari
segitiga sehingga membentuk garis pembatas segitiga didalam garis pembatas
tersebut diberi warna sehingga terbentuklah bidang segitiga.

Beberapa format file citra vektor di antaranya: svg, eps, wmf , cdr dan lain
sebagainya.Gambar vektor tidak tergantung pada resolusi. Citra vektor dapat
diperbesar atau diperkecil ukuran gambar tanpa kehilangan detail gambarnya.
Disamping itu gambar vektor akan mempunyai ukuran file yang lebih kecil dan
dapat diperbesar atau diperkecil bentuknya tanpa merubah ukuran filenya.

Citra vektor merupakan jenis gambar yang paling tepat untuk
mengolah/membuat gambar logo atau setting percetakan hal ini dikarenakan

citra vektor tidak akan pecah saat diperbesar sampai ukuran berapapun.
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2) Ciri — Ciri Citra Vektor
Citra Vektor terdiri dari penggabungan koordinat-koordinat titik yang dibuat

dalam persamaan matematika menjadi garis atau kurva untuk kemudian

menjadi sebuah objek.

Adapun ciri — ciri dari citra vektor adalah sebagai berikut :

o Citra vektor terdiri susun dari persamaan matematika
Grafik dengan type Vektor merupakan gambar yang dibentuk oleh objek
berupa garis dan kurva.

o Citra vektor tidak terlihat pecah saat diperbesar

o Kualitas hasil gambar dari type vektor tidak tergantung pada resolusi
gambar.

o Ukuran file gambar relatif kecil

o Dalam penyimpanan file, type Vektor hanya memerlukan ruang
penyimpan yang relative kecil

o Ukuran file gambar tidak tergantung pada resolusi komputer

o Teknik pewarnaan gradasi membutuhkankemampuan yang lebih agar
menghasilkan gambar yang realistis.

a. Gambar asli b.gambar diperbesar 7x

Gambar 1.1 Citra cektor yang diperbesar



PENGOLAHAN CITRA DIGITAL

Dari kedua gambar diatas, gambar a diperbesar sampai 7x (terlihat pada
gambar b). Kualitas dan ukuran kedua gambar sama, meskipun gambar b
diperbesar sampai 7x.

Semakin kompleks citra yang dibuat semakin besar size filenya dan semakin
lambat untuk ditampilkan di layar.

Untuk kelebihan dan kekurangan dari citra vektor dapat dilihat pada tabel
diberikut ini :

KELEBIHAN KEKURANGAN ‘

Ukuran file relatif kecil Tidak mampu menampilkan gambar

secara detail dan  kompleks.

Pemberian warna kurang detail

Ketajaman gambar tidak akan berubah Kurang realistik

meskipun diperbesar sampai berapapun

Ruang penyimpanan untuk objek gambar

lebih efisien

Dapat dicetak pada resolusi tertingi pada

printer

3) Perbandingan Citra Vektor dengan Bitmap
Untuk perbedaan citra vektor dan bitmap dapat dituliskan dalam bentuk tabel
berikut :

No Keterangan Citra Vektor
Relatif lebih kecil

dibanding citra bitmap

Citra Bitmap ‘
Relatif lebih besar

dibanding citra vektor

1. Besar ukuran File

2. Teknik penyajian gambar  Berdasarkan Berdasarkan pixel

persamaan matematis

3. Ketajaman gambar ketika  Tetap Semakin diperbesar
diperbesar gambar akan terlihat
kabur
4. Ukuran file Tidak dipengarubhi Tergantung besar

besarnya gambar

gambar dan resolusi

5. Detail warna dan gambar

Tidak mampu

menampilkan gambar

Mampu menampilkan

gambar secara detail
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secara detail dan dan kompleks
kompleks

6. Resolution Resolution Resolution dependent
independent

Citra pada vektor umumnya memiliki ukuran yang lebih kecil bila
dibandingkan dengan gambar bitmap. Citra vektor menyajikan gambar
berdasarkan persamaan matematika , ukuran file dari gambar vektor grafis
dipengaruhi oleh kompleksitas dari persamaaan vektor yang digunakan.

Pada gambar bitmap sangat baik digunakan untuk merepresentasikan
gambar yang sangat kompleks dan detail. Tetapi kekurangannya adalah ukuran
filenya tergantung dari ukuran gambar dan resolusinya. Jika file bitmap

diperbesar maka ketajaman gambar akan berkurang.

Rasio = Gambar vektor Gambar bitmap
1:1

1:30

r

Pada vektor grafis ukuran gambar tidak mempegaruhi ukuran file. Jika
gambar diperbesar maka ketajamannya tetap sama dengan sebelumnya. Pada

tabel gambar diatas terlihat pada gambar vektor ( menggunakan tipe file .cdr )
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ketika diperbesar sampai 30 kali menghasilkan ketajaman gambar yang tidak
berubah. Hal ini berbeda dengan jenis gambar bitmap ( menggunakan tipe file
.jpg ), saat diperbesar 30 kali gambar yang ditampilkan tampak kabur.

Ukuran file dari gambar vektor grafis dipengaruhi oleh kompleksitas dari
persamaaan vektor yang digunakan. Misal ada dua gambar yang besarnya
sama. Gambar yang pertama adalah gambar lingkaran sedangkan gambar yang
kedua adalah gambar tali yang melingkar tidak beraturan. Ukuran file gambar tali
akan lebih besar daripada gambar lingkaran. Kekurangan dari vektor grafis tidak

mampu menampilkan gambar secara detail dan kompleks.

c. Rangkuman

Dari uraian materi pengertian citra vektor dapat dirangkum sebagai berikut :

= Citra vektor/gambar vektor merupakan gambar digitalyang berdasarkan
persamaan matematis.

» Persamaan matematis tersebut disebut dengan vektor.

= Gambar Vektor terdiri dari penggabungan koordinat-koordinat titik menjadi
garis atau kurva untuk kemudian menjadi sebuah objek, sehingga gambar
tidak menjadi pecah walaupun diperbesar atau diperkecil.

= Kelebihan citra vektor memiliki ukuran file relatif kecil dan ketajaman
gambar tidak akan berubah meskipun diperbesar sampai berapapun

= Citra vektor juga memiliki kekurangan, diantaranya tidak mampu
menampilkan gambar secara detail dan kompleks.

= Perbedaan yang mendasar antara citra vektor dan citra bitmap adalah
teknik penyajian gambar citra vektor berdasarkan persamaan matematis

dan citra bitmap berdasarkan pixel.

d. Tugas
Buatlah kelompok. terdiri atas 2/3 orang untuk mendiskusikan tugas yang
akan diberikan . Dalam kegiatan ini masing-masing kelompok akan membuat
ringkasan materi pengertian ciri-ciri citra vektor dan bitmap serta carilah
contoh gambar vektor dan bitmap. Kemudian secara bergantian masing-
masing kelompok mempresentasikan hasilnya didepan kelas.

1. Bacalah uraian materi diatas dengan teliti dan cermat.
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2. Buatlah ringkasan materi menggunakan software pengolah presentasi.

3. Presentasikan hasil ringkasan di depan kelas.

e. Tes Formatif
Dalam test ini setiap peserta didik wajib membaca dengan cermat dan teliti
setiap butir soal dibawah ini. Kemudian berdasarkan uraian materi diatas
tulislah jawabannya pada lembar jawaban test formatif yang telah disediakan.
1. Apa yang dimaksud dengan citra vektor
2. Apakah ciri khas dari citra vektor dibanding dengan citra bitmap
Bagaimana akibat jika sebuah citra vektor diperbesar sampai 999 kali

dari ukuran semula

f. Lembar Jawaban Tes Formatif

LJ - 01 : Pengertian citra vektor
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LJ - 03 Citra vektor diperbesar 999x

dg. Lembar Kerja Siswa
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2. Kegiatan Belajar 2 : Menyajikan Hasil Pengolahan Aplikasi
Pengolah Citra Vektor

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 2 ini siswa diharapkan dapat :
1) Memahami aplikasi citra vektor
2) Memahami macam-macam aplikasi citra vektor

3) Menyajikan hasil pengolahan citra menggunakan aplikasi citra vektor

b. Uraian Materi
1.) Pengenalan aplikasi pengolah citra vektor

Pelbagai karya seni dapat dilihat dalam kehidupan sehari-hari , misalnya
website, blog, kartu nama, kartu undangan, liflet, brosur, seni fotografi. Banyak
pengguna komputer yang menciptakan sebuah website dengan desain grafis
yang paling menarik untuk ditampilkan. Karya-karya tersebut dapat dibuat sendiri
dengan menggunakan perangkat lunak grafis. Karena itu banyak bermunculan
program-program aplikasi pembuat grafis yang mudah dipelajari dengan fitur-fitur
yang canggih dan mudah dioperasikan.

Program aplikasi pembuat grafis berkembang sangat cepat sejak
diperkenalkannya sistem GUI (Graphical User Interface). GUlI mudah untuk
dipelajari karena menggunakan ikon atau toolbox secara visual sebagai
pengganti menu atau perintah yang berbasis command line (teks).

Citra vektor dapat diolah dalam format 2 dimensi maupun 3 dimensi. Aplikasi
pengolah citra vektor 2 dimensi di antara lain corel draw, adobe ilustrator,
freehand, macromedia flash, Xara Extreme. Sedangkan aplikasi citra vektor yang
diolah dalam format 3 dimensi diantaranya Maya 3D, Strata 3D CX, Ulead COOL
3D, Swift 3D, AutoCad, 3D Home Architect, google sketchup dan lain
sebagainya.

Satu satu aplikasi pengolah citra vektor yang banyak digunakan oleh editor
grafis adalah CorelDraw. CorelDraw adalah editor citra/grafik vektor yang
dikembangkan oleh Corel, sebuah perusahaan perangkat lunak yang bermarkas
di Ottawa, Kanada.

Tahun 1987, Corel merekrut beberapa pengembang software (programmer)

untuk membangun sebuah software grafis berbasis vektor untuk dijadikan satu
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dengan paket desktop-publishing Corel dan diberi nama CorelDraw, pertama kali
diluncurkan ada 1989. Aplikasi grafis vektor ini diterima luas oleh masyarakat dan
pada akhirnya corel hanya focus pada pengembangan software. Beberapa
inovasi untuk ilustrasi berbasis vektor pada CorelDraw : Note-edit tool, stroke
before fill, mesh fill dan sebagainya.

CorelDraw memiliki perbedaan aplikasi pengolah grafis vektor yang lainnya.
Perbedaan tersebut diantaranya CorelDraw adalah suatu paket software grafis,
bukan hanya sebuah editor gambar berbasis vektor. Peralatan — peralatan yang
ada memungkinkan penggunanya untuk mengatur kontras, keseimbangn warna
bahkanmengubah dari mode RGB (Red Green Blue) menjadi CMYK (Cyan
Magenta Yellow). Khusus untuk gambar bitmap dapat diubah dengan Corel
PhotoPaint.

Banyak jenis dan versi produk CorelDraw, dari tahun ke tahun Corel selalu
update, selain itu banyak pula komponen-komponen yang di kembangkan dan di
masukan ke setiap paket Program Corel pada setiap versinya, namun Corel
sendiri sudah memiliki aturan dan ketentuan dasar untuk setiap rilis produk
barunya, diantaranya yaitu
Rilis dalam versi CorelDraw Graphic Suite yang harus di sertakan beberapa
program/aplikasi pendukung berikut ini:
PowerTRACE (sebuah  bitmap untuk vector graphic converter),
PHOTO-PAINT  (sebuah  bitmap editor graphic), dan CAPTURE
(sebuah screen capture utility).

CoreIDRAW pada awalnya dikembangkan untuk sistem operasi Windows
2000 dan seterusnya. Versi CoreIDRAW untuk Linux dan Mac OS pernah
dikembangkan, namun dihentikan karena tingkat penjualannya rendah.
CorelDRAW X5 dirilis pada 2008. Sebelum ada CorelDraw X5 terdapat versi X3,
X4 . Versi CoreIDRAW X5 memiliki tampilan baru serta beberapa aplikasi baru
yang tidak ada pada CorelDRAW versi sebelumnya. Beberapa aplikasi terbaru
yang ada, di antaranya Quick Start, Table, Smart Drawing Tool, Save as
Template, dan lain sebagainya.

CoreIDRAW adalah suatu aplikasi desain grafis yang berguna untuk

membuat desain vector, logo, dan layout halaman. Program CorelIDRAW yang
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terbaru adalah CoreIDRAW X6, yang menawarkan banyak kemudahan dan

fasilitas baru sehingga dapat membantu anda dalam membuat desain kreatif.

Kelebihan coreldraw diantaranya :

tool-toolnya yang lebih bersifat freehand, karenanya coreldraw pada
dasarnya sebagai software grafis coreldraw bisa berdiri sendiri, Karena
berbasic vektor dan bersifat freehand

coreldraw juga memiliki kemampuan untuk dipadupadankan dengan
editing foto

dapat menghasilkan suatu gambar dari foto dengan penambahan atau
editing tulisan dan karakter-karakter tertentu.

Coreldraw juga mampu untuk mengimpor atau ekspor file menjadi file jpg,

bmp atau lainnya.

Kekurangan yang sering muncul:

memakan memori dan resource lain yang sangat besar apalagi bila
gambar yang sedang dibuat mempunyai detail yang banyak

Semakin kompleks filenya maka semakin besar file

warna yang dicetak tidak akurat (tidak sesuai dengan tampilan layar)
pada beberapa jenis printer

pembuatan objek table tidak semudah membuat table dalam aplikasi
pengolah angka maupun kata, pada corel pembuatan tabel dibuat dengan
cara manual

saat penggabungan objek vector dan photo/bitmap kualitas cetakannya
kurang memuaskan, misalnya membuat cover buku yang terdapat objek
text dan photo.

kompatibilitas versi CorelDraw banyak kendala dalam sharing ke versi

lainnya.

Berikut tahapan perkembangan aplikasi pengolahan grafis CoreIDRAW

» CorelDRAW versi 1.01 dirilis pada bulan Januari 1989.
CorelIDRAW versi 1.01 dirilis pada bulan Maret 1989.
CorelIDRAW versi 1.02 dirilis pada bulan April 1989.
CorelIDRAW versi 1.10 dirilis pada bulan Juli 1989.
CorelIDRAW versi 1.11 dirilis pada bulan Februari 1990.
CorelDRAW versi 2 dirilis pada tahun 1990.
CorelDRAW versi 3 dirilis pada tahun 1992.

¥ ¥ ¥ ¥ ¥ ¥
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CorelDRAW versi 4 dirilis pada tahun 1993
CorelDRAW versi 5 dirilis pada tahun 1994
CorelDRAW versi 6 dirilis pada tahun 1995
CorelDRAW versi 7 dirilis pada tahun 1997
CorelDRAW versi 8 dirilis pada tahun 1998
CorelDRAW versi 9 dirilis pada tahun 1999
CorelDRAW versi 10 dirilis pada tahun 2000
CorelDRAW Graphics Suite 11 dirilis pada tahun 2002
CorelDRAW Graphics Suite 12 dirilis pada tahun 2003
CorelDRAW Graphics Suite X3 dirilis pada tahun 2005
CorelDRAW Graphics Suite X4 dirilis pada tahun 2008
CorelDRAW Graphics Suite X5 dirilis pada tahun 2010
CorelDRAW Graphics Suite X6 dirilis pada tahun 2012

¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥FO¥F OFYFOFTYT¥YCTV

Dari tiap versi CorelDraw mempunyai kelebihannya, berikut ini adalah kelebihan

dari tiap-tiap versi CorelDraw
+» CorelDRAW versi 2

Envelope Tool »>untuk memecah teks atau objek menggunakan shape
utama
Extrusion - untuk mensimulasi gambar dan volume dalam objek

Perspective > Untuk memecah objek sepanjang X dan Y

CorelDRAW versi 3

Terdapat Corel PHOTO PAINT* > untuk mengedit bitmap
CorelSHOW ->Untuk membuat on-screen presentasion
CorelCHART —untuk Grahpic chart

Mosaic

CorelTRACE —>untuk vectorizing bitmaps

CorelDRAW versi 4

Penambahan fasilitas Corel PHOTO-PAINT* - untuk mengedit bitmap
CorelSHOW ->untuk membuat on-screen presentasion

CorelCHART

CorelMOVE

Mosaic
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- corelTRACE.
CorelDRAW versi 5

- versi terakhir yang dibuat dan berjalan pada windows 3.x. k Corel

7
0.0

- Ventura yang ada didalamnya kemudian dijual terpisah ini adalah
desktop publishing yang mirip dengan PageMaker, Quark Express, atau
InDesign.

% CorelDRAW versi 6

- versi pertama untuk windows 32-bit.

- Corel Memo

- Corel Presents

- Corel Motion 3D

- Corel Depth

- Corel Multimedia Manager

- Corel Font Master

- Corel DREAM —>untuk membuat objek 3D

- Fiturfitur baru telah disesuaikan dengan Interface, Polygon, Spiral, Knife
dan Eraser tools.

CorelIDRAW versi 7

- Properti bar yang sensitif (Context-sensitive Property bar)

7
X4

*,

- Print Preview dengan Zoom dan Pan

- Scrapbook »>untuk melihat, menggeser dan menempatkan objek

- mencetak ke dalam HTML, Draft dan Enhanced display

- Interactive Fill

- Blend tools

- Transparency tools

- Natural Pen tool

- mencari & mengganti wizard

- merubah Vector menjadi Bitmap (ketika dalam CorelDRAW)

- pengecek ejaan (Spell checker)

- Kamus (Thesaurus)

- Pengecek susunan bahasa (Grammar checker).

- Corel Scan and Corel Barista > dokumen pertukaran format berbasis
java

CorelIDRAW versi 8

7
°
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- Digger selection

- dudukan windows (Docker windows)

- memecah teks / objek (Interactive Distortion)

- Membuat efek 3D,

- Envelope and tools

- efek pemberi bayangan yang realistis (Realistic Dropshadow tool)
- pencampuran warna (interactive color mixing)

- penyusun tempat-tempat warna (color palette editor)

- garis bantu sebagai objek (guidelines as objects)

- merubah ukuran halaman (custom-sized pages), duotone support.
CorelIDRAW versi 9

- Mesh fill tool untuk pencampuran warna yang lebih kompleks
Artistic Media tool

- mencetak kedalam PDF

- menyatukan profile warna ICC (embedded ICC color profiles)

- Multiple On-screen Color Palettes

- Microsoft Visual Basic untuk mendukung aplikasi 6. Canto Cumulus LE,

CorelIDRAW versi 10

- CorelR.A.V.E. & untuk animasi vector

- Perfect Shapes

- Web graphics tools -untuk membuat element-elemen yang interaktif
seperti tombol

- penyortir halaman (Page sorter)

- dokumen multibahasa (multilingual document support)

- petunjuk window (navigator window)

- buka, simpan, import dan eksport dalam format SVG.

CorelDRAW Graphics Suite versi 11

- Kumpulan simbol-simbol (Symbols library) yang langsung dapat diambil

- memotong gambar > untuk mendesain web

- pressure-sensitive vector brushes

- 3 titik alat menggambar (3-point drawing tools).

CorelDRAW Graphics Suite 11 versi 12

- Panduan yang dinamis (Dynamic guides)
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- alat menggambar pintar (Smart Drawing tools)

- mengekspor kedalam MS Office atau Word

- bagian alat penghapus virtual (Virtual Segment Delete tool)

- mendukung teks yang unicode (Unicode text support) ->sistem yang
memiliki kemampuan untuk menuliskan, memproses, dan menampilkan
berbagai aktifitas dari tulisan itu sendiri.

s CorelDRAW Graphics Suite X3

- memotong dengan mengklik 2 kali (software vector pertama yang
mampu untuk memotong sebuah grup vector dan bitmap dalam waktu
yang sama)

- Smart fill tool

- Chamfer/Fillet/Scallop/Emboss tool

- ruang pengaturan gambar (Image Adjustment Lab).

- Menjiplak/Trace menjadi terintegrasi didalam CorelDRAW dibawah
kendali PowerTRACE.

CorelIDRAW Graphics Suite X4

- Layanan pengidentifikasi huruf (font) terkait didalam CoreIDRAW

3

%

- ConceptShare
- Table tool
- independent page layers

- live text formatting

mendukung file kamera *.RAW.
% CorelDRAW Graphics Suite X5
- pengaturan isi (Corel CONNECT)
- pengelolaan warna
- alat-alat grafis dan animasi
- pengembangan kinerja multi-core, konten digital bernilai tinggi
(profesional huruf/fonts, clip arts, dan foto-foto)
- mengisyaratkan objek (object hinting)
- pixel view
- Mesh tool ditingkatkan dengan transparansi
- menambahkan dukungan sentuh (added touch support)

- mendukung berbagai format file.
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- mengembangkan transformasi, yang mana dapat membuat banyak
salinan dari satu objek.

CorelDRAW Graphics Suite X6

support typografi OpenType

X3

AS

tool Color Harmonies

tool Shaping

- Object Styles

- Software tambahan seperti Corel Website Creator X6 merupakan hal
baru yang disertakan dalam bundel X6. Selain itu terdapat software
tambahan yang sudah dikenal pengguna versi sebelumnya, seperti
PhotoPaint X6, PowerTrace X6.

2.) Lingkungan kerja aplikasi pengolah citra vektor
Pada buku ajar ini akan diperkenalkan CorelDRAW Graphics Suite X3

sebagai aplikasi pengolahan design grafis berbasis vektor untuk membuat
beberapa design seperti kartu nama, logo, kalender, poster, dan lain-lain.
Pada saat pertama aplikasi mengolah grafis CoreIDRAW Graphics Suite X3
dibuka akan dijumpai area kerja seperti gambar berikut :
+ Lembar Kerja
Bagian-bagian fitur yang ada di aplikasi pengolah citra vektor dapat dilihat pada

lembar kerjanya. Berikut bagian dari lembar kerja di aplikasi pengolah citra vektor

Menu bar  Area berisi pilihan dalam bentuk pull-down menu yang berfungsi untuk
mengatur dan mengolah objek.

Property menu bar yang memiliki perintah yang berhubungan dengan obyek
bar atau tool yang sedang aktif.
Merupakan sebuah batang yang berisi sederetan perintah untuk
mengatur parameter dari suatu objek.

Toolbar bagian yang memuat tombol-tombol perintah yang digunakan untuk
membuat dan memodifikasi objek.

Title bar area yang menampilkan nama dokumen yang sedang dibuka.

Ruler Batas horisontal and vertikal yang digunakan untuk menentukan
ukuran dan posisi obyek dalam gambar

Toolbox Berisi tool yang berguna untuk membuat dan memodifikasi obyek
dalam gambar
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Drawing area di luar area kerja yang dibatasi dengan scroll bars.

window

Drawing Area berbentuk persegi di dalam drawing window yang merupakan
page area kerja yang tercetak.

Document Page Navigator berisi informasi dan tombol perintah untuk pindah dari
Navigator  satu halaman (page) ke halaman lain.

Color Color Palettes berfungsi untuk member warna objek.

Palltete

Status bar Bar yang menampilkan informasi obyek ataupun perintah yang sedang
aktif terpilih (select)

Berikut adalah lembar kerjanya

Title bar Menu bar Tool bar
'l v

Property bar

~lix
an

Ume 00 pe o ow e o e e

0 a Darm -
- - ;" = A0S e t;
ETN SOTKT AT, T EEE ST | | POT T2Y CXrs S SRR FITR, ST TR, SR ST MO OV
Tool box‘
Drawing
window
Drawing
page
.’!"':'J'. my A AN y €
b e s b a2 s s s i da X T
Document Status bar navigator Color
navigator
gato palette

Gambar 2.1. Lembar Kerja CorelDraw X3
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+ Page Navigator
Page Navigator merupakan sekumpulan informasi dan tombol perintah untuk

pindah dari satu halaman (page) ke halaman lain.

{4 ¢« 20f¢ » M\ Pagel ) Page2 /Page3 fPaged /

Gambar 2.2. Tampilan Page Navigator

Dari gambar diatas dapat diinformasikan seperti keterangan berikut :

* Insert Page untuk menyisipkan halaman baru di kiri atau di kanan
halaman yang aktif.
" First Page untuk menuiju ke halaman pertama.

- i Last Page untuk menuju ke halaman terakhir.
4

_ Previous Page untuk menuju ke halaman sebelumnya.
* Next Page untuk menuju ke halaman selanjutnya.

20f4 menunjukan yang aktif ad alah page (halaman) 2 dari total page 4
. P T nama halaman

Color palettes
Fungsi dari color palattes adalah untuk memberi warna pada obyek . Warna bisa

diberikan pada bidang objek maupun garis tepi dari obyek.

panah atas untuk _/% —ntuk menghapus warna

- = obvek
menggulung pilihan —
L pilihan warna
panah bawah untuk panah kiri untuk
menggulung pilihan ] menampilkan seluruh
\ pilihan warna
[ 1=

Gambar 2.3 tampilan color palettes
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+ Toolbox

Toolbox adalah bagian yang memuat tombol-tombol perintah yang
digunakan untuk membuat dan memodifikasi objek.
Pada toolbox terdapat berbagai peralatan untuk menggambar atau membuat
desain. Ikon-ikon yang tampil hanyalah sebagian dari yang ada. Untuk melihat
ikon-ikon yang tersembunyi, klik pada ikon dengan durasi waktu yang agak lama,
maka akan tampil ikon-ikon yang tersembunyi.

Secara Default tampilan dari toolbox pada CorelDraw X3 seperti gambar dibawah
ini :

e .
| [}5 < Pickup
Shape /!‘ﬁ@é__flyouts
editinz/'zfu
Crop 94
erase éﬁcurve
ﬂ"
-—
Shape —
tool -
=2
=, <—Text tool
=57, <—interaktif
y‘
Eye dropper $2 . <—Outline pen

gi: } fill

Gambar 2.4 toolbox

Smart

Tombol - tombol yang berada pada Toolbox memiliki symbol segitiga hitam yang

bernama flyouts ("' ). Flyouts menandakan bahwa ada tool-tool lain di dalam
ke dalam kelompok kategori tool tersebut. .

Pick tool ! R pada toolbox diatas untuk memilih, memiringkan / memutar, serta
mengubah ukuran gambar.

Shape tool = Oﬂ' R a!

Shape berisi tool-tool untuk membuat berbagai bentuk objek seperti objek bentuk
kotak, lingkaran, segi banyak, dan objek-objek dengan bentuk lain.

Ketika flyouts pada rectangle tool C di klik akan muncul pilihan tool sebagai
berikut :
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Gambar 2.5 Rectangle tool ketika flyouts ditekan

keterangan

Tool Keterangan

(] Rectangle tool Untuk menggambar kotak dan persegi panjang dengan
menariknya dalam halaman gambar

A 3 Point Untuk menggambar kotak dan persegi panjang dengan

dasar 3 titik

Rectangle Tool

Ketika flyouts pada ellips tool C>‘|di klik akan muncul pilihan tool sebagai
berikut o
g~ | —
Gambar 2.6 elips tool ketika flyouts ditekan
Tool _ Keterangan
< Ellipse Tool Untuk menggambar objek berbentuk lingkaran dan elips

dengan menariknya dalam halaman gambar
3 Point Ellipse  Untuk menggambar objek berbentuk lingkaran dan elips
Tool dengan dasar 3 titik

Ketika flyouts pada poligon tool & di klik akan muncul pilihan tool sebagai
berikut

Glora@e

Gambar 2.7 poligon tool ketika flyouts ditekan

Keterangan
Tool _ Keterangan
Untuk menggambar polygon dengan menariknya dalam

9
Folgen e halaman gambar

 Star Tool Untuk menggambar objek berbentuk bintang

Lo ] Complex Star Untuk menggambar bintang yang memiliki sisi
Tool berpotongan

) Graph Paper Untuk menggambar grid

Tool
“ spiral Tool Untuk menggambar spiral simetris dan logaritmik
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Ketika flyouts pada basic shapes al di klik akan muncul pilihan tool sebagai

berikut
Blpzwsa

Gambar 2.8 Basic shapes tool ketika flyouts ditekan

Keterangan

Tool : Keterangan

w . Untuk menggambar objek berbentuk lingkaran silinder,
2ael shiege hati dan sebagainya

Untuk membuat gambar objek berbentuk anak panah

=
L
Arrow Shape dengan berbagai arah

39 Flowchart Untuk menggambar symbol flowchart
Shape
g Untuk membuat gambar objek berbentuk pita

Banner Shape

~J Collout Shape ~ Untuk membuat gambar objek berbentuk gelembung
atau label yang biasanya dibuat untuk keterangan
sesuatu

Shape Editing 6‘4]
Shape Editing berisi tool-tool yang dapat anda gunakan untuk mengubah dan

memodifikasi bentuk objek. Ketika flyouts pada shape Editing A“|

di klik akan muncul pilihan tool sebagai berikut

84 o o %

Gambar 2.9 Shape editing tool ketika flyouts ditekan

Keterangan
Tool ~Keterangan |
A Untuk mengubah bentuk gambar
Shape tool
e ¢ Smudge Brush Untuk membuat efek distorsi pada obyek garis

Untuk mengubah bagian outline pada garis vector

%
Roughen Brush dari sebuah gambar

& Froe T ¢ Untuk memutar gambar dengan bebas
ree Transform
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Bl
CurveTool &l
Curve berisi tool-tool yang dapat anda gunakan untuk menggambar berbagai

bentuk objek garis dan kurva. Curve tool dapat menggunakan Artistic Media Tool

untuk membuat objek efek semprot, membuat garis-garis kaligrafi dan

menambahkan garis tepi objek. Ketika flyouts pada CurveTool :-é'*! di klik akan

muncul pilihan tool sebagai berikut

Gambar 2.10 curve tool ketika flyouts ditekan

Keterangan

Tool Keterangan |

;éd Ersshand Tool Untuk menggambar kurva dan segmen garis lurus

4 Freehand Too

A Bezier Tool Untuk menggambar kurva satu segmen pada satu
waktu

@Artistic Media Tool Untuk menambahkan brush, menyemprot, serta
menambahkan efek kaligrafi

Ty Pen Tool Untuk menggambar garis luru atau kurva dengan

en 100 cara klik pada lokasi yang ditentukan
A . Untuk menggambar kurva yang terhubung, dan garis
Polyline Tool lurus dalam satu tindakan berkesinambungan

Untuk menggambar kurva dengan menariknya dari
titik awal ke titik akhir kemudian menuju posisi titik
pusat

Untuk menggambar kurva dengan menariknya dari
titik awal ke titik akhir

- 3-Point Curve

5 Interactive connector
tool

I~ . Untuk memberikan ukuran panjang/suatu dimensi
Dimension tool obyek

Fiil Tool

Fill tool berisi tool-tool yang dapat anda gunakan untuk mengisi bidang-
bidang objek dengan berbagai warna, gradasi warna, objek tekstur, objek pola
gambar, atau untuk mengatur komposisi warna objek dengan menggunakan

Mesh Fill Tool. Ketika flyouts pada fill tool P di klik akan muncul pilihan

MW SR X =

Gambar 2.11 fill tool ketika flyouts ditekan
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Keterangan

Tool __________ Keterangan __________
A Fi color dialog memberikan warna isi yang solid untuk suatu benda
P ntuk mengisi objek dengan sebuah gradasi warna

'Fountalnflll Untuk isi objek d buah gradasi
atau bayangan

% Pattern Fill Untuk menerapkan pola preset pattern fill ke objek
atau membuat pola secara manual

¥ Texture Fill Untuk menerapkan preset texture Fill pada objek

E 3] PostScript Fill Untuk menerapkan tekstur postscript yang pada
obyek

X No Fill Untuk menghapus fill pada objek

¥ Color Docker Untuk menampilkan jendela color docker yang ada

Window disebelah kanan page drawing

Ketika flyouts pada interactive fill tool &di klik akan muncul pilihan tool

sebagai berikut
A X

Gambar 2.12 Interactive fill tool ketika flyouts ditekan

Keterangan _
Tool Keterangan

Untuk membuat fill secara dinamis

Q‘ Interactive fill tool

b Interactive mesh fil Untuk membuat fill mesh secara dinamis

tool

Interactive Tool

Interactive tool berisikan tool yang dapat anda gunakan untuk member efek-
efek special pada objek, seperti : memadukan objek dengan blend, membuat
kontur objek, member objek 3-dimensi, dan mengatur transparansi objek. Ketika

flyouts pada interactive tool &di klik akan muncul pilihan tool sebagai berikut

@'H;ﬁi’mamat{f

Gambar 2.13 Interactive tool ketika flyouts ditekan

Keterangan _
Tool Keterangan

: Campuran objek dengan menciptakan
_i OIInteractlve Blend perkembangan peralihan objek dan warna

¥ Interactive Contour  Untuk menerapkan serangkaian bentuk konsentris
Tool yang menyebar ke dalam atau keluar obyek
3 Interactive Distort Untuk mer)distorsi objek den_gan menerapkan push
Tool and pull, zipper atau efek twister
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& Interactive Drop Untuk menambah efek bayangan di belakang atau di
Shadow Tool bawah sebuah gambar

Untuk mengubah bentuk objek dengan menerapkan

= .
“' Interactive Envelope i Py
an menyeret node

Tool

Untuk menerapkan efek 3D pada objek dalam

& Interactive Extrude . o
menciptakan ilusi kedalam

Tool

g o e Untuk memberikan efek transparansi pada objek

Transparency Tool

Crop & Erase Tool H,

Crop & Erase tool berisi tool yang dapat anda gunakan untuk menghapus
atau membuang bagian-bagian objek yang tidak diperlukan dengan
menggunakan berbagai cara.

Ketika flyouts pada crop tool H, ‘di klik akan muncul pilihan tool sebagai berikut
By sy 2 |

Gambar 2.14 Crop & erase tool ketika flyouts ditekan

Keterangan

Tool Keterangan |

" Crop Tool Untuk memotqng dgn mengambil bagian gambar
yang terseleksi dari gambar bitmap
A Knife Tool Untuk memotong gambar
@ Eraser Tool Untuk menghapus bagian dari sebuah gambar yang
tidak diperlukan
e Untuk memotong bagian gambar yang berpotongan
—Virtual Segment dengan gambar lain

Delete

Outline Pen Q&

Ketika flyouts pada Outline Pen I’»mdi klik akan muncul pilihan tool sebagai
berikut
I

Gambar 2.15 Outline pen tool ketika flyouts ditekan

-

ANXE—————-z

Outline Pen digunakan untuk menampilkan daftar yang berisi pilihan untuk
menentukan ketebalan garis tepi suatu objek dan menentukan warna garis tepi

suatu objek.
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3.) Memulai dan mengakhiri aplikasi pengolah citra vektor
- Memulai aplikasi pengolah citra vektor

Untuk memulai bekerja membuat aplikasi pengolah citra vektor dapat
dilakukan pelbagai cara diantaranya dengan meng-klik tombol Start -> All
Programs - CorelDRAW X3, klik CoreIDRAW X3 hingga ditampilkan jendela

Welcome

CorelDRAW 2 %

= bedyisitoritvas. o L
e pr e L0
SNew Recently Used Open
\ 5.4 '
(5 (
|
o o/
New Froos Templat e CorelTUTOR What's New?

Folow $00-0y 5000 FEtratons On Comgieting Jooens of tashs from orastrg obiects to
PG your work

Gambar 2.16‘Iembar kerja welcome

Keterangan gambar

- New ->lembar kerja baru, pada new dapat diatur nama dan ukuran
lembar kerja.

- New from template > merupakan lembar kerja yang sudah tersedia
pada CorelDRAW X3

- Open - icon untuk membuka file yang sudah pernah dibuat

- Recently used - icon untuk membuka file yang terakhir digunakan

- corelTutor > terdiri dari tutorial yang disediakan olah CorelDraw

- What’s New - berisikan info seputar corelDraw

Untuk membuat lembar kerja baru maka silahkan memilih new dan akan

terbuka jendela kerja aplikasi corelDraw X3 seperti dibawah ini



PENGOLAHAN CITRA DIGITAL

b

byt vv

Gambar 2.17 Iemba?T(erja CorelDraw
- Membuka File citra vektor

Untuk membuka file citra vektor yang sudah pernah dibuat dapat
dilakukan dengan jalan
= untuk membuka file yang sudah pernah dibuat dapat dilakukan dengan
jalan klik file > open dan kemudian akan terbuka jendela untuk memilih
file yang sudah pernah dibuat atau menggunakan shortcut key ctrl+O

ST o
- =< O File *.cdr yang sudah

g r——— pernah dibuat

e—

C = >Fieopen

Gambar 2.18 jendela untuk memilih file

Setelah jendela pilih file terbuka maka pikih file *.cdr - klik open maka
terbuka file *.edr , bile file yang dimaksud sudah terbuka akan muncul tampilan

seperti dibawah dan file *.cdr siap untuk dilakukan editing lebih lanjut .
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«i.

W ¥

Gambar 2.19 file siap di edit

= Selain perintah diatas dapat juga menggunakan recently used dengan
jalan meng-klik recently used pada lembar kerja welcome - pilih file

yang akan dibuka.

bedavektorBitmap.cdr
coba pratek, cd

Recently Used

Gambar 2.20 file recently used
- Mengakhiri aplikasi pengolah citra vektor
Bila proses editing di aplikasi pengolah citra vektor sudah selesai dilakukan

maka perlu kiranya aplikasi tersebut ditutup. Langkah untuk mengakhiri
pengolah citra vektor sebenarnya tidak berbeda dengan aplikasi yang lain.

Adapun langkah — langkah untuk mengakhiri segala aktifitas pada program
CoreIDRAW dapat dilakukan dengan pelbagai cara, diantaranya adalah sebagai
berikut :

= Klik menu File = Close untuk menutup dokumen yang sedang aktif atau

Klik tombol 2 Close Windows.
= Klik menu File > Close All untuk menutup semua dokumen yang aktif
atau terbuka saat itu.

= Klik menu File > Exit untuk keluar dari program CoreIDRAW atau klik

tombol 2! Close atau menggunakan shortcut Alt+F4

4.) Menyimpan file *.cdr
Setelah selesai mengolah suatu obyek dalam aplikasi pengolahan citra
vektor maka langkah berikutnya adalah menyimpan file tersebut ke dalam format

file pengolahan citra vektor , misalnya dalam format CDR (file berformat
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CoreIDRAW). Pada format file CDR masih dapat diolah/edit lagi dikemudian hari.
Atau juga dapat menyimpan desain citra digital dalam format file lain seperti :
Adobe Portable Document Format (PDF), Adobe lllustrator (Al), Windows
Metafile (WMF) dan lain-lain.

Langkah untuk menyimpan hasil pengolahan gambar vektor dengan format

file .cdr adalah

Pilih menu File > Save

Atau klik tombol Save ', atau tekan tombol Ctrl + S sehingga tampil kotak
dialog Save Drawing.

P

Gambar 2.21 kotak dialog save drawing
Pilih folder tujuan untuk menyimpan file.

Pilih tipe file pada kotak daftar Save as type, secara default tipe file yang
terpasang adalah CDR-CorelIDRAW, nam un anda juga dapat menyimpan
file dalam format lain.

Pilih versi penyimpanan objek pada bagian Version. Pilihan Version
berfungsi untuk menyimpan file ke versi di bawahnya, sehingga file tersebut
dapat dibuka pada program CorelDRAW vyang versinya sebelum
CoreIDRAW X3.

Ketik nama file pada bagian File name. Sebagai contoh - coba
praktek.cdr.

Klik tombol Save untuk menyimpan file

5.) Mengimpor dan mengekspor file

CoreIDRAW menyediakan fasilitas untuk mengimpor dan mengekspor objek

ke dalam dokumen, baik objek teks maupun objek gambar yang telah dibuat

oleh program aplikasi lain, seperti file JPEG, GIF, atau tipe-tipe file lain.

Mengimpor file merupakan langkah mengambil file gambar untuk

dimasukkan pada kembar kerja CorelDRAW, baik berupa file JPG atauPNG.
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Sedangkan mengekspor file berguna untuk menyimpan objek desain ke dalam
format file lain agar file tersebut dapat dibuka pada software aplikasi lain. Anda
dapat menyimpan file CoreIDRAW dengan tipe JPG, Al, BMP, PNG, PDF, GIF,
dan lain-lain.
* Mengimpor file
Langkah - langkah untuk mengimpor file adalah :

1. Pilih menu File - import.atau gunakan shortcut key ctri+l
e Wew  Lwokt  Ayrang:

< Qutek
5 New From Template..,
() Qiose
T Cose Mt
) Save A, CeteShiftss

m‘ﬁi »

Gambar 2.22 Perintah untuk mengimport file
2. Setelah itu akan muncul tampil kotak dialog Import..

=

Gambar 2.23 Kotak dialog Impor

3. Kemudian klik file yang akan diimpor, misalnya file yang bernama

vgm_app.png
4. Klik tombol Import maka setelah itu akan muncul tanda perintah pada

lembar kerja seperti dibawah ini

T_w0 g
WEIRINRMTINe
i e &y Vo e
Pynis Enter 10 cottir of page,

Gambar 24. Tanda perintah import pada mouse telah aktif
5. Kilik tahan dan geser mouse dalam lembar kerja untuk meletakkan objek

hasil impor dengan ukuran sesuai keinginan
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.

Gambar 2. 25 Objek hasil impor
»= Mengekspor file
Berikut adalah langkah — langkah untuk mengekspor file :

1. Klik menu File > Export atau ctrl+E.

Edk  Vew (vt  Anangs

— Citen

€5 Pooes Erom Teoglate

B Do

@0&0“

D Sewe... [

T Save s e +S
Acgure Inage .

Gambar 2.26 Perintah mengexport file
2. Setelah itu akan muncul tampil kotak dialog Export

ST RAR——_ .

Gambar 2.27 Kotak dialog export
3. Pilih folder untuk menempatkan file hasil ekspor.
Pilih tipe file pada bagian Save of type, pilih JPG — JPEG Bitmaps bila
ingin menyimpan dalam bentuk file jpg/jpeg.
Ketik nama file pada kotak teks File name, misalnya taman

Klik selanjutnya pilih tombol Export untuk menjalankan proses ekspor.
Dan akan ditampilkan kotak dialog Export to JPEG.
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feomeetoneman x

Ioage Sow
W XN = 1o x] rctes »
gt T - 100 = %
Bechron X -

v MAREaN Mt (80 Orgrndd Fle s 11

Martwn argesl s New fle soe: ERNE

Cotor e
Cotr modker. G Coor (2%00) - v Aotr sy
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Gambar 2.28 Kotak dialog Export to JPEG
7. Pada kotak dialog tersebut akan muncul beberapa pengaturan objek hasil

ekspor, diantaranya :

Width - lebar gambar bitmap

Height - tinggi gambar bitmap

Resolution - resolusi/kualiatas gambar bitmap

Color mode > mode pewarnaan

Klik tombol OK untuk mengakhiri proses ekspor.

Objek hasil export dapat dilihat pada folder yang telah tentukan saat
eksport.

6.) Menggunakan garis bantuan

» Guidelines
Guidelines merupakan garis bantu yang digunakan untuk menempatkan objek
pada posisi tertentu. Pada corelDraw terdapat guidelines horisontal dan
guidelines vertikal.

R ICSSICES, St ST TR | EEEEE T

:. . \: o
F: M
e Al 4 Guidelines
5 setelah guidelines Al ;
B diaktifkan Ql horlsontal\l/
- N Sy
- |
7 . . .
2R f’, FGwdelmes vertikal
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*

Gambar 2.29 guidelines
Langkah untuk menampilkan garis bantu adalah sebagai berikut :

- klik tahan dan geser pointer mouse dari ruler horizontal kearah bawah

- klik tahan dan geser pointer mouse dari ruler vertical ke arah kanan.
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Guidelines horisontal dan guidelines vertikal dapat memiringkan garis bantu

dengan cara

- mengubah nilai Angle of rotation pada property bar
19,56 3 #3596
!I 9% | oo NS 1%2*??- a
,' - 4 o

Ll I | P i Akl

[»
’Eu ] Angle of rotation
B Gambar 2.30 Angle of rotation

- klik 2x secara pelan pada guidelines
- Maka akan muncul titik handle pada samping kanan dan samping Kiri

guidelines, kemudian putar point guidelines.

P Garis yangt ek
N digaser i
~ 5 B Snssinsasasasusases .
[

Gambar 2. 31 Mengeser guidelines

- Dapat pula menggeser titik acuan perputaran guidelines dengan cara klik
tahan dan geser titik ke tempat yang dibutuhkan.

» Tabel bantu grid
Grid merupakan table bantu yang berfungsi untuk mempermudah pengguna
saat mengolah gambar/obyek bitmap. Grid digunakan agar seleksi lebih
mudah dibuat dan mempunyai keakuratan yang tinggi.
Langkah - langkah untuk mengaktifkan Grid adalah sebagai berikut :
1. Pilih menu View > Grid

e
Sengie Wirelrsve
e e
Draft
Yorna
Enhanced
+ Erhanged weh Overperes

23 £ Scroen Prevew (2]

Ed Previaw Sebocted Oriy
Faoe Sorter View

| C—

Row »
Trubie Roloyer
Gambar 2.32 perintah tampilkan grid
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2. Dan akan muncul grid pada lembar kerja CorelDraw

B e o e e e e e - TR TR

LTI

Grid diaktifkan

=

Carad
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Gambar 2.33 Grid muncul pada lembar kerja

c. Rangkuman
Dari uraian materi aplikasi pengolah citra vektor dapat dirangkum sebagai
berikut :
= CorelDraw merupakan satu satu aplikasi pengolah citra vektor yang
banyak digunakan oleh editor grafis
= Banyak jenis dan versi produk CorelDraw, dari tahun ke tahun Corel
selalu update, selain itu banyak pula komponen-komponen yang di
kembangkan dan di masukan ke setiap paket Program Corel pada setiap
versinya, namun Corel sendiri sudah memiliki aturan dan ketentuan dasar
untuk setiap rilis produk barunya.
= Kelebihan coreldraw diantaranya :
- tool-toolnya yang lebih bersifat freehand
- coreldraw memiliki kemampuan untuk dipadu dengan editing foto
- menghasilkan suatu gambar dari foto dengan penambahan atau
editing tulisan dan karakter-karakter tertentu.
- Coreldraw juga mampu untuk mengimpor atau ekspor file menjadi file
jpg, bmp atau lainnya.

= Kekurangan yang sering muncul:
- memakan memori dan resource lain yang sangat besar Semakin

kompleks filenya maka semakin besar file

- warna yang dicetak tidak akurat pada beberapa jenis printer
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- pembuatan objek table tidak mudah ,pada corel pembuatan tabel
dibuat dengan cara manual

- saat penggabungan objek vector dan photo/bitmap kualitas
cetakannya kurang memuaskan, misalnya membuat cover buku yang
terdapat objek text dan photo.

- kompatibilitas versi CorelDraw banyak kendala dalam sharing ke
versi lainnya.

= Tool-tool perlu diketahui di lingkungan kerja aplikasi pengolah citra vektor
adalah menu bar, property bar, toolbar, title bar, ruler, toolbox, drawing

window, drawing page, document, navigator, color palltete, status bar.

d. Tugas
Buatlah file baru pada aplikasi pengolah citra vektor, import suatu gambar yang
berekstensi *.jpg kemudian simpan file yang terimport dalam format *.cdr

1. Buatlah catatan langkah-langkah untuk menyelesaikan tugas tersebut.

2. Presentasikan hasil ringkasan di depan kelas.

e. Tes Formatif
Dalam test ini setiap peserta didik wajib membaca dengan cermat dan teliti setiap
butir soal dibawah ini. Kemudian berdasarkan uraian materi diatas tulislah
jawabannya pada lembar jawaban test formatif yang telah disediakan.
1. Jelaskan apa yang dimaksud dengan guidelines dan grid
2. Apa fungsi perintah “recenlty used” pada saat membuka lembar kerja
3. Bagaimana menurut Anda tentang kelebihan dan kekurangan dari

aplikasi pengolahan citra vektor yang Anda gunakan.

f. Lembar Jawaban Tes Formatif
LJ - 01 : guidelines dan grid
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g. Lembar Kerja Siswa
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3. Kegiatan Belajar 3 : Menyajikan Hasil Pengolahan Objek Garis

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 3 ini siswa diharapkan dapat :
1) Memahami obyek garis

2) Menyajikan pengolahan obyek garis

b. Uraian Materi

Pada kegiatan belajar 3 akan dipelajari teknik- teknik untuk menggambar
obyek garis. Saat menggambar obyek garis dan bidang dapat menggunakan
bantuan pelbagai tool yang sudah ada di aplikasi pengolah citra vektor

CorelDraw.

1.) Menggambar garis dan kurva dengan pen tool

Pen tool merupakan tool untuk membuat garis lurus maupun garis lengkung
dengan tanda point / titik sebagai acuannya.

Adapun langkah-langkah untuk menggambar garis lurus dengan Pen adalah
sebagai berikut :

= Kilik Pen tool pada toolbox

D» ™~ 2 - 1 2
>

=,
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Eleedanhaur|
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Gambar 3.1 Pen tool
= Klik mouse pada tempat-tempat yang berbeda untuk menggambar

segmen-segmen objek garis lurus.

Klik

—_—
\m,w b

Gambar 3.2 Obyek yang dibuat dengan pen tool

= Tekan Shift untuk mendapatkan garis lurus secara vertical atau
horizontal.

= Dobel klik untuk mengakhiri proses menggambar.
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Sedangkan langkah-langkah untuk menggambar garis lengkung dengan Pen
adalah sebagai berikut :
= Klik Pen tool pada toolbox

~ 1 - T
4
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Gambar 3.3 Pen tool pada toolbox
= Klik untuk mulai membuat garis lurus
= Klik tahan dan geser mouse pada lokasi yang lain untuk membuat garis

lengkung.

r
Gambar 3.4 Obyek garis yang dibuat dengan pen tool

= Lakukan langkah di atas secara berulang untuk menggambar objek garis
lengkung.
= Dobel klik pada titik awal membuat garis, untuk menjadikan garis menjadi

shape / bangun ruang.

| L] n
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Gambar 3.5 Bidang yang tersusun dari garis

2.) Menggambar garis dan kurva dengan freehand
Freehand tool memiliki fungsi hampir sama dengan Pen tool, namun
memiliki perbedaan yang terletak pada pembentukan titik

acuan dilakukan dengan cara dobel klik.
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Adapun Langkah-langkah untuk menggambar garis lurus maupun kurva dengan

Freehand tool adalah :
= Klik Freehand tool (F5) pada toolbox

= ¥

e
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=

e e A
- I Froshand Tood °5)]

Gambar 3.6 Freehand pada toolbox

= Klik untuk mulai membuat garis, geser mouse untuk membentuk garis

Gambar 3.7 Membentuk garis dengan freehand
= Dobel klik untuk membentuk segmen garis berikutnya

= Dan klik untuk mengakhiri pembuatan garis.

- L] -
L L -
- “. -

Gambar 3.8 Gambar bidang yang tersusun dari garis
3.) Menggambar garis dengan 3 point curve
3 Point Curve merupakan tool yang berfungsi untuk menggambar garis kurva
dengan 3 titik acuan. Langkah menggambar kurva dengan 3-Point Curve
adalah sebagai berikut :
Klik 3 Point Curve tool pada toolbox

‘-E PRy RS [ I, |

tar~
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Gambar 3.9 Point Curve pada toolbox

PR R e

Klik tahan dan geser mouse untuk membentuk garis dasar kurva, garis

Gambar 3.10 Obyek grafis dengan 3 point curve

= kemudian klik untuk mengakhiri proses.
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4.) Melengkungkan dan meluruskan garis
Saat mendesain obyek dari bentuk dasar garis bukan tidak mungkin kita

memerlukan proses untuk melengkungan atau pun meluruskan garis. Untuk

melengkungkan garis lurus bisa menggunakan perintah Shape tool B untuk
melengkungkan garis sesuai kebutuhan. Shape tool juga dapat digunakan
untuk meluruskan garis lengkung.

Adapun langkah - langkah untuk melengkungkan garis lurus adalah sebagai
berikut :

«  Kiik Pen tool 2 pada toolbox

Gambar 3.11 Pen tool pada toolbox
= Dan buat objek garis seperti gambar di bawah ini, Dobel klik pada titik

akhir membuat garis untuk mengakhiri pembuatan obyek garis.

- 1=}

Gambar 3.12 Obyek garis dengan pen tool
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Gambar 3.13 Titik ancol dengan shape tool
= kemudian klik Convert to curve pada property bar dan geser titik
anchor untuk melengkungkan garis.
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dengan shape tool

Gambar 3.14 Mengeser titik anchor pada garis
= Setelah titik achor digeser dibeberapa titik akan menghasilkan obyek

grafis garis lengkung sebagai berikut

Gambar 3.15 Obyek garis lengkung dengan mengedit titik anchornya
Untuk meluruskan garis lengkung langkah-langkah sama dengan diatas,

namun bedanya tool yang digunakan pada property bar adalah Convert to line,

;A"'mu ..;:D

1 - - 20
wsasalConvert Curve ToLinep il

Gambar 3.16 Property bar untuk convert curve to line

maka garis lengkung akan berubah menjadi garis lurus.

Garis lengkung

dengan titik achor - - Garis lengkung
berubah jadi lurus

Gambar 3.17 Garis lengkung diubah menjadi garis lurus
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c. Rangkuman
Pada paparan materi kegiatan belajar pengolahan obyek garis ini dapat
dirangkum sebagai berikut :
= Untuk membuat obyek garis dan kurva dapat menggunakan tool — tool
diantaranya pen tool,freehand, 3 Point Curve tool.
= Freehand tool memiliki fungsi hampir sama dengan Pen tool, namun
memiliki perbedaan yang terletak pada pembentukan titik acuan dilakukan
dengan cara dobel klik.
= Garis lurus dapat diubah menjadi bentuk melengkung menggunakan
fasilitas shape tool dan convert to curve
= Sebaliknya bentuk melengkung dapat diubah menjadi bentuk lurus

menggunakan fasilitas shape tool dan convert to line

d. Tugas
1. Buatlah obyek-obyek garis berikut ini menggunakan teknik dan tool yang
sudah dijelaskan di kegiatan belajar ini

a. b.

c. buatlah obyek garis yang menyerupai tanda tangan anda
Tuliskan langkah-langkah untuk menyajikan obyek garis tersebut
Bandingkan keunggulan dan kelemahan dari tool yang Anda gunakan

Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
1. Bandingkan tentang fungsi dari pen tool,freehand serta 3 point
curve tool untuk pembuatan garis
2. Bagaimana cara agar garis lengkung berubah menjadi garis lurus
?
3. Bagaimana caranya agar garis yang Anda buat benar-benar

menjadi garis lurus secara vertikal atau horisontal ?
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f. Lembar Jawaban Tes Formatif

LJ - 01 : pen tool,freehand serta 3 point curve tool untuk pembuatan garis
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g. Lembar Kerja Siswa
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4. Kegiatan Belajar 4 : Menyajikan Hasil Pengolahan Obyek Bidang

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 4 ini siswa diharapkan dapat :
1) Memahami obyek bidang
2) Menyajikan pengolahan obyek bidang

b. Uraian Materi

Pada kegiatan belajar 4 akan dipelajari teknik- teknik untuk menggambar
obyek bidang. Saat menggambar obyek bidang dapat menggunakan bantuan
pelbagai tool yang sudah ada di aplikasi pengolah citra vektor CorelDraw.

Menggambar objek bangun ruang meliputi menggambar persegi, lingkaran,
polygon, bintang dan lain sebagainya. bangun ruang dapat digambar secara
langsung maupun secara manual.

1.) Menggambar bidang persegi dengan rectangle tool

Menggambar persegi dapat dilakukan dengan dua cara yaitu dengan
Rectangle tool atau dengan 3-Point Rectangle.

Rectangle tool merupakan tool untuk menggambar objek persegi panjang
atau bujur sangkar. Adapun langkah untuk menggambar persegi panjang dengan
Rectangle tool adalah sebagai berikut :

= Klik Rectangle tool pada toolbox atau tekan F6

= -~ r)

=

QODEh &R
1

ectangle Tool (F6))

Gambar 4.1 Rectangle tool pada toolbox

= Klik tahan dan geser mouse di dalam lembar kerja sehingga membentuk

objek persegi panjang. = B =
[ x El
" = ®

Gambar 4.2 obyek persegi panjang
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Secara default sudut yang terbentuk pada bidang persegi panjang adalah
sudut siku atau didalam round corner bernilai 0% sudut siku tersebut dapat diatur

sehingga membentuk sudut yang tidak siku

0, ==

Sudut 0°
Gambar 4.3 besar sudut berubah dari 0° ke 60°

Sudut 60°

Untuk mengatur bentuk dan radius kelengkungan sudut objek pada
property bar dapat dilakukan dengan jalan :
= Pilih bentuk Round corner pada properti bar

= Dan ubah nilai sudut, misalnya 60° dengan kondisi round corner

together terkunci/aktif
= ) B ) o
60 "~ F Vg vaq ' ‘
6::3( va L 2 60 T A 4\ — .' x l.

round corner u u u
together aktif

Gambar 4.4. mengubah sudut dengan round corner

= Non aktifkan round corner together dengan cara klik tombol round
corner together pada property bar agar bisa mengubah besar sudut
tertentu saja, misalnya pada sudut kiri atas dan kanan bawah diisi dengan
0° dan sudut kiri bawah dan kanan atas diisi 60°.

= Maka akan menghasilkan obyek bidang persegi yang memiliki sudut yang

berbeda By "
0 wa PN 60 ¥~ - " o.
n
o walhidln e ,ﬁ —) Y
/ = " m 'm

round corner
together tidak aktif

Gambar 4.5 obyek persegi panjang dengan besar sudut yang berbeda-beda
= Untuk membuat objek bujur sangkar, tekan tombol Ctrl saat menggeser

mouse.
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2.) Menggambar bidang persegi dengan 3 point rectangle tool

3 Point Rectangle tool memilik fungsi untuk membuat persegi dengan pola
tiga titik. Langkah — langkah untuk menggambar objek persegi dengan 3 Point
Rectangle adalah :

= Kilik 3 Point Rectangle tool pada toolbox.
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Gambar 4.6 point rectangle pada toolbox
= Klik tahan dan geser mouse untuk menentukan ukuran tinggi objek kotak,

kemudian lepaskan klik mouse.

Gambar 4.7 obyek persegi panjang dengan 3 point rectangle
= Geser mouse untuk menentukan ukuran lebar objek persegi dan klik

mouse untuk mengakhiri.

3.) Menggambar elips dengan Ellipse tool

Untuk menggambar elips atau lingkaran dapat dilakukan dengan
menggunakan Ellipse tool ataupun 3 Point Ellipse. Ellipse tool berfungsi untuk
menggambar objek elips atau lingkaran.Adapun langkah untuk menggambar
elips dengan Ellipse tool adalah sebagai berikut :

= Kilik Ellipse tool pada toolbox

=E :
=

=, 3

=

= 5
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= Elipse Tool (F7)

Gambar 4.8 ellipse tool pada toolbox

= Klik tahan dan geser mouse untuk menggambar objek elips.
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Gambar 4.9 Pembentukan obyek ellips
= Bentuk dan radius dapat diatur pada pada property bar.
= Misalnya elips akan diubah ke bentuk Pie dan ubah besar sudut, maka

gambar berikut :

) v a | e
= i 3l S ;’| S| — P

oo oy f \

Atur bentuk Atur besar
elips sudut

Gambar 4.10 Tampilan bentuk elips setelah diubah sudutnya
= Untuk membuat objek lingkaran / bulat yang memiliki ukuran diameter
yang sama maka dapat dilakukan dengan menggeser mouse untuk

membuat objek elips, tekan tombol Ctrl .

4.) Menggambar elips dengan 3 Point Ellipse tool

3 Point Ellipse tool merupakan tool untuk menggambar objek lingkaran atau
elips dengan tiga titik acuan. Langkah — lamgkah untuk menggambar objek
lingkaran atau ekips dengan 3-Point Ellipse adalah sebagai berikut :

= Kilik 3-Point Ellipse tool pada toolbox
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Gambar 4.11 point ellipse tool
= Kilik tahan dan geser mouse untuk menentukan ukuran lebar ./ diameter
objek elips dan lepaskan klik mouse.

N\ \ \
¢ - i X

N 7 =
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Gambar 4.12 proses pembuatan obyek ellips
= Kemudian, geser mouse untuk menentukan ukuran panjang objek elips

= klik mouse untuk mengakhiri.
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5.) Menggambar poligon dengan poligon tool

Polygon tool digunakan untuk menggambar objek polygon dengan berbagai
sisi. Adapun Langkah-langkah untuk menggambar objek polygon adalah sebagai
berikut :

= Kilik Polygon tool pada toolbox.
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Gambar 4.13 polygon pada toolbox
= Tentukan jumlah sisi objek polygon pada property bar, misalnya 9 sisi

7 -
20 §

Gambar 4.14 property bar obyek poligon
= Klik tahan dan geser mouse pada lembar kerja untuk menggambar objek

polygon.

Gambar 4.15 obyek poligon
» Tekan shift untuk mendapatkan objek polygon yang sama sisi.

6.) Menggambar bintang dengan poligon tool
Untuk menggambar bintang dapat dibuat menggunakan poligon tool dan
kemudian diedit menggunakan shape tool. Langkah — langkah membuat
bintang adalah sebagai berikut :

= Kilik Polygon tool pada toolbox.

S roise|
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Gambar 4.16 Polygon tool pada toolbox.
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= Tentukan jumlah sisi objek polygon pada property bar, misalnya 9 sisi
Q8 S

Gambar 4.17 property bar obyek poligon
= Klik tahan dan geser mouse pada lembar kerja untuk menggambar objek

polygon.

Gambar 4.18 objek polygon dengan 9 sisi
= Kilik shape tool pada toolbox
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Gambar 4.19 shape tool pada toolbox
= Kemudian arah mouse pada poligon yang sudah dibuat, klik tahan dan

geser mouse shape tool pada salah satu titik sudut obyek poligon ke arah

sembarang
= Maka akan terbentuk bintang X
- O~ - ] \/l
- e ey
- = e ‘
Salah satu
sudut

Gambar 4.20 poligon berubah menjadi bintang
Untuk menggambar bintang, selain menggunakan poligon dan shape tool,

obyek bintang dapat dibuat dengan star tool .(:kl yang ada di toolbox.

7.) Menggambar Spiral
Spiral tool meruapakan tool untuk menggambar objek spiral. Langkah untuk
menggambar objek spiral adalah sebagai berikut :
= Kilik Spiral tool pada toolbox

e
=
=

= = =
S e

Gambar 4.21 spiral tool
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Atur banyaknya spiral pada properti spiral di property bar seperti gambar

dibawah ini ;
® (& & —
2 =2 [oo Y
\ ({((
Banyaknya lingkaran . ~
dalam spiral entuk spiral =

Gambar 4.22 obyek spiral dengan 9 lingkaran

8.) Menggambar dengan graph paper
Graph Paper tool merupakan tool untuk membuat garis-garis table yang

menyerupai kertas grafik. Langkah —langkah untuk menggambar Graph Paper

adalah sebagai berikut :
= Klik Graph Paper tool pada toolbox
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Gambar 4.23 Graph paper tool
Tentukan jumlah kolom dan baris yang akan dibuat pada property bar di

bagian Coloums and Rows. Sebagai contoh, ubah nilai menjadi 4 dan 7.

B~ —
Atur baris
dan kolom
i}

Gambar 4.24 coloumns and rows pada property bar

Klik tahan dan geser mouse pada lembar kerja untuk membentuk objek

kertas grafik.

9.) Memformat garis tepi obyek dengan outline pen
Outline Pen dapat digunakan untuk memformat garis tepi objek meliputi,

tebal garis, warna garis, bentuk garis dan lain sebagainya. Langkah —
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langkah untuk memformat garis tepi obyek dengan outline pen adalah
sebagai berikut :

Klik objek yang akan diformat.

O‘ . -

Gambar 4.25 Objek yang akan diformat

Klik tombol Outline Pen kemudian pilih salah satu pilihan tombol,misalnya

pilih Outline Pen dialog (F12) sehingga tampil kotak dialog Outline Pen.
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Gambar 4.26 Outline Pen dialog pada tool box

Setelah itu akan muncul kotak dialog Outline Pen

x|
Coke: NI~ AT
width —_— -~
Im 'I pores Lot
o 7 Opt =
Stye: oxt o
................... - ol :
Stretche Nb shepe:
L\ EGR Style. 100 e 0t
~S -0
Coerees Line caps e
- A - — Deafat
PN =
Batind f#
S =
Scale with moge
cwea | e

Gambar 4.27 kotak dialog Outline Pen
Atur tatanan untuk memformat garis tepi objek pada kotak dialog Outline
Pen, misalnya style di ubah jadi point dengan wdith 4.0pt
Kemudian klik OK.
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Gambar 4.28 outline pada obyek berubah dari garis lurus menjadi titik-titik

10.) Memilih obyek

Sebelum memformat dan memodifikasi objek, pengguna aplikasi
corelDraw harus memilih objek terlebih dahulu. Ada beberapa cara untuk memilih

objek. Langkah untuk memilih objek tunggal adalah sebagai berikut
= Kiik Pick tool pada tool box

ek Tool

D 2w
0

Gambar 4.29 Pick tool
dan klik objek yang akan dipilih

T — —
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Gambar 4.30 objek yang akan dipilih
Berikut adalah langkah untuk memilih beberapa objek , sebagai berikut
= Klik tombol Pick tool pada toolbox

Gambar 4.31 Pick tool

Klik objek pertama.

Gambar 4.32 satu obyek yang terseleksi
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= Tekan tombol Shift dan klik objek-objek berikutnya yang ingin dipilih,

seperti gambar dibawah ini terdapat 2 obyek yang terseleksi.

Gambar 4.33 dua obyek yang terseleksi.
Selain cara di atas, dapat juga dilakukan memilih beberapa objek dengan
cara menggeser mouse, ikuti langkah berikut :
= Klik tombol Pick tool.

Gambar 4.34 pick tool
= Kilik tahan dan geser mouse hingga mengelilingi objek-objek yang ingin
dipilih.

Gambar 4.35 4 obyek terseleksi
Objek yang tertutup obyek lain dapat dipilih dengan catatan obyek tersebut
terletak di urutan bawah ,Langkah untuk memilih objek yang terletak di urutan
bawah adalah sebagai berikut :
= Kilik tombol Pick tool.

Gambar 4.36 pick tool
= Tekan tombol Alt kemudian klik mouse tepat di atas posisi objek berada di

urutan bawah. |
= - . L]
- - 3
o = -

Gambar 4.37 obyek tertutup yang telah terseleksi
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11.) Menyalin obyek dengan perintah copy — paste

Menyalin objek yaitu menggandakan objek menjadi dua atau lebih. Ada
beberapa cara untuk menyalin objek di dalam CorelDraw, berikut salah satunya,
yaitu dengan menggunakan perintah copy-paste

Menyalin objek dengan Copy-Paste adalah teknik menyalin objek yang paling

umum digunakan. Langkah untuk menyalin objek dengan cara Copy dan

Paste sebagai berikut :

Pilihan objek dengan Pick tool.

Gambar 4.38 obyek terseleksi dengan pick tool
= Kilik Copy @ atau tekan Ctrl+C

=  kemudian klik Paste Eﬁ atau Ctrl+V.

= Selanjutnya, objek hasil salinan akan berada tepat di atas objek sumber.

-

Gambar 4.39 objek hasil salinan yang bertumpuk dengan obyek aslinya
= Klik tahan dan geser posisi objek hasil salinan ke lokasi lain sehingga

anda dapat melihat objek sumbernya

O_e — OO

a ] L]
Gambar 4.40 obyek yang telah dipindahkan dari posisi obyek aslinya

12.) Menyalin obyek dengan teknik duplikasi
Duplikasi juga merupakan teknik menyalin objek. Proses menyalin dengan
teknik duplikasi bisa lebih cepat disbanding dengan Copy-Paste. Langkah
untuk menyalin dengan duplikasi adalah :

Klik Pick tool dan pilih objek.

Gambar 4.41 obyek yang terseleksi menggunakan pick tool

Klik menu Edit - Duplicate, atau tekan tombol Ctrl+D
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= Kemudian tampil objek hasil duplikasi

Gambar 4.42 obyek hasil duplikasi
13.) Menyalin Objek dengan Mouse
Untuk menyalin objek menggunakan mouse dengan praktis dan cepat. Ikuti
langkah berikut untuk menyalin dengan mouse yang dapat dilakukan dengan
jalan sebagai berikut :
= Kilik Pick tool.

Gambar 4.43 pick tool
= Kilik tahan dan geser objek yang akan disalin ke lokasi yang lain.

0" 2Zam)

Gambar 4.44 obyek yang digeser ke lokasi lain
= Sebelum melepas Klik kiri mouse, klik kanan mouse dan lepaskan kedua
klik mouse tersebut secara bersamaan.
7 n L]
SRS
a a "
Gambar 4.45 obyek yang telah tergandakan
14.)Menyalin Objek dengan Fasilitas Menu
Dengan fasilitas menu, anda dapat menyalin objek dengan jumlah salinan
lebih dari satu sekaligus, anda juga dapat mengatur jarak antar objek.

Langkah untuk menyalin objek dengan fasilitas menu adalah :
= Kilik Pick tool dan pilih objek.

= : a :

Gambar 4.46 obyek dengan pick tool
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= Klik menu Edit > Step and Repeat
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Gambar 4.47 perintah step and repeat
» hingga tampil panel Step and Repeat
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Gambar 4.48 panel step and repeat
= Klik jumlah salinan objek yang diinginkan pada kotak teks Number of
copies, misalnya diisi 12 sehinnga elips yang semula hanya 1 di
gandakan menjadi 12
= Pilih perintah pada Horizontal Settings dan Vertical Settings untuk
mengatur hasil salinan objek secara horizontal dan vertical :
- No offset - tidak ada jarak antara objek sumber dan hasil salinan
objek.
- Offset > untuk mengatur jarak antara satu objek dengan objek lain.
- Spacing between objects - untuk mengatur jarak spasi antar objek.
- Distace »>untuk menentukan jarak antar objek baik secara horizontal
maupun vertical.
- Direction >untuk menentukan arah hasil salinan objek, yaitu : Left :
hasil salinan tampil di kiri objek sumber, Right : hasil salinan tampil di
kanan objek sumber, Up : hasil salinan tampil di atas objek sumber,

atau Down : hasil salinan tampil di bawah objek sumber.
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= Kilik tombol Apply sehingga objek akan disalin dengan hasil seperti
berikut :

Gambar 4.49 obyek yang sudah tersalin
15.) Memindah Posisi Objek dengan mouse
Memindah posisi objek adalah memindah objek pada suatu tempat tertentu
dalam lembar kerja. Ada beberapa cara untuk memindah posisi objek, yaitu
menggunakan mouse dan menggunakan keyboard, berikut akan dijelaskan
langkah untuk memindagkan posisi obyek dengan menggunakan mouse .

= Klik tombol Pick tool dan klik objek.

?‘9‘. - = o
| — -

Gambar 4.51 objek digeser ke lokasi baru

16.) Memindah Posisi Objek dengan Keyboard
Selain dengan mouse, anda juga dapat memindah objek dengan menggunakan
keyboard. Perintah ini biasanya digunakan untuk menempatkan objek pada
posisi yang kita inginkan dengan lebih tepat atau akurat. Langkah untuk
memindah objek dengan keyboard adalah :

= Kilik Pick tool dan pilih objek.

= Tekan tombol anak panah keyboard kiri, kanan, atas atau bawah untuk

menggeser posisi objek.
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Gambar 4.52 objek digeser ke lokasi baru




PENGOLAHAN CITRA DIGITAL

17.) Mengubah Ukuran Objek dengan Mouse

Ada beberapa cara dalam mengubah ukuran objek, diantaranya adalah
dengan menggunakan mouse, fasilitas menu, ataupun secara manual dengan
memasukkan nilai skala pada property bar.
Untuk mengubah ukuran objek dengan mouse adalah mengubah ukuran objek
dengan cara klik dan geser mouse ke arah vertical maupun horizontal.

Langkah untuk mengubah ukuran objek dengan mouse adalah :

= Kilik tombol Pick tool ! B dan klik objek yang akan diubah ukurannya.

8 L "
x -
n ] L J

Gambar 4.53

= Klik tahan kotak handle yang ada di sekeliling objek dan geser sesuai

dengan yang diinginkan, dan lepaskan klik mouse.

Gambar 4.54 obyek setelah obyek diubah ukuranya
18.) Mengubah Ukuran Objek dengan fasilitas menu
Mengatur ukuran objek dengan fasilitas menu adalah mengatur ukuran objek
dengan pengaturan-pengaturan yang dituliskan dalam bentuk nilai/angka.

Langkah untuk mengatur ukuran objek dalam fasilitas menu adalah :

= Pilih objek dengan Pick tool R dan pilih objek.

x -

Gambar 4.55 seleksi obyek dengan pick tool
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= Klik menu Arrange -> Tranformations > Scale atau tekan tombol
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Gambar 4.56 arrange - transformations

= Kemudian akan muncul kotak dialog Transformation.
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Gambar 4.57 kotak dialog tranformation
= Ubah ukuran secara horisontal dengan mengisi nilai scale - H : 200
kemudian klik apply
= Maka akan menghasilkan gambar berikut, dimana obyek elips lebih

lebar dari sebelumnya.

Gambar 4.58 obyek ellips yang telah berubah ukuranya

19.) Memutar Objek
Pada CorelIDRAW dapat dilakukan memutar maupun memiringkan objek
sesuai kebutuhan baik secara manual maupun secara langsung dengan
menggunakan perintah menu. Memutar objek dapat dilakukan dengan memutar

titik pusat/handle yang terdapat pada sisi-sisi objek dengan cara klik tahan dan
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geser pada mouse. Langkah- langkah untuk memutar objek adalah sebagai

berikut :

= Klik tombol Pick tool | % dan Klik objek.

; —

Gambar 4.59 pick tool dan obyek
= Klik sekali lagi pada objek sehingga tampil kotak hendle rotasi sekeliling
objek.
= Klik mouse ke salah satu kotak handle rotasi, kemudian geser kea rah
yang diinginkan.
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Gambar 4.60 proses obyek yang dirotasi pada handle rotasi

Selain menggunakan perintah di atas, dapat juga memutar objek dengan
perintah menu pada menu Arrange > Tranformations - rotate sehinga akan

muncul kotak dialog transformation — rotation
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Gambar 4.61 transformation - rotation



PENGOLAHAN CITRA DIGITAL

Atur pada bagian rotation — angle untuk mendapatkan sudut kemiringan yang

diinginkan dan klik apply untuk menjalankan perintah rotasi.

c. Rangkuman
Dari uraian materi pengolah obyek bidang dapat dirangkum sebagai berikut :

= Banyak obyek bidang diantaranya
- Menggambar bidang persegi dengan rectangle tool
- Menggambar bidang persegi dengan 3 point rectangle tool
- Menggambar elips dengan Ellipse tool
- Menggambar poligon dengan poligon tool
- Menggambar bintang dengan poligon tool
- Menggambar Spiral
- Menggambar dengan graph paper

= Selain membuat obyek bidang, dapat pula dilakukan editing
sederhana pada obyek garis dan bidang, diantaranya :
- Memformat garis tepi obyek
- Memilih obyek
- Menyalin obyek
- Memindah Posisi Objek
- Mengubah Ukuran Objek
- Memutar Objek

d. Tugas
1. Buatlah obyek — obyek bidang dengan menggunakan
a. rectangle tool
3 point rectangle tool

Ellipse tool

b

c

d. poligon tool
e. poligon tool

f. Spiral

g. graph paper

2. Diskusikan tentang karakteristik tool-tool yang Anda gunakan untuk

membuat obyek bidang teman sebangku Anda
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3. Presentasikan didepan kelas hasil karya Anda

e. Tes Formatif
1. Tool — tool apa sajakah yang digunakan untuk membuat obyek bidang ?
2. Apakah fungsi dari “ titik pusat/handle “ dari sebuah obyek bidang ?
3. Jelaskan fungsi dari kotak dialog “panel Step and Repeat” ?

4. Apa sajakah yang dapat di atur menggunakan kotak dialog “outline pen”

f. Lembar Jawaban Tes Formatif
LJ - 01 : Tool — tool untuk membuat obyek bidang
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g. Lembar Kerja Siswa
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5.Kegiatan Belajar 5 : Mengolah Obyek Grafis

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 5 ini siswa diharapkan dapat :
1) Memahami obyek grafis
2) Memahami pengolahan obyek grafis

3) Menyajikan hasil pengolahan obyek grafis

b. Uraian Materi
1.) Mengatur urutan obyek

Adakalanya saat membuat obyek di lembar kerja urutannya kurang
sesuai dengan yang diinginkan, oleh karena itu diperlukan untuk mengatur posisi
dan urutan objek maksudnya adalah mengatur posisi objek dari atas hingga
bawah pada suatu objek yang bertumpuk/bertindih. Langkah — langkah untuk

mengatur posisi urutan objek adalah sebagai berikut :

Klik Pick tool h dan pilih objek, pada contoh dibawah obyek yang akan
diubah urutanya adalah obyek oval kecil dengan urutan paling belakang
(urutan ke 3) akan dipindah ke depan

Gambar 5.1 memilih obyek urutan terbawah dengan pick tool
= Pilih menu Arrange - Order -> to front of page maka obyek akan
bergeser menjadi urutan paling depan
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Gambar 5. 2 obyek hasil perintah order to front of page
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= Perintah To Front Of Page dapat digantikan dengan shortcut key
Ctrl+Home

= Untuk obyek menggeser menjadi urutan paling depan  dapat pula
menggunakan perintah Arrange - Order > To Front Of Layer atau
shortcut key Shift+PgUp .

Pada perintah Arrange - Order , selain To Front Of Page dan To Front Of

Layer terdapat pula perintah lainnya yaitu :

= To Back Of Page atau Ctrl+End untuk memindah objek ke urutan paling

bawah.

Gambar 5.3 hasil pemidahan posisi obyek dengan “to back of page”
= To Back Of Layer atau Shift+PgDn untuk memindah objek ke urutan
palinn hawah

R
-

L x
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!

Gambar 5.4 hasil pemidahan posisi obyek dengan “to back of layer”
= Forward One atau Ctrl+PgUp untuk memindah objek agar naik satu

tingkat ke depan

Gambar 5.5 hasil pemidahan posisi obyek dengan perintah “forward one”
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» Back One atau Ctrl+PgDn untuk memindah objek agar turun satu tingkat

Gambar 5.6 hasil pemidahan posisi obyek dengan perintah “back one”

= Reserve Order untuk membalik urutan seluruh objek terpilih.

Gambar 5.7 hasil pemidahan posisi obyek dengan perintah “reserve order”

= In Front Of untuk memindah objek di atas objek tertentu. Setelah memilih
perintah ini, akandiminta untuk memilih objek acuan untuk menentukan
posisi objek. Seperti contoh berikut, obyek yan akandigeser urutanya

adalah oval kecil kuning, akan digeser didepan oval besar orange

-»;

Gambar 5. 8 hasil pemidahan posisi obyek dengan perintah “ in front of”
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= Behind untuk memindah objek di bawah objek tertentu. Setelah memilih
perintah ini, kemudian akan diminta untuk memilih objek acuan untuk
menentukan posisi objek. Obyek kotak biru akan dipindah urutanya

dibelakang oval kecil kuning

Gambar 5.9 hasil pemidahan posisi obyek dengan perintah “behind”

2.) Menggabung obyek - obyek

Menggabung objek adalah menggabung beberapa objek menjadi objek
tunggal. Objek yang telah digabung masih dapat dipisah/dipecah kembali.
Menggabung obyek pada CorelDraw dapat dilakukan dengan perintah Combine
dan weld.

Pada saat menggabung objek dengan Combine maka dua objek atau lebih
sehingga membentuk sebuah objek tunggal.Sedangkan dengan bila
menggunakan Weld maka menggabungkan beberapa objek menjadi sebuah
objek baru yang tidak dapat dipecah kembali.

Berikut ini akan dilakukan penggabungan obyek dengan menggunakan

perintah weld, adapun langkahnya adalah sebagai berikut :

= Kilik Pick tool ﬁ? dan seleksi objek-objek yang akan digabung.

" - -
. ..AF
o x -
- - -

Gambar 5.10 menyeleksi obyek dengan pick tool

= Klik menu Arrange - Shaping - Weld
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Gambar 5.11 menu arrange - shaping
= Kemudian kedua objek tersebut akan digabung menjadi objek tunggal

yang warna tunggal(satu warna)

|

Gambar 5.12 obyek hasil proses weld
Selain itu cara di atas, perintah weld dapat digunakan dengan jalan
mengklik tombol Weld pada property bar.
OB @8 GG aF =
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Gambar 5.13 perintah weld pada property bar

Penggabungan obyek menggunakan perintah combine dapat dilakukan
dengan jalan klik menu Arrange -> Combine, atau tekan Ctrl+L, atau tekan
tombol Combine pada property bar

= |8 = 2 &

BONS 100
s e o mbine (Ctrl= L)

Gambar 5.14 perintah combine pada property bar

sehingga objek akan tergabung menjadi objek tunggal dengan perpotongan
antara objek-objek yang digabung akan berlubang, hal ini sedikit berbeda dengan
hasil penggabungan menggunakan weld.
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Gambar 5.15 hasil pengabungan obyek dengan perintah combine
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3.) Memotong obyek

Memotong objek suatu proses menghilangkan sebagian objek berdasarkan
objek pemotong, objek pemotong harus menindih di atas objek yang
dipotong.Pemotongan sebagian obyek pada corelDraw dapat dilakukan dengan
perintah trim dan simplfy.

Memotong objek dengan Trim adalah memotong objek dengan posisi objek
pemotong berada di atas objek yang akan dipotong. Langkah — langkah untuk

memotong objek menggunakan perintah Trim adalah sebagai berikut :

= Kilik Pick tool [_[? dan pilih objek yang akan digunakan untuk memotong,
yaitu objek oval dan obyek yang akan dipotong adalah kotak

Obyek yang -
akan dipotong

Obyek pemotong

Gambar 5.16 obyek pemotong dan yang akan dipotong
= Tekan Shift dan klik objek yang akan dipotong, yaitu objek kotak
o o -

Gambar 5.17 tekan shift dan obyek yang akan dipotong
= Klik menu Arrange > Shaping—> Trim

m Begs  Bovaps Jem Tk  Wedee g
| N

3 Oawr Tisnstonpuescns

: Agn oed Dttt . QREQa® o B
1 Ceder o 13 i
. ——————
¥ e Oni-G

Q) Somibinn Ol

£ Lock Otync:

BT

© Congee Te Cames coeq |G R |- |
3ol Comat Outra T4 St v | ptenen 7

O e,

& Lo Mews Kacd

P Bach Vs Focem

g

Gambar 5.18 menu trim

= Atau klik tombol Trim pada property bar.
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Gambar 5.19 trim pada property bar

= Selanjutnya, pindahkan posisi objek persegi untuk melihat hasil

perpotongan

yek pemotong

L . Obyek terpotong

Obyek terpotong
pada posisi awal keti'k:':\ didrag dari
setelah terpotong L 4 <_/msJ-sl awal

-

Gambar 5.20 proses pemindahan hasil trim
= Objek hasil pemotonaan denaan trim

. ~ - Obyek kotak
‘ yang terpotong
oleh obyek oval

Obyek

. .
LJ - LJ

Gambar 5.21 obyek hasil pemotongandengan trim
Selain dengan trims dapat pula dilakukan pemotongan dengan
simplify.Dengan perintah simplify digunakan untuk memotong objek yang telah
terletak di bawah obijek lain. Jika terdapat tumpukkan objek lebih dari satu, maka
objek yang posisinya di atas akan memotong objek yang terletak di bawahnya.

Langkah untuk memotong objek dengan Simplify adalah sebagai berikut :

= Kilik Pick tool ﬁ'? dan pilih objek yang akan dipotong.
) - )

Obyek yang x -
AllAan

3 Obyek pemotong

- - -
Gambar 5.22 memilih obyek pemotong dan yang akan dipotong

= Klik menu Arrange - Shaping > Simplify
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Gambar 5.23 perintah simplify
= Atau tekan tombol saling memotong objek yang ada di bawahnya.
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Gambar 5.24 simplify pada property bar
= Pindahkan objek-objek yang telah terpotong sehingga tampak seperti

gambar berikut.

Obyek pemotong e ~
b
. 1 Obyek kotak yang
v e terpotong oleh
obyek oval
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Gambar 5.25 obyek hasil proses simplify

4.) Membuat obyek dengan intersect

Suatu objek dapat dibuat dari objek lain dengan membuat objek baru
berdasarkan gabungan dari beberapa objek tanpa harus menghilangkan objek
asli. Membuat objek dari objek lain dapat dilakukan dengan berbagai cara, salah
satunya dengan bantuan perintah intersect.

Perintah Intersect digunakan untuk menciptakan sebuah objek baru

berdasarkan perpotongan beberapa objek yang terseleksi. Langkah - langkah
untuk menciptakan objek baru menggunakan Intersect adalah sebagai berikut :

= Kilik Pick tool ﬁg dan seleksi beberapa objek sumbernya.
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Gambar 5.26 seleksi beberapa obyek dengan pick tool
= Klik menu Arrange - Shaping - Intersect
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Wagrg

Gambar 5.27 menu intersect

= Atau klik tombol intersect pada property bar.

oeelara =

Gambar 5.28 perintah intersect pada property bar
= Perpotongan antar dua objek tersebut akan membentuk objek baru yang

dihasilkan dari irisan kedua obvek asli (kotak dan lingkaran)

Obyek asli : Obyek baru yang
lingkaran f masih tertindih
\ obyek asli
ek asli kotak

Gambar 5.29 perpotongan 2 obyek asli

= Klik dan geser posisi objek hasil perpotongan ke posisi lain untuk melihat
hasilnya

Obyek asli \

byek asli

Obyek baru setelah

< digeser dari kedua
' obyek asli

Gambar 5.30 obyek bari hasil perpotongan obyek kotak dan oval

5.) Shape editing untuk pengolahan obyek grafis
Shape tool menggunakan fasilitas yang digunakan untuk memodifikasi

bentuk objek, seperti : melengkungkan bentuk garis objek, menambahkan dan
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menghapus titik-titik pembentuk objek, meluruskan bentuk garis objek, dan
sebagainya. Pada kegiatan belajar ini akan di jelaskan fungsi dari tool yang
terdapat pada menu shape yang lebih di pergunakan untuk memodifikasi objek.
Pada Shape Editing berisi tool-tool yang dapat anda gunakan untuk
mengubah dan memodifikasi bentuk objek. Ketika flyouts pada shape Editing

A“l di klik akan muncul pilihan tool sebagai berikut
'ﬁl”} d 4’ %——-ﬁee transform
: Z A
Shape tool” / \
Roughen brush

Smudge brush
Gambar 5.31 shape editing ketika flyouts

Untuk penggunaan shape editing sudah dibahas dalam kegiatan belajar

sebelumnya. Berikut adalah penggunaan smudge brush untuk memodifikasi
obyekperseqi.
= Buat objek persegi panjang dengan pen tool ataupun rectangle tool.

Gambar 5. 32 objek persegi panjang dengan pen tool

= Klik smudge brush yl
= Atur ukuran brush Nip size pada property bar, misal 1 cm.

i|@ 1.0cm -~
Gambar 5.33 brush Nip size pada property bar

= Kilik tahan dan geser smudge brush dari dalam objek keluar objek.
P 7

Proses editing dengan Hasil editing dengan

smudge brush smudge brush

Gambar 5.34 obyek hasil editing dengan smudge brush
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c. Rangkuman

Dari kegiatan belajar Pengolahan obyek grafis dapat disimpulkan sebagai
berikut

Pengolahan obyek grafis dapat dilakukan dengan mengatur urutan obyek,
menggabung obyek - obyek , memotong obyek, mengubah dengan shape
tool

Perintah Intersect digunakan untuk menciptakan sebuah objek baru
berdasarkan perpotongan beberapa objek yang terseleksi

Untuk menggabungkan obyek-obyek grafis dapat menggunakan fasilitas
weld maupun combine

Memotong obyek grafis dapat dilakukan dengan bantuan fasilitas trim
ataupun simplify

Shape tool menggunakan fasilitas yang digunakan untuk memodifikasi
bentuk objek, seperti : melengkungkan bentuk garis objek, menambahkan
dan menghapus titik-titik pembentuk objek, meluruskan bentuk garis

objek, dan sebagainya.

d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di olah
Smudge brush S S

Menggunakan shaping
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Menggunakan shaping
serta tool untuk menggambar

garis lengkung

2. Tuliskan langkah-langkah untuk menyajikan obyek garis tersebut pada
aplikasi pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
1. Bandingkan fungsi dari tool — tool yang termasuk dalam shaping tool
2. Menurut Anda, bagaimana langkah yang paling mudah untuk mengatur
urutan obyek
3. Apa sajakah fungsi shape tool pada pengolahan sebuah citra vektor ?

f. Lembar Jawaban Tes Formatif
LJ - 01 : fungsi dari tool — tool dalam shaping tool
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LJ - 02 : mengatur urutan obyek

g. Lembar Kerja Siswa
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6. Kegiatan Belajar 6 : Mengolah Teks

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 6 ini siswa diharapkan dapat :
1) Memahami proses pengolahan teks

2) Menyajikan teks dalam bentuk obyek grafis

b. Uraian Materi

Terdapat dua tipe teks pada aplikasi pengolahan grafis CorelDraw,yakni teks
artistik dan paragraf. Teks Artistik biasa digunakan untuk mengetik judul atau
teks-teks yang pendek seperti pada tipografy ataupun teks efek.

Sedangkan Teks Paragraf berguna untuk mengetik teks yang panjang seperti
isi naskah yang termuat dalam frame teks.
1.) Menyajikan teks artistik

- Klik Text tool “| pada toolbox.

= Klik mouse pada lembar kerja, kemudian ketik teks

- Misalnya ketikall kata “Citla Vektor”

Gambar 6.1 obyek teks dengan text tool
= Untuk menganti jenis huruf (font) dan ukuran teks dapat menggunakan

perintah yang terdapat toolbar property
|| catoneger w|log = U §|= - F o
=

3

Al

/ .
Character  Edit text

Jenis font ukuran font Bold, italic, .
formating

underline

Gambar 6.2 toolbar property
= Setelah jenis font diganti dengan cataneo BT dan ukuran font diubah

menjadi 48 pt maka akanmenghasilkan tampilan sebagai berikut

-Citra Vektor-

Gambar 6.3 teks dengan font cataneo BT
= Klik kanan warna pada palet Color yang terdapat dibagian kanan lembar

kerja untuk mengubah warna garis tepi teks.
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= Kilik warna pada palet Color yang terdapat dibagian kanan lembar kerja

untuk mengubah warna bidang teks, pada contoh dibawah warna teks

diubah meniadi merah(red)

-Ci tra Vektor-

teks Palet color

Gambar 6.4 warna teks diganti dengan warna merah/red
2.) Menyajikan teks paragraf
Teks Paragraf berguna untuk mengetik teks yang panjang dalam
paragraf/frame teks.Langkah - langkah untuk mengetik teks paragraph

adalah sebagai berikut :

= Klik Text tool & pada toolbox

= Klik tahan dan geser mouse pada lembar kerja untuk membentuk frame
teks paragraph.

Gambar 6.5 frame teks paragraf

= Ketik teks dalam frame teks yang terbentuk

- v .
Mewamal toks dengan
wama solid maupun dengan
wama gradasi, Langkah
* mewamal lokS hampir sama *
dengan mewarnal pada
Dbk
O ’;
Gambar 6.6 teks dalam frame teks paragraf

= Untuk menganti jenis huruf (font) dan ukuran teks dapat menggunakan

perintah yang terdapat toolbar property
’ T Cateneg\6T - 4a$ . U ;F abl

5

A\l

/ .
Character  Edit text

Jenis font ukuran font Bold, italic, .
formating

underline

Gambar 6. 7 toolbar property
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3.) Menyisipkan teks dalam suatu obyek
Mengetik teks dalam objek adalah mengetik teks yang hanya termuat dalam

suatu objek saja. Langkah-langkah untuk mengetik teks dalam objek adalah
sebagai berikut :

= Buat obyek grafis, misalnya obyek oval

Gambar 6. 8 obyek oval
= Klik Text tool & pada toolbox.
= Arahkan mouse ke bagian tepi objek hingga panah mouse berubah bentuk

menjadi , kemudian klik mouse.

Gambar 6.9 teks tool dalam obyek oval
= Ketik teks dalam frame teks yang telah terbentuk

- ‘1 -
Mengetik
teks dalam objek adalah
*Lmengetik teks yanl) hanya termuat  *
dalam suaty objek saja
. e b ahe ™

Gambar 6.10 teks dalam obyek oval
Saat mengarahkan pointer mouse pada bagian garis tepi objek, akan
melihat dua bentuk kursor yang memiliki fungsi berbeda :

= —->Untuk mengetik teks pada bagian dalam objek, hasilnya
- ‘1 -
Mengetik
teks dalam objek adalah
mengetik teks yanl) hanya termuat  J®
datam suaty objek saja

™ e bl ™

Gambar 6.11 teks dengan menggunakan icon

- ->Untuk mengetik teks pada bagian garis tepi objek.
gO\a\‘\an Citrg v

()
S %,
o »

Gambar 6.12 teks dengan menggunakan icon A
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4.) Menuliskan teks pada alur

Mengetik teks pada alur adalah mengetik teks pada suatu alur / pola garis
tertentu. Langkah — langkah untuk mengetik teks pada alur adalah sebagai
berikut :

= Buatlah sebuah alur objek menggunakan Freehand # yang akan digunakan

sebagai alur teks , misalnya seperti pola garis berikut

a . [ L]
) R, S ™
e ] . . : .

n o o

Gambar 6.13 menggambar kurva dengan freehand
= Klik Teks tool dan arahkan mouse pada garis tepi objek alur hingga berubah

menjadi £

Gambar 6.14 Teks tool padia kuirva
= Kemudian klik mouse pada tepi obyek dan ketik teks di sepanjang alur

.QBD_QOIah an citra"

Gambar 6.15 teks pada obyek kurva

= Untuk memisahkan teks tersebut dari alur/garisnya maka klik menu arrange
- break text apart atau gunakan shortcut key ctrl+K

&range  Effects Btmaps Text Toos  ‘Wndow el

Trarsformatons >
3+ Choae Traruforpatscns !
A3on and Distribute » |TeXSeeeeing 41 | O
P o 4 BRESSE0S BT
»@ Groun e

2 I - < ]

Gambar 6.16 perintah break text apart
= Kemudian klik pada garis alur, kemudia tekan Delete pada keyboard
untuk menghapus garis alur.

= Maka akan terlihat teks tanpa garis/alur seperti gambar berikut




PENGOLAHAN CITRA DIGITAL

penQO/ahan —_—

Gambar 6.17 teks yang berbentuk kurva
5.) Memformat paragraf
Saat pemformatan teks/paragraf  pada aplikasi CorelDraw bertujuan
mengatur tatanan teks, baik berupa jenis Font, ukuran teks, warna teks, posisi
teks, dan lain sebagainya. Untuk memformat teks dapat menggunakan menu text
, daftar perintah yang terdapat dalam menu text digambarkan pada gambar
berikut.

S e
acter Formatting ErisT
Par agraph Foermatting
TE Tabs...
T BE <oMwwrnrs... t
- = Buflets...
8= orop Cop---
ab] Edk Text... e+ Shift+ 7
Insesrt Symbol Character Ceed4F13
Insest Formattiong Code >
T P& Text To Path
Ao ARogn To Baseline AR+FLZ
A28 Straighten Test
Paragraph Text Frame >
3 Use Hyphenation
| =5 rypbenation Settings. ..
b YWriting Tools >
@ Encode. ..
1 TA Charge Case...
- Maloe Teoxt Web Compatible
1 59 Conwert To Astistic Text Ctri+F8
« =5 Texk Statistics...
Gl Show pon-Printing Characters
= Fook List Options...

Gambar 6.18 menu teks

Selain pada menu text, perintah-perintah editing text/paragraf terdapat di icon
ditoolbar property

Cateneg BT v 48 - =
|| catane R L

/ .
Character  Edit text
formating

Jenis font ukuran font Bold, italic,
underline

Gambar 6.19 text property bar

Dalam memformat teks mapun paragraph, dapat dilakukan pengaturan
perataan teks maupun indentasi paragraf. Langkah — langkah untuk mengatur

pertaan teks adalah sebagai berikut :

= Kilik Text tool & pada toolbox

= Blok teks yang akan diatur perataannya.




PENGOLAHAN CITRA DIGITAL

|||| |

||| |
A e

4
av

Gambar 6.20 teks dalam teks paragraf

= KIlik tombol Text alignment pada property bar

BrUEESS Fu
Teaa e I None N | T PR
- Cirlat

Quieit

oAty Qe
B Force Justly  Cuie

Gambar 6.21 Text alignment pada property bar
= Dan pilih salah satu perataan teks, misalnya saja center maka akan format
teks dalam paragraf akan berubah menjadi
Pelbagai karya sem dapat dilihat
dalam kehidupan sehari-hari |
misalnya websate, blog, kartu nams, |
kartu undangan, liflet, brosur, seni !
fotograf
Banyak pengguna komputer yang
menciptakan sebuah webstle dengan
desain grafis yang paling menarnk
untek ditampilkan

Gambar 6.22 teks dengan rata tengah

Keterangan dari Text alignment
- Left > mengubah perataan teks menjadi rata kiri.
- Center >mengubah perataan teks menjadi rata tengah.
- Right > mengubah perataan teks menjadi rata kanan.
- Full Justify > mengubah perataan teks menjadi rata kiri dan kanan,
kecuali baris terakhir.
- Force Justify > mengubah perataan teks menjadi rata kiri dan kanan,

termasuk bari paling akhir.
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6.) Mengatur jarak antar teks
Mengatur jarak antar teks yang meliputi, mengatur jarak antar baris dan
mengatur jarak antar karakter. Langkah-langkah untuk mengatur jarak antar teks

pada paragraph adalah sebagai berikut

= Klik Pick tool * pada toolbox
= Klik frame teks sehingga muncul symbol dan di bagian sudut kanan

bawah dari frame teks.
Pelbagai karya seni dapat dilihat
dalam kehidupan sehari-hari .
misalnya website. blog, kartu nama,
kartu undangan, liflet, brosur, sem
- fotografi. =
Banyak pengguna komputer yang
Atur jarak

menciptakan sebuah website dengan
horisontal

desain grafis yang paling menank

untuk ditampilkan Atur jarak

- j=
Gambar 6.23 pengaturan pada fr

= Geser symbol II* ke kanan/kiri untuk mengubah jarak antar karakter
secara horisontal
= Geser symbol Tke atas/bawah untuk mengubah jarak antar baris secara

vertical

7.) Mengubah bentuk penulisan teks menggunakan perintah change case
Mengubah bentuk penulisan teks adalah mengubah huruf capital dari suatu
kata tertentu menjadi huruf kecil atau sebaliknya. Langkah — langkah untuk

mengubah bentuk penulisan teks adalah sebagai berikut :

,'\
= Klik Text tool '“* dan klik teks yang akan diubah.

:citra yektor:

Gambar 6.24 teks yang dibuat dengan teks tool
= Klik menu Teks > Change Case untuk menampilkan kotak dialog Change

Case.
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(hoor Cane x|

Sertenis Cace
Mowariase

. PTERCAs
Tem Cone
POGAL oA

1 o I Caccel rec
Gambar 6.25 kotak dialog change case
= Pilih salah satu , misalnya UPPER CASE dan klik OK maka akan
menghasilkan teks seperti dibawah ini

CITRA VEKTOR

Gambar 6.26 teks dengan format change case — upper case

Berikut keterangan kotak dialog Change Case.
- Sentence case 2 mengubah huruf pertama setiap kalimat menjadi huruf
capital.
- Lowercase - mengubah semua huruf menjadi huruf kecil.
- UPPERCASE - mengubah semua huruf menjadi huruf capital.
- Title Case - mengubah huruf pertama setiap kata menjadi capital.
- tOGGLE cASE - membalik bentuk penulisan huruf, huruf capital akan

diubah menjadi huruf kecil, dan sebaliknya.

8.) Mengubah tipe teks
Tipe teks dapat diubah dari teks artistic menjadi teks paragraph ataupun
sebaliknya dari teks paragraph menjadi teks artistic. Langkah - langkah untuk

mengubah tipe objek teks adalah sebagai berikut :

»

= Klik Pick tool | " pada toolbox dan pilih objek teks artistic.

.CITRA VEKTOR:

Gambar 6.27 teks yang terseleksi dengan pick tool
= Klik menu Text > Convert To Paragraf Text atau gunakan shortcut key

Ctrl+F8 untuk mengubah teks artistic menjadi teks paragraph.
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et Tk iesdow —
L ) Oviet
Lo oy woh Foreasneg

o] o e .. Ottt
oot Syobal Chaescter Lt S T
et Sty Code »

¥ re e To Poth

At &hor Tz Basedne R F3

23 Sraften Tent
P ooz noh Ted Frame »

Brtwg Yook »
D treode..
FA Crangs Case..

orvvert Teut (e d )

Gambar 6.28 perintah convert to paragraf text

= Setelah itu teks artistik akan berubah menjadi teks paragraf

. o .
. o v.
Gambar 6.29 teks berubah menjadi teks paragraf
= untuk langkag sebaliknya vyaitu untuk mengubah tipe teks dari
teksparagraph menjadi teks artistic dilakukan cara yang sama vyaitu

dengan meggunakan shortcut key Ctrl+F8 atau menggunakan perintah

menu Text > Convert To Artistik Text

B3| Conyert To Artistic Text  Clrl+F8

Gambar 6.30 perintah convert to artistik text

9.) Mengubah obyek teks menjadi obyek kurva

Tipe obyek teks dapat diubah menjadi objek kurva dengan tujuan untuk
mengolah obyek teks tersebut menjadi obyek grafis yang lebih variatif dan
menarik . Saat obyek teks telah diubah menjadi obyek kurva maka obyek kurva

tersebut tidak dapat mengubah isi teksnya kembali.

Langkah - langkah untuk mengubah obyek teks menjadi obyek kurva adalah

sebagai berikut :

»
N

= Kilik Pick tool ' " pada toolbox dan teks yang akan diubah tipenya.
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-CorelDraw:

Gambar 6.31 teks yang terseleksi dengan pick tool

Klik menu Arrange > Convert To Curves, atau tekan ctrl+Q

m:o-’. Taoh  Wndiw o
-

w * Omar Trarolorgatiors
Son and Catrbute . L'

e L B PR

2 ook Anetc Teut: Dol Gorac Sod Mack (Black) (BN Agat  Ondet
) Lo Ctmar

3|

Gambar 6.32 perintah convert to curves

Akan menghasilkan tampilan sebagai berikut

CorelDraw

Gambar 6.33 teks hasil convert to curves

Langkah  berikutnya adalah  mengedit/merubah  bentuk  huruf

menggunakan bantuan shape tool. Klik shape tool [Z‘ yang ada di

toolbox dan teks akan berubah siap diedit

CorelDraw

Gambar 6.34 teks siap di edit dengan menggunakan shape tool
Klik dan drag mouse shape tool™: - ke sembarang arah di titik sudut —
sudut dari teks sehingga menghasilkan obyek grafis teks yang diinginkan,

misalnya saja seperti gambar dibawah ini
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CarelDrawr

Gambar 6.35 teks hasil pengeditan

Catatan :
Untuk membantu mengolah sudut-sudut dengan shape tool dapat menggunakan

fasiltas editing curve yang terdapat ditoolbar property
IR 7 e LE

Gambar 6.36 property bar dari editing curve

c. Rangkuman
Dari kegiatan belajar pengolahan obyek teks dapat dirangkum hal — hal
sebagai berikut :
= Terdapat dua jenis obyek teks , yaitu teks artistik dan teks paragraf
= Teks Artistik digunakan untuk judul atau teks tipografy ataupun teks efek.
= Teks Paragraf untuk teks yang panjang seperti isi naskah
= Text tool merupapan tool untuk menuliskan obyek teks
= Tipe teks dapat diubah dari teks artistic menjadi teks paragraph ataupun

sebaliknya dari teks paragraph menjadi teks artistic.

d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit
Menggunakan perintah o Lo
shape tool : -Q '
Stage
O-1vce &
O -ne22" a .- o
Pewarnaan teks, outline mm = ]] m”
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Menggunakan perintah

shape tool

- Teks mengikuti
path

- Teks “SMK”
digeser
menggunakan

shape tool

2. Tuliskan langkah-langkah untuk menyajikan obyek garis tersebut pada
aplikasi pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
1. Apa yang Anda ketahui dengan teks artistik
2. Berikan contoh pengolahan obyek teks yang termasuk dalam teks artistik
3. Yang termasuk dalam kategory teks paragraf adalah teks yang
mempunya sifat ....
4. Berikan contoh pengolahan obyek teks yang termasuk dalam teks

paragraph

f. Lembar Jawaban Tes Formatif
LJ - 01 : teks artistik
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LJ - 02 : contoh obyek teks artistik

g. Lembar Kerja Siswa
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7. Kegiatan Belajar 7 : Mengolah Warna pada Obyek Grafis

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 7 ini siswa diharapkan dapat :
1) Memahami proses pemberian warna pada obyek grafis

2) Menyajikan hasil pengolahan warna pada obyek grafis

b. Uraian Materi

Dengan adanya warna obyek-obyek akan terlihat menarik dan lebih hidup,
pengolahan warna sangat penting saat mendesain obyek grafis. Pada aplikasi
pengolah citra vektor CorelDraw menyediakan pelbagai fasilitas pewarnaan.
Teknik pewarnaan obyek grafis meliputi warna pada (solid), warna pola, warna
gradasi, warna bertekstur dan lain sebagainya.
1.) Mewarnai obyek dan garis dengan palette Color

Color palette merupakan fasilitas untuk memberi warna pada obyek . Warna
bisa diberikan pada bidang objek maupun garis tepi dari obyek. Gambar berikut

adalah posisi pallete color pada lembar kerja CorelDraw.

N A KT g

s N e P . Y T < T3t CUR
; - ¢ e R
t:l N
.
.,
’:: u
p; Palette color I
, i
i I
e e

R L 42t me wm o e a =

GamBar 71 posisivcolor paIIeté- pada lembar kerja
Langkah yang paling cepat dan mudah untuk member warna pada suatu
objek adalah dengan mengklik warna pada pallete color yang terletak di sebelah
kanan dari jendela program CorelDRAW




PENGOLAHAN CITRA DIGITAL

Perhatikan langkah berikut untuk member warna lewat pallete color :

= Kilik Pick tool @ dan klik objek yang akan diberi warna.

LR - -~ Setelah obyek - = 5
‘ diberi warna

- > -

.; — = - - -

Gambar 7.2 pick tool dan obyek
= Kilik warna yang ingin dipasang pada bagian palette color.

/r?%/untuk menghapus

anah atas untuk
P warna obyek

menggulung pilihan )
warna ke atas

L pilihan warna

panah bawah untuk

menggulung pilihan anah kiri untuk
warna ke bawah \ - menampilkan seluruh
o — pilihan warna

1=

Gambar 7.3 bagién — bagian color palette
Keterangan gambar
- klik kiri pada palette color > warna tersebut akan dipasang sebagai
warna bidang objek.
- klik kanan pada palette color > warna tersebut akan dipasang

sebagai warna garis tepi objek.

- klik kiri tombol No Color pada palette color > menghapus warna
bidang objek.

- klik kanan tombol No Color pada palette color > menghapus

warna garis objek.
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- klik tombol panah atas “ atau bawah = - menampilkan pilihan
warna yang lain pada palette color

- klik tombol panah kiri " pada palette Color > menampilkan semua
warna pada palette color

g

[ S

ey =

=

—

j— |

™m

==

Tampilan semua wa/rua/ =3

di color palette E’“ﬁ
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Gambar 7.4 tampilan semua warna pada colo palette
- klik dan tahan salah satu warna hingga tampil pilihan kotak warna

->menampilkan warna muda sampai warna tua dari salah satu warna

e

Tampilan warna muda sampai tua

dari salah satu warna yang terpilih

Gambar 7.5 tampilan warna muda ke tua

2.) Mewarnai obyek dengan interactive fill tool

Interactive Fill tool merupakan tool untuk mewarnai objek dengan berbagai
pilihan warna pengisi bidang objek, yang dapat langsung memilih komposisi
warna yang telah disediakan pada tool bar property. Ada beberapa pilihan dalam

memberi warna dengan Interactive Fill Tool.
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Didalam interactive fill tool terdapat teknik pewarnaan uniform fill, dimana
pilihan warna solid/satu warna yang dapat diberikan pada suatu objek.Langkah -
langkah untuk mewarnai objek dengan Uniform Fill adalah sebagai berikut :

= Kilik Pick tool E‘adan klik objek yang akan diberi warna uniform fill
- - -

L .

Gambar 7.6 pick tool dan obyek
= Klik tombol Interactive Fill tool

Interactive Fill Tool (G)]

Gambar 7.7 Interactive Fill tool

= Kemudian pilihan Uniform Fill & pada bagian Fill type dalam property
bar.
= Atur parameter-parameter pada property bar di bawah ini :
- Pilih mode warna di bagian Uniform fill type. Misal, pilih mode warna
CMYK.

- Ubah nilai-nilai warna C (Cyan), M (Magenta), Y (Yellow) dan K (Black).
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Gambar 7.8 parameter warna pada property bar

» Perhatikan perubahan warnanya pada objek yang terpilih.
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Gambar 7.9 perubahan warna obyek

3.) Mewarnai obyek dengan warna gradasi
Warna gradasi adalah gabungan dari beberapa warna yang digunakan untuk

mewarnai sebuah objek sehingga tampak lebih hidup.
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Ada beberapa tipe warna gradasi yang telah tersedia dalam CorelDRAW,
yaitu :
- Linear - gradasi warna ditampilkan mengalir dengan pola lurus.
- Conical ->gradasi warna ditampilkan dengan pola melingkar.
- Radial > gradasi warna ditampilkan dengan pola mengalir dari tengah
objek ke arah tepi.
- Square - gradasi warna ditampilkan dengan pola persegi empat.

Langkah untuk member warna gradasi pada objek adalah :

= Kilik Pick tool @ dan pilih objek.
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Gambar 7.10 pick tool dan obyek
= KIlik Interactive Fill tool pada toolbox

Ey e

Ieteractrve Fll Todd (G)
Gambar 7.11 Interactive Fill tool pada toolbox
= Kemudian pilih tipe warna gradasi , misalnya pilihan : Linear, Radial,
Conical, atau Square pada kotak Fill Type pada bagian property bar.
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Gambar 7.12 property bar untuk memilih tipe warna gradasi

o Berikut hasil bila memilih linear untuk member warna gradasi dengan pola

garis lurus.
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gradasi
Gambar 7.13 gradasi libear dengan titik pusat ditengah
= Geser titik pusat gradasi ke arah kanan, maka akan menghasilkan warna

sebagai berikut

Gambar 7.14 graasi libear dengan titik pusat digeser ke pinggir
4.) Mewarnai obyek dengan mesh fill
Mesh Fill tool merupakan fasilitas mewarnai satu objek dengan berbagai
campuran warna. Dengan mesh fill tool dapat memodifikasi tempat, campuran,
dan variasi warna sesuai kebutuhan. Langkah — langkah untuk mewarnai objek
dengan Mesh Fill tool adalah sebagai berikut :

= Kilik Pick tool dan klik sebuah objek yang akan diberi warna.

Gambar 7.15 pick tool dan obyek
= Klik dan tahan interactive fill tool, kemudian klik tombol Mesh Fill
sehingga objek tersebut akan terbagi menjadi beberapa bidang warna.
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Interactive Mesh Fill Tool (M)

Gambar 7.16 interactive mesh fill tool
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= Akan muncul grid warna pada obyek yang terpilih, kemudian ubah nilai-
nilai Grid size pada warna property bar untuk menentukan jumlah bidang

warna. Perhatikan contoh berikut ini :

S~

Gambar 7.17 pemidahan posisi grid warna pada obyek

= |Isi bidang-bidang warna dengan warna dari palette Color, yaitu dengan

jalan klik salah satu bidang warna dan klik warna pada palette Color.

Gambar 7.18 pewarnaan menggunakan interactive mesh fill tool

5.) Mewarnai obyek dengan pattern

Selain menggunakan perintah Interactive Fill tool, dapat menggunakan

perintah Fill tool untuk memberi warna pada objek. Perintah fill tool terdiri atas

|ap

FiIIcoIor/ F_0un¢in Pa(tern Te\(ture P&Script kf'll Color Docker
dialog fill fill fill fil ' Window

Gambar 7.19 Fill tool pada tool box

Pattern Fill adalah perintah untuk mewarnai objek dengan pola tertentu. Pola
pattern bisa berupa gambar objek abstrak. Langkah — langkah untuk mewarnai
objek dengan Pattern Fill adalah sebagai berikut :

= Kilik Pick tool R dan klik objek yang akan diberi pola warna.
= Kilik Fill tool dan pilih Pattern Fill sehingga tampil kotak dialog Pattern
Fill seperti
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Gambar 7.20 kotak dialog pattern fill
= Kemudian, pilih salah satu pilihan pola warna berikut ini :
- 2-Colors > memilih pola dengan 2 warna.
- Full Colors - memilih pola dengan warna penuh.
- Bitmap ->memilih objek bitmap.
= Misalnya, klik Bitmap dan pilih salah satu pola pada kotak daftar di
sebelah kanannya. Saat pilih bitmap, klik tombol load untuk mengambil

pola warna dari folder lain.
= Kemudian klik OK untuk mengakhiri perintah pattern fill.

Gambar 7.21 obyek dengan pewarnaan pattern fill

6.) Mewarnai obyek dengan fill tool
Fill tool dialog merupakan bagian dari warna pada objek hanya dengan

warna solid atau satu warna. Langkah — langkah untuk mewarnai objek dengan

Fill tool adalah sebagai berikut :

= Kilik Pick tool R dan pilih objek yang akan diberi warna.
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= Kilik Fill tool sehingga tampil kotak dialog Uniform Fill.
Mi
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Gambar 7.22 kotak dialog Fill tool
= Dan akan muncul kotak dialog sebagai berikut
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Gambar 7.23 kotak dialog uniform
= Pada tabulasi Models, pilih warna dengan cara : geser slider untuk memilih
warna. Kemudian, pilih gelap-terang warna dengan mengklik salah satu warna
pada kotak warna.
= Dan akan menghasilkan perubahan warna sebagai berikut, obyek yang

semula berwarna orange berubah menjadi hijau

e

9 0 L
Gambar 7.24 warna berubah dari orange menjadi hijau

= Selain memilih models, dapat pula memilih warna pada tabulasi Mixers dan
Palletes.
= Bila pilih mixers maka akan muncul kotak dialog mixers, klik tombol OK untuk

mengakhiri
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Gambar 7.25 kotak dialog uniform - mixers
= Bila pilih palettes maka akan muncul kotak dialog palettess, klik tombol OK

untuk mengakhiri
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Gambar 7.26 kotak dialog uniform — palettes

c. Rangkuman
Materi pada kegiatan belajar mengolah warna pada obyek grafis ini dapat
disimpulkan bahwa :
= Dengan adanya warna obyek-obyek akan terlihat menarik dan lebih
hidup, pengolahan warna sangat penting saat mendesain obyek grafis.
= Teknik pewarnaan obyek grafis meliputi warna pada (solid), warna pola,

warna gradasi, warna bertekstur dan lain sebagainya.
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= Tool — tool yang digunakan untuk mengolah warna pada obyek grafis,

diantaranya adalah palette color, interactive fill tool, mesh fill, pattern fill,

texture fill
d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit
O l.: 83,
'. .o “; Mgt oy
' ¥ i
9 :
:‘- wo i | ~E
W | "

gambar awal menggunakan Teknik pewarnaan menggunakan
freehand tool interactive mesh tool

Gambar awal terdiri dari 5 obyek

oval
2. Tuliskan langkah-langkah untuk menyajikan obyek garis tersebut pada

aplikasi pengolah presentasi
3. Presentasikan didepan kelas hasil karya anda
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e. Tes Formatif
1. Bandingkan fungsi ketiga jenis model pewarnaan pada kotak dialog
uniform fill
2. Sebutkan tool — tool yang digunakan pada mengolah warna pada obyek
grafis
3. Bandingkan tentang macam — macam teknik yang digunaan pada
pewarnaan gradasi

f. Lembar Jawaban Tes Formatif

LJ - 01 : model pewarnaan pada kotak dialog uniform fill
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g. Lembar Kerja Siswa
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8. Kegiatan Belajar 8 : Mengolah Obyek Artistik

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 8 ini siswa diharapkan dapat :
1) Memahami jenis — jenis obyek artistik
2) Memahami proses pengolahan obyek artistik

3) Menyajikan hasil pengolahan obyek artistik

b. Uraian Materi

Artistic Media Tool berisi perintah untuk menggambar objek — obyek yang
bersifat artistic. Artistic Media Tool merupakan tool untuk menambahkan brush,
menyemprot, serta menambahkan efek kaligrafi pada desain citra vektor. Untuk

perintah artistik media tool tersedia di toolbar property
sprayer presure

}

%@X 9 *\ 100 & ;:35.4mm 2 ‘_N\"

preset -
brusb( calligra\phic i \
Ukuran dari Preview artistik
obyek artistik media

Gambar 8.1 property bar Artistic Media Tool
Terdapat beberapa model artistik media diantaranya :
- Preset - artistic yang menyerupai bentuk pensil
- Brush = artistic yang menyerupai bentuk brush
- Sprayer -> artistic dalam bentuk objek-objek gambar tertentu
- Calligraphic - bentuk artistic yang menyerupai huruf arab / huruf latin.
- Presure - artistic yang menyerupai bentuk crayon
Selain terdapat di toolbar property, pilihan/kotak dialog untuk mengolah
artistik media tool juga terdapat di sebelah kanan dari lembar kerja CorelDraw.
Untuk menampilkan kotak dialog artistik media tool dapat dilakukan dengan klik
menu effects - artistic media

Arrange Bitrmaps Text Tools Window Help

& U Adyust -
Transform L s
== [E Correction > -| & 2,53=m = Q::
O 7 Ao e, T S
Blend 7]

Gambar 8.2 artistik media pada menu effects
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Maka akan terbuka kotak dialog artistic media tool yang berada disebelah

kanan lembar kerja
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Gambar 8.3 kotak dialog artistic media tool
Berikut adalah salah satu contoh langkah penggunaan artistic media sprayer,

dimana fasilitas artistic media sprayer akan menghasikan obyek gambar tertentu.

= Kiik Artistic Media %’ pada bagian toolbox

R o I .

Gambar 8.4 artistic media pada tool box
= Kilik tombol Sprayer pada property bar.
=== @ Z 00 & | "B2Ssmm I eee—

sprayer

Gambar 8.5 property bar artistic media
= Kemudian buat garis menggunakan artistik media pada lembar kerja,

sehingga akan menghasilkan obyek artistik =

- - -
.
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R ! % 4
Garis yang dibentuk / k *‘
Obyek artistik §ang -

artistic media -

telah terbentuk

Gambar 8.6 obyek artistik media
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= Atur parameter kuas sprayer pada bagian Property bar, seperti pada
gambar berikut
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Gambar 8.7 sprayer pada bagian Property bar
= Size of sprayed objects untuk mengatur ukuran objek sprayer, berikut ini
obyek artistik dengan ukuran yang berbeda
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Gambar 8.8 pengaturan ukuran objek sprayer
= Spray pattern untuk memilih bentuk spray atau obyek spray yang akan
digunakan, misalnya pilih obyek spray berbentuk ghost maka gambar
akan berubah dari bentuk daun menjadi ghost
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Gambar 8.9 macam Spray pattern

= Spray order > memilih pola objek artistic, spray order ada 3 pilihan yaitu
randomly - sequentially — by direction

- Randomly > menata objek spray secara acak seperti contoh gambar
dibawah ini
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Gambar 8.10 macam obyek randomly
Sequentially > menata objek spray secara zigzag
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Gambar 8.11 macam obyek Sequentlally

By Direction - menata objek spray dengan bentuk dan arah yang
sama.
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Gambar 8.12 macam obyek By Direction

C
= Spraylist options L untuk mengatur objek spray melalui kotak dialog
Create Playlist.
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Gambar 8.13 kotak dialog Create Playlist.

Atur objek spray menggunakan tombol-tombol dalam kotak dialog
tersebut dan klik ok untuk menjalankan perintah.
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- Move Up I.' *. > memindah urutan objek spray di bagian Playlist ke

atas.

- Move Down l? - memindah urutan objek spray di bagian Playlist ke

bawah.

- Flip Vertical I£| - membalik urutan daftar objek spray di bagian
Playlist.

- Add >> - menambahkan objek spray dari jendela Spraylist ke
jendela Playlist.

Reanye

-  Remove. | > menghapus objek spray dari jendela Playlist.

- Add All I AddAL | 3 menambahkan semua objek spray ke jendela
Playlist.

- Clear e | —>menghapus semua objek spray dari jendela

Playlist.

Langkah — langkah untuk membuat obyek artistik lainya hampir sama
dengan langkah membuat obyek artistik sprayer, yang membedakan adalah
detail property pada masing-masing jenis obyek artistik. Berikut ini hasil dari jenis

- jenis obyek artistik

preset

brush ST =

Artistic media
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calligraphic

Pressure

2.) Memecah artistik media
Saat obyek artistik terbentuk biasa terdiri dari beberapa obyek dan obyek
tersebut bisa dipisahkan sesuai dengan kebutuhan saat mendesain citra vektor.

Objek artistik dengan langkah sebagai berikut.

= Kilik Artistic Media Tool &- dan buat artistic bebas.

' ™ ™
' v =
' ™ -

Gambar 8.14 obyek artistik media

= Kk Pick tool & dan seleksi objek artistic.
» Klik menu Arrange - Break Artistic Media Group Apart atau gunakan
shortcut key tekan Ctrl+K untuk memecah objek artistic.
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Gambar 8.15 perintah break artistik media group apa?t pada menu arrange

= Klik Ungroup : pada properti bar untuk memisah objek artistic dari
% @ a 8
by 50 10
““{Ungroup (CtrIvU)r

Gambar 8.16 ungroup pada property bar

sumbu

= Atau klik kanan pada obyek artistik dan plilh ungroup , bisa juga
menggunakan shortcut key ctrl+U

= Kemudian hapus sumbu tersebut dengan menekan tombol delete
L
- s

Gambar 8.17 menghilang garis sumbu pada obyek artistik media

dikeyboard sehingga terpisah dari obyek artisik

u
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yang akan
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= Kemudian klik Ungroup % sekali lagi untuk memisah objek artistic geser

objek yang sudah terpecah.
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Gambar 8.18 objek artistik media yang sudah dipecah
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c. Rangkuman
Pada paparan materi kegiatan belajar pengolahan obyek artistik ini dapat
dirangkum sebagai berikut :
= Artistic Media Tool berisi perintah untuk menggambar objek — obyek
yang bersifat artistic
= Terdapat beberapa model artistik media diantaranya :
- Preset - artistic yang menyerupai bentuk pensil
- Brush - artistic yang menyerupai bentuk brush
- Sprayer > artistic dalam bentuk objek-objek gambar tertentu
- Calligraphic 2> bentuk artistic yang menyerupai huruf arab atau
huruf latin.
- Presure - artistic yang menyerupai bentuk crayon
= obyek artistik dapat dipisahkan sesuai dengan kebutuhan saat mendesain
citra vektor dengan menggunakan perintah Arrange - Break Artistic

Media Group Apart dan dilanjutkan meng-ungroup obyek artistiknya.

d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit
Obyel awal J 3
L PEREEA-
i ﬂ

408

serta artistik media

1 -
-

Gabungan dari ”m '[“' . =
obyek teks, artistik Likar semimar sehari

. ’ \ ienjadi petani jumur sukse
media serta shape * Cfﬂﬁ”
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2. Tuliskan langkah-langkah untuk menyajikan obyek garis tersebut pada
aplikasi pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
1. Bandingkan bentuk dari beberapa model artistik media pada pengolah
citra vektor

2. Bandingkan kegunaan dari macam-macam pola pada spray order

f. Lembar Jawaban Tes Formatif
LJ - 01 : model artistik media
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g. Lembar Kerja Siswa




PENGOLAHAN CITRA DIGITAL

9.Kegiatan Belajar 9 : Memahami teknik dasar menggabungkan gambar
bitmap

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 9 ini siswa diharapkan dapat :
1) Mengenal teknik dasar penggabungan gambar bitmap
2) Memahami teknik dasar pengabungan gambar bitmap

3) Menyajikan hasil pengabungan gambar bitmap

b. Uraian Materi
Konsep Layer

Layer merupakan bagian pada aplikasi pengolah gambar bitmap yang
digunakan untuk menggabungkan beberapa gambar menjadi satu gambar.
Layer digunakan untuk menggabungkan beberapa gambar menjadi satu gambar.
Setiap gambar diletakkan dalam satu lapisan layer dan digabungkan dengan
lapisan lapisan layer yang lain sehingga membentuk gambar. Lapisan tersebut

saling bertumpuk sehingga menghasilkan sebuah gambar.

Layer Opacity
e — t M
5 | Channeis | Paths | /

roernd v Cpetiy) 100w »

o o+ 0 N ew »
Visibity Toogie

Laywr 4 Layer Name

P Y et Group Folder

- L Loy )
Layer Thumboal

- Layw 3

Gambar 9.1 bagian layer
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Keterangan gambar :

Layer menu . berisi menu dari layer

Layer name : nama layer misalnya “layer 4”

Group folder . group dari beberapa layer

Active layer . layer yang sedang aktif, ditandai dengan warna biru

Layer lock . layer yang terkunci, ditandai dengan simbol E1 gembok,

bila kondisi layer lock artinya layer tersebut tuik dapat

diedit
Delete layer . lcon untuk mendelete layer
New layer . lcon untuk membuat layer baru
New group . lcon untuk membuat group layer baru
Create . lcon untuk membuat layer adjustment
adjustment layer
Add layer mask . lcon untuk menambahkan layer mask
Add layer style . lcon untuk menambahkan layer style
Link layer . lcon untuk melink-an antar layer
Background layer : Layer yang berfungsi sebagai background
Layer thumnail . Layer ditampilkan secara tumbnail
Visibilty toogle :untuk memunculkan atau menyembunyikan tiap tiap layer
Locking control : untuk mengunci layer agar tidak dapat kita edit. Lock ada

4 macam yaitu :
- lock transparant pixel %

- lock image pixel '

- lock position +

- lock all ®

Pada saat membuat gambar baru maka secara default akan mempunyai
sebuah layer yaitu layer background. Layer tersebut adalah layer dasar didalam
membuat desain. Saat membuat beberapa layer baru maka layer background

akan tetap berada pada lapisan yang terbawah.
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Gambar 9.2 layer dan obyek

Sebaiknya dalam membuat desain, setiap obyek berada pada layer yang
berbeda. Sehingga jika kita memanipulasi salah satu obyek maka perubahannya

tidak akan mempengaruhi obyek yang lain.

Dasar Penggabungan gambar

Layer digunakan untuk menggabungkan beberapa gambar menjadi satu
gambar, Bisa dikatakan saat mengabungkan gambar satu dengan yang lainya
akan terbentuk lebih dari satu layer (multi layer). Artinya beberapa gambar
tersebut seakan akan bertumpuk sehingga akan terlihat menjadi sebuah objek
atau gambar. Gambar yang berada pada layer atas maka akan berada pada
tumpukan yang paling atas dan bisa menutupi tumpukan gambar yang berada

dibawahnya.

Gambar 9.3 penggabungan gambar dengan multi layer
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Langkah — langkah untuk mengabungkan gambar dengan multi layer adalah
sebagai berikut
1. Buat file baru pada aplikasi pengolah gambar bitmap photoshop dengan

perintah file = new (ctrl + N), kemudian akan muncul kotak sebagai

berikut

E a
e [Urntes 2 - [
et (o 3 -
[ T Seehen |
v, [ " = |
e = - Dvvcscored |

i ad O | - e

Zokox Mo [Groycm =] [300 B
Rackgrourd Caneerts: | Bacigraund Cotr = A
¥ Adarced & 190 %

Gambar 9.4 kotak dialog file baru

2. Beri nilai width = 400, height = 400, background contents
background color dan kemudian klik OK

3. Buka file gambar yang akan digabung dengan jalan klik menu file >
open (ctrl + O), kemudian akan terbuka kotak dialog untuk memilih file.

4. Cari file yang akan digabungkan misalnya garfield1.jpg dan
bart_simpson.jpg.

5. Sehingga pada lembar kerja photoshop akan terbuka 3 file

Gambar 9.5 file- file pada lemmbar kerja photoshop
6. Klik dan drag file bart_simpson.jpg ke file yang berisi background warna
kuning, sehingga gambar bart_simpson akan tercopi di file ber-

background kuning
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Gambar bart_simpson.jpg .
muncul dlflle baru Gambar bart_simpson.jpg

tetap ada di file aslinya &
ot 3 _

Gambar 9.6 layer bertambah saat gambar disisipkan

Layer baru, layer berisi
bart_simpson.jpg

7. Saat bart_simpson.jpg tergandakan difile baru maka otomatis akan
terbentuk layer baru yang bernama layer 1

8. Kemudian klik dan drag file garfield1.jpg ke file yang berisi background
warna kuning, sehingga gambar garfield1.jpg akan tercopi di file ber-

background kuning

A2 3 10 (Laper 2L M0

Layer baru) layer
berisi garfield2.jpg

Gambar 9.7 muncul layer 2 ketika gambar ke 2 digabungkan

9. Klik horizontal type tool T dan ketikan teks untuk judul gambar ,
misalnya the simpson & garfield.

10. Maka akan muncul teks “‘the simpson & garfield” pada gambar
gabungan dan secara otomatis akan muncul layer baru sehingga total
layer yang terbentuk adalah 4.
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Gambar 9.8 hasil penggabungan 2 gambar dan obyek teks

Pada contoh penggabungan gambar diatas terbentuk adalah 4 layer

yang terdiri dari :

- Layer background : berisi background

- Layer 1. gambar simpson

- Layer 2 : gambar garfield

- Layer T : berisi teks the simpson & garfield”
Pengaturan Opacity pada Layer
Pada layer terdapat pengaturan tingkat transparansi pada obyek layer. Opacity
digunakan untuk menentukan tingkat transparansi suatu layer terhadap layer
yang lain. Seperti contoh gambar diatas memiliki opacity 100 yang artinya
gambar sama sekali tidak transparan. Jika opacity diberi nilai kurang dari 100
maka layer akan tampak transparan dan semakin kecil nilainya maka layer akan

semakin transparan.

OPACITY HASIL PENGATURAN OPACITY

Obyek garfield pada layer 2 diberi || -ax

nilai opacity sebesar 100 % >
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Obyek garfield pada layer 2 diberi | | ESEIEEEIENERR0 100
C
nilai opacity sebesar 25 %, gambar
pada layer 2 terlihat transparan e s
& Garfield
|
e n Dox) &4 MLIN L)) ]P-J

Obyek garfield pada layer 2 diberi
nilai opacity sebesar 2 %, gambar
seakan — akan tidak ada

Jika suatu layer dibuat transparan maka gambar yang berada pada layer
dibawahnya akan dapat menembus gambar pada layer transparan tersebut.
Berikut adalah langkah untuk memberikan efek transparan obyek pada layer

1. Klik layer yang akan diberi efek transparan, misalnya layer 2 (gambar
garfield)

| Layers x | Channels | Paths | _,;]
[Hcernal ey Opacky: [25% | |
Lock: ] J—i—_

S | T | The smpzon & Garfeld

, —Rgm i

- “ | Layer 1

Pengaturan opacity

- Back prownd 5]

Gambar 9.9 pengaturan opacity pada layer
2. Ubah nilai pada bagian opacity, misal ganti dengan nilai 25%
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3. Maka gambar pada layer 2 (gambar garfield) akan terlihat transparan

| LEATE Y IATEITER | vmTe | .-
— 2] onetys [Z= 1)
wa: s @ re[awals)

oy -
- ) | The s g & Setwhd _]

Latithed 1 W 1 D% (L ayer 2 0GHT) ~1Q1 29

The simpron
& Gadield

_

k

Gambar terlihat__| /

transparan

s D ot % A » ol | »

Gambar 9.10 hasil pengolahan opacity pada layer

Merger Layer

Merge berfungsi untuk menggabungkan beberapa layer menjadi satu layer.
Merge down artinya menggabungkan layer yang sedang aktif dengan layer
dibawahnya. Merge visible menggabungkan semua layer yang visibility-nya diset
aktif. Sedangkan layer yang visibility-nya tidak diset aktif masih tetap berdiri
sendiri. Untuk melakukan merger layer dapat mengikuti langkah-langkah sebagai
berikut :

1. Buat file baru yang terdiri dari beberapa layer, seperti contoh berikut

terdiri dari 5 layer

2. Kiik layer-layer yang akan merger

Gambar 9.11 memilih beberapa layer
3. KIlik kanan pada layer atau klik pada icon =l yang ada dipojok kanan

layer sehingga akan muncul pop up merger layer
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Gambar 9.12perintah merge layer

4. Maka layer yang terseleksi akan ter-merge

[ Oaonts | P . Layers = | GChanewls | Pathe
I j‘

: > B “ ’
- | a Lapwr 4 —l

- b

Layw §

Layer yang
sudah dimerger

Gambar 9.13 layer yang sudah dimerger
Layer 1-4 termerger menjadi layer 4, sehingga ke empat layer tersebut menjadi

satu kesatuan.

Berikut ini contoh pemanfaatan merger untuk memudahkan pengaturan
obyek dilayer.
1. Buka 3 file baru yang akan digabungkan dengan perintah file = open.
Untuk percobaan kali ini gambar 1 adalah gambar background hitam,

gambar 2 background putih dan gambar 3 background kuning.
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Gambar 9.14 file yang akan gabung
2. Pindahkan gambar 2 ke arah gambar 1 dengan jalan klik dan drag.

T L ]

.-owmv-oéua.omtw.a [ —
- o wm(m x|
SEFIEIND
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L Gresoen | Oatm
e v Uiy wore
whi s+ e L Y
d e
'-;mx
- A O S 3 3 )

i N Con. 3303280 .

Gambar 9.15 file gambar 2 yang telah berpindah ke gambar1
3. Buat shape berwarna orange untuk dijadikan bingkai gambar 2

" atwve bood. phossgraphy 37 jpg @ 66 7% Shapa L ROBSY) | (0 J"u- o S
L AL BE MR Bk JP
Bl - Jd .

% »

L=y LGanewh | P |

Worre v OPaiEyl 00N 0

Gambar 9.16 shape orange
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4. Pindahkan layer shape orange dibawah layer gambar2 dengan cara
klik&men-drag layer shape ke bawah layer gambar2, sehingga obyek

gambar 2 terlihat di atas shape

| B cetec Aret phregrady [Ty 8 00T Dhge [ PERA0

| e t——— e aa——

Gambar 9.17 shape dan gambar2

5. Langkah berikutnya adalah me-raster layer shape agar bisa di merger
layer. Klik kanan pada layer shape 1 maka akan pup-op dan pilihlah
“rasterize layer”.

6. Kiik layer “gambar2” kemudian klik kanan dan pilih merger down. Maka

layer gambar2 akan bergabung (dimerger) dengan layer shape1.

« | Cheon
Norme 3 Marge Ev(:.ﬂ
Wi go Vastle Nermal » Opeclty: w00% *

Layers x | Chaneels | Pathe

et I |

= Flattes beis
T PSS sl bt e S &
. A>J. N . m :
et gantert r N
® EXUY gerbert "

Gambar 9.18 layer yang di merger layer

w 0.9 a3

7. Ketika 2 layer telah termerger artinya layer tersebut menjadi 1 layer Pada
saat obyek shape diedit(efek-pindah posisi-atur ukuran gambar) maka
obyek gambar2 juga ikut berubah. Atur posisi dan ukuran shape 1
sehingga mendapatkan kompisi gambar yang diinginkan, misalnya seperti
gambar berikut :

B o et gty 57 g & T e L W ¢ L B e Ao okt gty 170 @ 8N Tage 1 608 e |

Gambar 9.18 obyek pada layer merger dipindah posisinya
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Ulangi langkah 2 sampai 7 untuk mendapatkan gambar akhir seperti

contoh berikut :

T creatrefood-photogeaphy-17.469 © 66.7% (Shape 2. RGB/37) | '.!J - |
[+ L - it 0 ! ' |- ;J

s fu 0 ©. . J a2 ¥

Gambar 9.19 hasil pengolah obyek pada layer yang dimerger

c. Rangkuman

Dari kegiatan belajar menggabungkan gambar dengan multilayer didapat

materi-materi seperti berikut :

Layer merupakan bagian pada aplikasi pengolah gambar bitmap yang
digunakan untuk menggabungkan beberapa gambar menjadi satu gambar
saat membuat gambar baru maka secara default akan mempunyai
sebuah layer yaitu layer background.

Saat membuat beberapa layer baru maka layer background akan tetap
berada pada lapisan yang terbawah.

saat mengabungkan gambar satu dengan yang lainya akan terbentuk

lebih dari satu layer/multi layer
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d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari

Keterangan Obyek setelah di edit

Terdiri dari gambar

7 ~

A memorable trip
starts here.

Book a unique space EM

Dan obyek teks serta garis
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Obyek sebelum di edit

terdiri dari

Buat obyek grafis seperti

disamping dengan (!} [ "‘;‘\“

SALA
memanfaatkan merger (@)‘."\lgm)ﬁﬂ
'

layer dan opacity CENTER

WELKDAYS
10am ‘vl dpm
WEEXENDS
0am 'tH Som

I LENYIRLIN )
R UM

2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi
pengolah presentasi
3. Presentasikan didepan kelas hasil karya anda
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e. Tes Formatif
1. Bagaimana efek pemberian perintah merger layer pada layer photoshop?
2. Apa yang terjadi pada sebuah gambar bitmap diubah nilai opacity pada
layer dari 100% menjadi 30% ?

3. Bagaimana hubungan obyek gambar dengan layer pada photoshop ?

f. Lembar Jawaban Tes Formatif
LJ - 01 : merger layer pada layer photoshop




PENGOLAHAN CITRA DIGITAL

g. Lembar Kerja Siswa
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10.Kegiatan Belajar 10 : Menyajikan Hasil Penggabungan Gambar
Bitmap dengan Teknik Selection

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 10 ini siswa diharapkan dapat :
1) Memahami teknik penggabungan gambar bitmap dengan selection

2) Menyajikan hasil penggabungan gambar bitmap dengan selection

b. Uraian Materi

Untuk menggabungkan gambar banyak jalan yang dapat dilakukan. Teknik yang
sering digunakan diantaranya adalah memilih/menseleksi gambar tertentu
dengan teknik selection setelah itu menggabungkan dengan gambar yang lain
sehingga menjadi desain gambar sesuai yang dibutuhkan.

Pada aplikasi pengolah gambar bitmap disediakan beberapa teknik dan
perangkat seleksi yang mudah untuk digunakan, diantaranya adalah

menggunakan magic wand, lasso tool, marque tool.

Marque tool

Marque tool berfungsi untuk membuat seleksi dengan dengan bentuk
seperti yang disediakan. Untuk memilih bentuknya, tekan sekitar satu detik maka
pilihan bentuk akan muncul. Pilihan bentuk yang disediakan yaitu persegi, elip,
garis vertikal dan garis horisontal

I

r= E
L RectangularMarquee L

I L] IEII||:-t||:aI Mlarquee Tool

m =3 Single Fow Marquee Tool
Terseleksi dengan

E Single Colurnn Marguee Taal

..........

Gambar 10.1 seleksi dengan marque tool

Lasso tool

Lasso tool adalah untuk membuat seleksi dengan bentuk yang tidak
beraturan sesuai dengan yang kita inginkan. Pilihan dari lasso tool ada tiga

macam yaitu: lasso tool, polygonal lasso tool, magnetik lasso tool.

= Lasso tool IPI untuk membuat seleksi yang bentuknya tidak beraturan
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= magnetik lasso tool untuk menseleksi sisi terluar gambar walaupun

gerakan kita tidak persis di sisi gambar

= Polygonal lasso tool gl berfungsi untuk menyeleksi dengan bentuk

polygon atau banyak sisi.

- a0 7 @i Dogg i--- =] B4
: Z
. . Seleksi v{ 7--4_\
Seleksi lasso N magnetik ®

tool

lasso tool 0 \
p W 4

Gambar 10.2 seleksi dengan lasso tool

Quick Selection

Quick Selection Tool merupakan tool pembuatan seleksi instan (sekali klik
terjadi sebuah seleksi). merupakan sebuah kombinasi antara Magic Wand
dengan penggunaan brush. Sama-sama bisa mampu memilih sendiri area
warna, namun lebih mampu dibatasi perbatasan area yang diseleksi jika

dibandingkan dengan Magic Wand.

0 £
:

| s sk seectontodl W
‘_M_WMYool ]

/

g

=

Gambar 10.3 seleksi gambar dengan quick selection
Magic wand

Selekasi dengan menggunakan magic wand merupakan kemudahan
yang disediakan oleh photoshop didalam membuat seleksi. Prinsipnya adalah

tool ini akan menyeleksi daerah yang warnanya sama atau hampir sama. Daerah
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yang diseleksi akan meliputi tempat yang diklik dan daerah disekitarnya yang

memiliki warna hampir sama.

Gambar 10. 4 seleksi gambar dengan magic wand
Penggabungan gambar dengan selection
Saat akan desain ataupun menggabung gambar adakalanya gambar
yang akan di olah hanya seb agian dari gambar tersebut sehingga sebagian
darigambar tersebut harus diseleksi terlebih dahulu untuk kemudian baru
digabung dengan gambar yang lain. Berikut adalah contoh penggabungan
gambar bitmap yang sebelumnya menggunakan pemilihan bagian gambar
dengan teknik seleksi.
1. seleksi untuk gambar yang akan digandakan, gunakan salah satu teknik

seleksi yang ada misalnya dengan lasso tool |‘>|

Gambar 10.5 Gambar ke 1, bagian kepala dari gambar terseleksi dengan lasso

tool
2. lalu buka file gambar yang akan ditempel oleh gambar yang telah

diseleksi tersebut.
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Gambar 10.6 Gambar ke 2,bitmap yang akan di tindih
3. Letakkan kedua gambar berdampingan agar pada saat mendragnya lebih

mudah.

Gambar 10.7 Gambar bitmap diletakan berdampingan

4. Lalu drag gambar yang diseleksi dengan menggunakan move tool E

menuju gambar yang kedua.

Gambar 10.8 Gambar bitmap didrag menuju gambar ke dua

5. Atur posisinya agar sesuai yang diinginkan

c. Rangkuman
Dari paparan materi penggabungan gambar bitmap menggunakan selection
dapat dibuat rangkuman sebagai berikut :
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o Adakalanya gambar yang akan di olah hanya sebagian dari gambar
tersebut sehingga sebagian darigambar tersebut harus diseleksi terlebih
dahulu

o Teknik seleksi yang yang disediakan olah photoshop diantaranya adalah
lasso tool, quick selection serta magic wand

d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit

Terdiri dari 2 gambar

B e ..

Obyek sebelum di edit terdiri dari

Dan
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2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi
pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
1. Banding fungsi dari ketiga selection tool untuk menunjang
menggabungkan gambar bitmap
2. Apa yang menjadi pertimbangan untuk memilih selection tool yang akan

digunakan proses menggabungkan gambar bitmap

f. Lembar Jawaban Tes Formatif
LJ - 01 : Perbandingan selection tool untuk menunjang menggabungkan gambar

bitmap

LJ - 02 : pertimbangan untuk memilih selection tool saat menggabungkan

gambar bitmap
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g. Lembar Kerja Siswa
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11. Kegiatan Belajar 11 : Menggabungkan Gambar Bitmap dengan Layer
Masking

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 11 ini siswa diharapkan dapat :
1) Memahami teknik penggabungan gambar bitmap dengan layer masking
2) Menerapkan layer masking gambar bitmap

3) Menyajikan hasil penggabungan gambar bitmap dengan layer masking

b. Uraian Materi

Layer merupakan lapisan yang tembus pandang bila bagian tersebut tidak
terdapat obyek. Layer dapat atur disusunannya dan memberikan efek ke tiap
layernya dan tidak saling menggangu layer satu dengan yang lainnya.

Pemberian layer masking pada suatu layer bertujuan untuk menyembunyikan
bagian tertentu dari layer. Layer masking set warna pada layer, bila diset warna
hitam artinya untuk menyembunyikan gambar dan warna putih untuk
menampilkan gambar. Layer Mask menutup Layer. Dengan layer dapat menutupi
seluruh Layer atau hanya bagian tertentu saja. Bagian yang tertutup tentunya

akan tidak terlihat, begitupun sebaliknya.

Layers % | Channgs | Paths | =
Normal v Opacky: 1008  *
wk: Ll 7+ @ Pl 1009
Layer yang beri

perintah layer
masking

Layer tidak ada
perintah layer
masking

= wl@e. 5 s

Gambar 11.1 susunan layer dengan layer masking

Tool Masking terletak pada bagian bawah dari pallete layer, secara visual
berbentuk icon persegi panjang yang di tepat di tengah nya terdapat bulatan
seperti pada gambar diatas. Layer Masks memungkinkan untuk
menyembunyikan (mask) bagian dari layer menggunakan painting tools

dan seleksi tool.
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Penggabungan gambar dengan layer masking dan gradient tool

Untuk menggabungkan dua gambar dengan perpotongan latar belakang halus
dapat menggunakan teknik layer masking yang dipadu dengan gradient tool.
Langkah-langkah penggabungan gambar dengan layer masking dan gradient tool
dapat dilakukan sebagai berikut.

1. Siapkan 2 buah file gambar yang akan digabungkan, misalnya gambar

gedung berlatar awan biru dan gambar awan sore hari

MLl ¥ c =

Gambar A

Gambar B — :_‘_,‘__" A

Gambar 11.2 yang akan digabung
2. Pindahkan gambar B ke file gambar A dengan jalan klik dan drag gambar B

ke file gambar A. , _ .
B loerrmankivn - Coprypod ©667% (Lo | < o) bunal

Gambar 11.3 kedua gambar sudah digabung
3. Kemudian atur ukuran gambar B agar sesuai dengan komposisi gambar
A, untuk mengubah ukuran gambar B dapat menggunakan perintah

edit=>free transform
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Pastikan foreground color berwarna hitam

Pastikan layer gambar B aktif, kemudian klik “add vektor mask”.
6. Kilik gradient tool A, kemudian arahkan ke gambar yang akan digabung,
tarik garis dari bawah ke atas

[ emrins Comppd T

Gambar 11.4 saat menarik garis gradient dari atas ke bawah
7. Setelah itu akan menghasilkan penggabungan gambar seperti dibawah
ini.

=

'hmm.mﬁé&&?‘hnlt_.vl e

waeme &% 0

Gambar 11.5 hasil penggabungan gambar layer mask dan gradient

Penggabungan gambar dengan layer masking dan brush
Contoh dibawah ini adalah penggabungan gambar dengan 2 foto yang hampir

sama latar belakangnya yaitu air terjun dan tanah. Tujuan dari penggabungan
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gambar kali ini adalah memunculkan obyek perahu&orang yang ada digambar B
ke dalam gambar A. Sehingga latar belakang air terjun dan tanah gambar B
harus disembunyikan menggunakan teknik brush dengan foreground hitam.
Untuk menggabungkan gambar dengan layer masking dan brush dapat dilihat
pada langkah-langkah berikut.

1. Siapkan 2 buah file gambar yang akan digabungkan , gambar keduanya

mengandung air dan tanah.
! it e L (e s

Gambar B

-
| -

.....

Gambar 11.6 yang akan digabung
2. Pindahkan gambar B ke file gambar A dengan jalan klik dan drag gambar B
ke file gambar A.
3. Kemudian atur ukuran gambar B agar sesuai dengan komposisi gambar A,

untuk mengubah ukuran gambar B dapat menggunakan perintah edit->free

transform.
o
bl
s |l
, :
A
- mbar A
o
al
B
i :
0 '
set Gambar B
foreground Ty

Gambar 11.7 kedua gambar sudah digabung
4. Pastikan foreground color berwarna hitam
5. Pastikan layer gambar B aktif, kemudia klik “add vektor mask”
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- X

| Layers x | Chaness | Patks |
heemal v Opactyr 0% » Layer berisi
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* ! @ |ayer berisi
gambar A

Add layer mask
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Gambar 11.8 add layer mask

6. Kilik brush tool [Z dan atur diameter kuas sehingga diameternya cocok
untuk luasan gambar yang akan diatur, dalam kasus ini digunakan brush
sebesar 77.

7. Arahkan brush ke bagian gambar B yang akan disembunyikan sehingga

akan menghasilkan penggabungan foto seperti berikut

Gambar 11.9 hasil penggabungan dengan layer masking

Memunculkan kembali gambar yang telah tersembunyi
Adakalanya saat mengolah/menggabungkan gambar perlu memunculkan
kembali bagian gambar yang telah disembunyikan. Cara tidak jauh beda dengan
cara masking sebelumnya, namun kali ini untuk memunculkan kembali gambar
yang tersembunyi menggunakan brush dengan foreground putih. Untuk langkah
lebih detailnya dapat menggunakan cara sebagai berikut .

1. Buka file *.psd yang akan diedit misalnya seperti pada gambar berikut
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Gambar 11.10 terdapat bagian gambar yang akan dimunculkan kembali
2. Pada gambar terlihat perahu yang dibagian bawah terlihat agak kabur,
bagian ini yang akan dimunculkan kembali sehingga perahu yang diberi
warna biru terlihat jelas.

3. Ubah foreground menjadi warna putih

4. Kilik brush tool [Z dan atur diameter kuas sehingga diameternya cocok
untuk luasan gambar yang akan diatur, dalam kasus ini digunakan brush
sebesar 77.

5. Arahkan brush ke bagian gambar yang akan dimunculkan kembali,
dalam kasus ini bagian yang dimunculkan adalah perahu yang dibawah
(lingkaran biru), sehingga gambar perahu akan terlihat jelas seperti

gambar dibawah ini.

Gambar 11.11 bagian bawah perahu yang telah dimunculkan kembali
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c. Rangkuman
Dari uraian materi kegiatan belajar kali dapat dibuat rangkuman sebagai berikut :
= Pemberian layer masking pada suatu layer bertujuan untuk
menyembunyikan bagian tertentu dari layer.
= Layer masking set warna pada layer, bila diset warna hitam artinya untuk
menyembunyikan gambar dan warna putih untuk menampilkan gambar.
Layer Mask menutup Layer.
= Dengan layer dapat menutupi seluruh layer atau hanya bagian tertentu
saja. Bagian yang tertutup tentunya akan tidak terlihat.
= Layer Masks memungkinkan untuk menyembunyikan (mask) bagian dari

layer menggunakan painting tools dan seleksi tool.

d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit

Gambar asli terdiri dari 2 , yaitu
Gambar 1

Gambar 2

http://trikmudah.com

Setelah digabung dengan
menggunakan layer masking,

terlihat dalam satu gambar terlihat

2 pemain ski
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Gambar asli merupakan gambar tepian
danau.Terdapat 1 layer berwarna putih
diatas layer obyek danau, layer teratas
tersebut diberi layer mask

{Normal =] Opacty: [31% [¥]
tock: L) b @ Al 0w

http://www.digitalscrapbookplace.

com

a 3

2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi

pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif

1. Bagaimana hasil penggunaan brush dengan foreground hitam pada suatu
layer, dimana layer tersebut diberi perintah “Add vektor mask”

2. Bagaimana hasil penggunaan brush dengan foreground putih pada suatu
layer, dimana layer tersebut diberi perintah “Add vektor mask”

3. Bagaimana hasil penggunaan brush dengan foreground kuning pada
suatu layer, dimana layer tersebut diberi perintah “Add vektor mask”

4. Apa yang terjadi jika mengoleskan brush dengan warna hitam pada suatu
layer tanpa menekan “add vektor mask” terlebih dahulu

5. Apa yang terjadi jika mengoleskan brush dengan warna putih pada suatu

layer tanpa menekan “add vektor mask” terlebih dahulu

f. Lembar Jawaban Tes Formatif
LJ - 01 : “Add vektor mask” dengan foreground hitam
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LJ - 02 : Add vektor mask” dengan foreground putih
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LJ - 05 : Hasil brush warna putih tanpa perintah layer masking

dg. Lembar Kerja Siswa
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12. Kegiatan Belajar 12 : Menggabungkan Gambar Bitmap dengan Quick
Masking

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 12 ini siswa diharapkan dapat :
1). Memahami teknik penggabungan gambar bitmap dengan quick masking
2). Menerapkan quick masking pada gambar bitmap

3). Menyajikan hasil penggabungan gambar bitmap dengan quick masking

b. Uraian Materi

Layer merupakan lapisan yang tembus pandang bila bagian tersebut tidak
terdapat obyek. Layer dapat atur disusunannya dan memberikan efek ke tiap
layernya dan tidak saling menggangu layer satu dengan yang lainnya.
Adakalanya bagian gambar perlu disembunyikan, salah satu cara yang sering
digunakan untuk melakukan itu adalah menggunakan quick masking.

Saat menggunakan tool quick masking dapat dipadukan dengan tool
photoshop yang lainnya, misal gradient tool, brush tool, layer masking dan lain
sebagainya. Fasilitas quick masking terdapat dideretan tool bar. Untuk
mengaktifkan quick mask dengan menekan tombol Q pada keyboard atau

memilih tool Quick Mask Mode.

Edit in Quick Mask Mode (Q) ]::.w\'«.w »

Gambar 12.1 quick mask mode
Prinsip kerja dari quick mask menggunakan channel secara live tanpa harus
memilih layer pada panel pallete dari channel tersebut. Untuk membantu proses
masking dapat menggunakan tool selection serta brush.
Pada mode quick mask terdapat bahwa bagian yang tidak dipilih akan

terbungkus lapisan berwarna merah, istilahnya rubylith. Untuk menutup gambar
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dengan rubylith dan klik mode quick mask pada tool box kemudian tekan
ALT+Del.

e ————
| B L 0 0

rubylith

Gambar 12.2 quick mask dengan rubylith
Proses kerjanya seluruh bagian berwarna merah adalah bagian yang tidak
terseleksi, untuk memberi warna menjadi merah atau sebaliknya kita akan
menggunakan brush tool. Seleksi Quick mask bertumpu pada penggunaan
brush, sehingga harus cermat menggunakan brush tool sesuai dengan kondisi
gambar yang akan diseleksi, jika gambar dengan detail tinggi maka sebaiknya

gunakan brush dengan hardness tinggi.

Penerapan quick mask

Pada contoh berikut penerapan quick mask dengan tujuan merubah warna dari
sebagian gambar yang telah dipilih kemudian bagian gambar tersebut diubah
warna nya menggunakan adjustment. Berikut adalah langkah-langkahnya.

1. Buka file yang akan diedit

Gambar 12.3 gambar yang akan dioleh dengan quick mask
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Langkah berikutnya klik tool quick masking “Jatau tekan “Q”.

w N

Set foreground berwarna hitam.
Q
.Y

r

|Set foreground color |

Gambar 12.4 set foreground color

Klik tool brush 7, dan sesuaiankan diameter dari tool brush, dalam

B

percobaan ini menggunakan diameter 110

5. Arahkan brush ke area background gambar yang akan disembunyikan,

yang ditandai dengan munculnya rubylith pada gambar

Gambar 12.5 proses pemberian rubylith
6. Setelah selesai untuk memasking (yang akan disembunyikan berwarna
merah) , klik “edit in standard mode mode” untuk menghilangkan ara
rubylith

LR

Gy
4 Edit in Standard Mode (Q) |

Gambar 12.6 setelah kembali ke standard mode

7. Ubah foreground menjadi merah
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8. Berikutnya adalah mengubah warna bunga dengan menggunakan
adjusment layer dengan cara klik icon adjusment layer pada deretan layer
dan pilih Hue/saturation

Layers = | Channeis | Patns | =

—JLayeryang telah

Adjusment diberi adjusment

layer \

Gambar 12.7 adjustment layer

9. Setelah itu akan muncul kotak dialog Hue/satueation, atur besarnya hue
saturation dan lightness sampai mendapat gambar yang diinginkan

.Untuk mengakhiri perintah tekan OK.

¥ m—— x B
Mo/ Setoraton ——
*m —

Hoe! 358 -

Gocel
Saruration - Lod..

Save
Lohtnes: -5

v Colorge

i Frevew

=

Gambar 12.8 setting parameter hue saturation
10. Dan hasil akhir

perubahan warna bunga adalah sebagai berikut

Gambar 12.9 bunga berubah warna
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Penggabungan gambar dengan quick mask dan tool brush

Pada penerapan quick mask dengan bantuan tool brush akan
menggabungkan 2 gambar, dimana gambar A akan disembunyikan
backgroundnya dan digantikan background gambar B.

1. Buka 2 file gambar yang akan digabungkan

| W oo o oy § LI Y

Gambar A
Gambar yang akan
di quick masking

Gambar B ;
Gambar yang akan
dijadikan backgrou

Gambar 12.10 Gambar yang akan digabung

2. Langkah berikutnya masking bagian gambar A dengan jalan klik tool

quick masking “Jatau tekan “Q”.
3. Set foreground berwarna hitam.
Q

L

lSﬂ foreground color l
S . —

1
Gambar 12.11 set foreground color

4. Klik tool brush . dan sesuaiankan diameter dari tool brush, dalam
percobaan ini menggunakan diameter 77 — 53 — 30. Dan hardness
sebesar 0%.

o - Mﬁ:;[aa\uodo:m

Master Cianveter 53 pem

v

-l e @& | -
3 2 3 > 23 2 )
- - - - - - |
'S > 13 3z 23 3>
- - - - - -
3s as &s 0o | 200 | 300
- = - - -
= 13 1s iz s ss |~

Gambar 12.12 master diameter tool brush
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5. Arahkan brush ke area background gambar A yang akan disembunyikan,

yang ditandai dengan munculnya rubylith pada gambar.

Gambar 12.13 proses pemberian rubylith
6. Setelah selesai untuk memasking (yang akan disembunyikan berwarna
merah) , klik “edit in standard mode mode” untuk menghilangkan ara
rubylith

_).L
&Y

o Edit in Standaed Mode (Q) |8

Gambar 12.14 setelah kembali ke standard mode

7. Klik drag area yang terseleksi pada gambar A ke gambar B

[0 M v 9 1L B ) i 98 - |

s 0O - - ,

Gambar 12.15 gambar A yang telah dipindah ke gambar B




PENGOLAHAN CITRA DIGITAL

8. Kemudian sesuaikan ukuran dan posisi obyek gambar A dengan

menggunakan “free transform” agar sesuai dengan background dan akan

menghasilkan gambar seperti dibawah ini.

Gambar 12.16 hasil penggabungan dengan masking layer

c. Rangkuman

Dari uraian materi kegiatan belajar kali dapat dibuat rangkuman sebagai berikut :

Salah satu cara untuk menyembunyikan bagian gambar tertentu
digunakan untuk adalah menggunakan quick masking.

Untuk mengaktifkan quick mask dengan menekan tombol Q pada
keyboard atau memilih tool Quick Mask Mode.

Prinsip kerja dari quick mask menggunakan channel secara live tanpa
harus memilih layer pada panel pallete dari channel tersebut.

Pada mode quick mask terdapat bahwa bagian yang tidak dipilih akan
terbungkus lapisan berwarna merah yang bernama rubylith.
Menggunakan brush tool sesuai dengan kondisi gambar yang akan

diseleksi.
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d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit

Gambar asli terdiri dari 2 , yaitu

Kucing dan pemandangan

Gambar asli terdiri dari gambar, yaitu
gambar orang

Pantai

http://www.ephotozine.com

Gambar saat berada di mode on quick

mask. Atur hue/saturationnya
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2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi
pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif

1. Bagaimana hasil penggunaan brush dengan foreground hitam pada suatu
layer, dimana layer tersebut diberi perintah “quick mask mode”

2. Bagaimana hasil penggunaan brush dengan foreground putih pada suatu
layer, dimana layer tersebut diberi perintah “quick mask mode”

3. Apa yang terjadi jika mengoleskan brush dengan warna hitam pada suatu
layer tanpa menekan “quick mask mode” terlebih dahulu

4. Apa yang terjadi jika mengoleskan brush dengan warna putih pada suatu

layer tanpa menekan “quick mask mode” terlebih dahulu

f. Lembar Jawaban Tes Formatif

LJ - 01 : foreground hitam dengan “quick mask mode
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LJ - 03 : foreground hitam tanpa “quick mask mode

g. Lembar Kerja Siswa
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13. Kegiatan Belajar 13 : Menyajikan Efek Layer Adjustment pada
Gambar Bitmap

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 13 ini siswa diharapkan dapat :
1) Memahami konsep layer adjustment
2) Memahami proses penerapan layer adjustment pada obyek gambar bitmap

3) Menyajikan hasil adjustment layer pada obyek gambar bitmap

b. Uraian Materi

Istilah adjustment sering kali ditemukan saat membuka membaca tutorial
atau saat mencoba tool pada aplikasi pengolah gambar bitmap. Pada dasarnya
adjustment itu sendiri ada dua jenis penerapan, yaitu image adjustment dan layer
adjustment. Fungsi dari image adjustment dan layer adjustment hampir sama,
yaitu sama-sama untuk pengaturan/pengubahan warna. Namun ada hal yang
paling mendasari yang membedakan kedua, yaitu jika layer adjustment bersifat
non destruktif sedangkan image adjustment bersifat destruktif.

Layer adjustment merupakan fitur yang bekerja pada layer untuk
menyesuaikan warna gambar bitmap. Ketika melakukan editing gambar bitmap
dengan Layer adjustment maka tidak akan merubah pixel asli dari gambar
tersebut (non destruktif). Icon layer adjustment terdapat pada bagian bawah
layer berupa lingkaran setengah hitam dan setengah bagian berwarna putih.
Ketika icon layer adjustment diklik maka akan muncul pilihan layer adjustment

yang dibagi 4 kelompok yang berisi 17 adjustment layer.
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I Sebd Coler..
Geadhent..

Pattem..

Levels..
I Curves.
Celor Balance..

Brightness/Contrase

Black & White..
Hue/Saturetcn..,

Sefective Collor..

Jxv 8 |
Channel Mixer.
- m Geadhent Map..
I Pheeo Fiter.
Exposure.
rveert
Theesheid ..

T _“@ Posterae.
W 5

Gambar 13.1 layer adjustment

Layer Adjustment > Level
Salah satu jenis layer adjustment yang sering digunakan adalah level.
Pada jenis adjusment ini berfungsi untuk mengatur pewarnaan berdasar channel

RGB, red, green, blue. Dibawah ini adalah kotak dialog level

Levels L — |

s ke ' = |

Input Levels:

Cancel
Load...

Save

Auto
Options...

e eyedroppper
Qutput Levelk: BRI / ;'
[
Output & 7 Preview
. 0 255

paling gelap Output paling

terang
Gambar 13.2 kotak dialog level

Keterangan gambar
Channel Bagian ini digunakan untuk mengatur komponen warna

sebelah mana yang akan diatur. Pilihan yang tersedia adalah




PENGOLAHAN CITRA DIGITAL

Titik Shadow

(input)
Titik Midtone

(input)

Titik Highlite
(input)

Titik paling gelap
(output)

Titik paling
terang (output)
Eyedropper

RGB (Red, Green, dan Blue).

Titik segitiga ini digunakan untuk mengatur agar bagian
gambar yang berwarna gelap/hitam nampak semakin gelap.
Titik segitiga ini digunakan untuk mengatur gamma, yaitu
mengatur  intensitas gelap terang gambar tanpa
mempengaruhi kondisi titik paling gelap dan paling terang.
Titik segitiga ini digunakan untuk mengatur agar bagian
gambar yang berwarna terang/putih nampak semakin terang.
Titik ini digunakan untuk mengatur tingkat paling gelap/hitam
pada gambar.

Titik ini digunakan untuk mengatur tingkat paling terang/puitih
pada gambar.

Tiga tool ini digunakan untuk memilih bagian mana pada
gambar yang Anda anggap merupakan bagian paling gelap,

pertengahan, atau terang secara manual.

Berikut adalah salah satu contoh penerapan layer adjustment - level pada

pengolah gambar bitmap.

1. Buka gambar yang akan diberi efek adjustment layer

Gambar 13.3 gambar yang akan diberi efek adjustment layer

2. Set foreground berwarna merah

3. Kiik icon adjustment > level maka akan muncul kotak dialog adjustment —

level
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Levels “

n|
(|mo
L

Ohannels  RGS -

LN E
8N K
-

Fout Levels - ! ..
Gl

Save...
Aute

1,09 235 Opuons. .. Opacity

Output Leves: } > S 8 . ’

s
M~ o

Gambar 13.4 kotak dialog level
Klik icon “sample in image to set black point” dan arahkan ke foreground

Kemudian atur parameter level seperti dibawah ini

Levels M

Chaneet Aad -

Fovt Loves:

) 47 55 Oploes...

Qutput Leves: / / F
EEEm———
-

Gambar 13.5 parameter level
Ubah channel - red dan ubah nilai angkanya sesuai gambar diatas
Klik “OK” untuk mengakhiri perintah untuk penerapan adjustment level
dan akan menghasilkan gambar seperti dibawah ini, gambar akan

berubah kehijauan.
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Gambar 13.6 hasil adjustment level
Berikut hasil pengolahan pelbagai jenis layer adjustment dengan gambar

aslinya seperti dibawah ini

Solid Color
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Gradient
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Pattern
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Color
Balance
Brightness/
Contrast
Hue/Saturati | [
L B v »
on = - o
Cannt
s sben - et
=
A » Sen
< —
e
T m—
Selective
Color




Chanel Mixer
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Gradient
Map

W o Ul A s o gy g

Invert

Threshold

Themtabilew W4
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Posterize

Penerapan adjustment dan selection image

Berikut ini penerapan layer adjustment untuk memberikan efek pada
sebagian area dari gambar yang diseleksi. Area yang diseleksi diberi nuansa
klasik hitam putih menggunakan layer adjustment > black white. Langkah
detailnya adalah sebagai berikut.
1. Buka gambar yang akan di beri efek adjustment

Gambar 13.8 gambar yang akan diberi efek adjustment

2. Klik magnetic lasso tool untuk menyeleksi area yang tidak terkena efek klasik

black&white
L I
@“' ™ ¢)u-ofoo L

_\. ﬁl —
u wwwfod ¢

Gambar 13.9 magnetic lasso tool

3. Arahkan magnetic lasso tool ke bagian kecambah
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Area terseleksi
agnetic lasso

Gambar 13.10 kecambah yang terseleksi dengan magnetic lasso tool
4. Klik menu select > inverse, hal ini bertujuan untuk membalik area yang
terseleksi

Gambar 13.11 kecambah yang terseleksi inverse

5. Klik icon adjustment > black&white maka akan muncul kotak dialog
adjustment — black&white .

6. Atur parameter adjustment > black&white seperti pada contoh berikut

Prgret:  Costems . =
Been - s - ==
3 &eto
Yedoamn: 101 W™ o e
Srewrs - *> =
Crars - O ~
Sues - e
Magerte: - = -
v e
e -
-_— —
Samaarsee 20 -
o

Gambar 13.12 parameter black and white
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7. Klik OK untuk mengakhiri perintah dan akan menghasilkan perubahan

tampilan sebagai berikut

Gambar 13.13 perubahan gambar setelah diberi efek layer adjustment >
black&white

c. Rangkuman
Pada kegiatan belajar penerapan layer adjustment kali ini dapat dibuat
rangkuman materi sebagai berikut.
o Adjustment ada dua di jenis penerapan, yaitu image adjustment dan
layer adjustment.
o Fungsi dari image adjustment dan layer adjustment hampir sama, yaitu
sama-sama untuk pengaturan/pengubahan warna
o Layer adjustment bersifat non destruktif
o Image adjustment bersifat destruktif.
o lcon layer adjustment terdapat pada bagian bawah layer berupa lingkaran
setengah hitam dan setengah bagian berwarna putih.
o lcon layer adjustment diklik maka akan muncul pilihan layer adjustment

yang dibagi 4 kelompok yang berisi 17 adjustment layer.
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. Tugas

1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari

Keterangan Obyek setelah di edit

Menggunakan efek layer adjustment > |http://www.photoshopessentials.com/

black and white.

Gambar asli

(efek profesional photoshop cs5)
Menggunakan efek :

-Adjusment = curves
- layer mask

-adjusment = color balance
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2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi
pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
1. Apakah yang maksud efek non distruktif
2. Apakah perbedaan jika penerapan layer adjustment — level saat
menggunakan channel RGB-red-green dan blue.
3. Apakah yang terjadi saat suatu gambar diberi efek adjustment — color
balance ?

4. Apakah fungsi selection saat penerapan efek layer adjustment?

f. Lembar Jawaban Tes Formatif
LJ - 01 : efek non distruktif
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g. Lembar Kerja Siswa
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14. Kegiatan Belajar 14 : Menyajikan Efek Image Adjusment pada Gambar
Bitmap

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 14 ini siswa diharapkan dapat :

1) Memahami konsep Image adjusment

2) Memahami proses penerapan Image adjusment layer pada obyek gambar
bitmap

3) Menyajikan hasil Image adjusment pada obyek gambar bitmap

b. Uraian Materi

Seperti yang sudah dibahas pada bab sebelumnya, bahwa terdapat dua jenis
adjustment pada aplikasi pengolah gambar photoshop yaitu layer adjustment dan
image adjustment. Yang membedakan antara keduanya adalah layer adjustment
bersifat non disturktif dan image adjustment bersifat non distruktif.

Image adjustment merupakan salah fitur utama yang digunakan untuk
melakukan penyesuian atau adjustment pada gambar bitmap. Saat melakukan
mengolahan gambar bitmap selalu menggunakan fitur image adjustment. Image
adjustment bersifat distruktif yang artinya perubahan/penyesuaian bersifat

permanen dan merubah susunan pixel asli dari gambar bitmap.

| tevets.. Ctri+L
Auto Levels Shift+ Ctri+ L
Auto Contrast Alt+Shift+ Ctri«L
Auto Color Shift+ Curi+-B
Curves... Curl+- M
Color Balance... Ctri+B

Brightness/Contrast...

Black & Whate... Alt+Shift+« Ctri+B
Hue/Saturation... Ctrl«U
Desaturate Shift« Ctrl- U

Match Color...
Replace Color...
Selective Color...
Channel Muer...
Gradient Map...

' Photo Filter...

1 Shadow/Highlight...

\ Exposure...

i Invert Ciriel
Equalize
Threshold...
Posterize...

| Varniations...

Gambar 14.1 jenis-jenis image adjustment
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Cukup banyak jenis dari image adjustment, secara garis besar terdapat 5
group image adjustment yang terbagi dari 23 jenis image adjustment. Masing-
masing jenis mempunyai fungsi yang berbeda tetapi hanya sedikit yang sering
digunakan. Diantaranya adalah perintah Level dan Curves yang sering
digunakan para professional untuk memperoleh hasil sesuai yang diinginkan.

Image adjustment - levels
levels berfungsi untuk mengoreksi rentang tonal (nada warna) dan masalah

keseimbangan warna. Image adjustment - levels dapat mengoreksi dan
mengatur kecerahan pada gambar bitmap. Selain level dapat juga digunakan
untuk mengkoreksi warna secara manual dengan menentukan titik putih dan
hitam dalam gambar. Hampir setiap gambar akan menjadi lebih baik dengan

penyesuaian levels. Dibawah ini adalah kotak dialog levels.

Levels f\} E‘_% .
3 # Cook )
Input Levels:
Cancel
Load...
Save...
Auto
Shadow Q Q Options...
Qutput Levek: highlite / ,l
[
Output 4 7. Preview
paling gelap mOutput paling
terang
Gambar 14.2 kotak dialog level
Keterangan gambar
Channel Bagian ini digunakan untuk mengatur komponen warna

sebelah mana yang akan diatur. Pilihan yang tersedia adalah
RGB (Red, Green, dan Blue).

Titik Shadow Titik segitiga ini digunakan untuk mengatur agar bagian
(input) gambar yang berwarna gelap/hitam nampak semakin gelap.

Titik Midtone Titik segitiga ini digunakan untuk mengatur gamma, yaitu
(input) mengatur  intensitas gelap terang gambar tanpa

mempengaruhi kondisi titik paling gelap dan paling terang.

eyedroppper
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Titik Highlite Titik segitiga ini digunakan untuk mengatur agar bagian
(input) gambar yang berwarna terang/putih nampak semakin terang.
Titik paling Titik ini digunakan untuk mengatur tingkat paling gelap/hitam
gelap (output) pada gambar.

Titik paling Titik ini digunakan untuk mengatur tingkat paling terang/puitih

terang (output)  pada gambar.

Eyedropper Tiga tool ini digunakan untuk memilih bagian mana pada
gambar yang Anda anggap merupakan bagian paling gelap,
pertengahan, atau terang secara manual.

Image adjustment Levels berfungsi mirip dengan Brightness/Contrast namun
lebih fleksible karena warna dapat diatur warna gelap, warna menengah, dan
warna terang. Level dapat bekerja pada selection atau seluruh gambar bitmap.

Image adjustment levels biasanya digunakan untuk mengatur tingkat
kecerahan dari gambar bitmap. Gambar bisa dibuat menjadi lebih cerah ataupun
lebih terang. Berikut ini adalah contoh pengaturan levels untuk mencerahkan
foto.

1. Buka file gambar yang akan diubah tingkat kecerahannya

Gambar 14.3 gambar yang akan diedit

2. Klik menu image > adjustment > level maka akan terbuka kotak dialog levels

3. Atur parameter adjustment level sebagai berikut
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Gambar 14.4 parameter level
4. Klik “OK” untuk mengakhiri perintah levels dan akan menghasilkan gambar

seperti berikut

Gambar 14.5 gambar bitmap yang sudah diatur kecerahannya

Image Adjustment Color balance

Adjustment color balance berfungsi untuk mengubah mixture dari keseluruhan
warna dalam suatu image untuk melakukan koreksi warna secara umum.
Dengan menggunakan pilihan slider Cyang, Magenta dan Yellow, dapat menaik
digunakan untuk menyesuaikan unsur-unsur warna pada seluruh gambar bitmap,
sementara untuk mengatur keseimbangan total (total balance) tersedia 3 pilihan

Shadow (gelap), Midtones (sedang) dan Highlight (terang).
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Color Balance g
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Color Levels:  +48 #33) o1 .
Cancel
Cyan Red
v Preview
Magenta | Green
Yelow | 8ue
Tone Balance
Shadows & Mgtones Hghights
Preserve Lumnosty
L —— e e — = "‘4

Gambar 14.6 kotak dialog color balance

Image Adjustment hue/saturation

Image Adjustment hue/saturation dapat digunakan untuk melakukan
koreksi, menambah atau mengurangi suatu unsur warna. Ada kalanya gambar
bitmap mengalami kelebihan saturasi, yaitu suatu warna terasa begitu berlebihan
sehingga tidak terkesan natural, misalnya gambarnya terlalu biru. Pada kotak
dialog Hue/Saturation memungkinkan untuk memilih salah satu unsur warna
untuk diatur saturasinya untuk mengatur saturasi pada keseluruhan warna pada
gambar bitmap.

v ¥
e, Syraton g
Eoe: Master - !
oK
Moo
Qacel
{
u \oad... |
Satuaten: 110]
Save
Qraness 9
Coloroe
[
< Pravewm
s —

Gambar 14.7 kotak dialog hue/saturation
Image Adjustment desaturate
Image Adjustment desaturate berfungsi untuk mengubah suatu gambar
bitmap berwarna menjadi hitam putih tanpa harus mengubah mode warnanya.
Kelebihan Desaturate dengan mengubah mode warna Greyscale adalah detail

dari dimensi gelap terang dari suatu gambar bitmap.
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Gambar 14.8 gambar yang telah diberi Image Adjustment desaturate

Image Adjustment match color
Image Adjustment match color merupakanfitur untuk mengatur unsur
brightness dengan hasil yang lebih baik dengan menggunakan slider Luminance

dan Color Component.

Nursch Color —

Destedlon roge o
Target: Gy 10 Sorset jog (RGR/E)
Cancet
ege Ootom ¥ Preves

L wrance m
Color Femty
Fade

Mectaice

ruge Sttt

Sowrce: Nore -
|
Lo ST

Save S5, —

Gambar 14.9 kotak dialog match color
Berikut hasil pengolahan pelbagai jenis layer adjustment dengan gambar

aslinya seperti dibawah ini

Gambar 14.10 gambar yang akan diolah dengan image adjustment
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Penerapan image adjustment dan quick mask

Pada percobaan berikut memanfaatkan fitur quick yang padukan dengan

image adjustment level dan curve. Adapun langkah-langkahnya adalah sebagai

berikut :

1. Buka file gambar yang akan diolah

Gambar 14.11 gambar bitmap yang akan diolah
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2. Pastikan foreground berwarna hitam
3. Klik icon quick mask “4 pada tool bar

4. Klik brush tool dan atur lebar diameter brush
B3 Fi=e Edit Pmage Layer Select Figer

. - Srush: — Mode: Noersal
e 3 T
Master Diarrater 453 p= >
ST
Hardress: o
: BEIE JE
3 3 s £l 13 3
- - - - - - 3
3 > 3 > 23 7
- - - - - -
35 45 S5 220 200 0
- o @ | ~ - -
5 i3 55 e 4s | 85 |~

Gambar 14.12 diameter brush

5. Arahkan brush ke gambar bitmap, tutupi semua gambar dengan brush

Gambar 14.13 gambar bitmap dan quick mask
6. Klik menu image > adjustment > curve maka akan muncul kotak dialog curve

dan atur parameternya seperti pada contoh berikut

et s Ma

=

& Curve Duply Ot

P Aot ot ® (o7 00 —
-

Pt e N
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Gambar 14.14 kotak dialog curve
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7. Kilik OK untuk mengakhiri perintah adjustment curve
8. Kemudian Klik menu image > adjustment >level maka akan muncul kotak

dialog level dan atur parameternya seperti pada contoh berikut

Gambar 14.15 kotak dialog level
9. Klik OK untuk mengakhiri perintah adjustment level
10. Klik “edit in standard mode” pada tool bar untuk keluar dari mode “quick
mask”
11. Langkah berikutnya memperbaiki adjustment curve dengan menggunakan
menu image > adjustment > curve, maka akan muncul kotak dialog curve

dan atur parameternya seperti pada contoh berikut

Gambar 14.16 kotak dialog curve
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12. Klik OK untuk mengakhiri perintah adjustment curve dan didapatkan hasil
akhir bagian daun dari gambar bitmap nampak lebih hijau dari gambar

semula

Gambar 14.17Hasil akhir pengolahan gambar dengan quick mask dan adjustment

c. Rangkuman
Pada kegiatan belajar penerapan image adjustment kali ini dapat dibuat
rangkuman materi sebagai berikut.
= Adjustment ada dua di jenis penerapan, yaitu image adjustment dan
layer adjustment.
= Fungsi dari image adjustment dan layer adjustment hampir sama, yaitu
sama-sama untuk pengaturan/pengubahan warna
= |mage adjustment bersifat destruktif yang artinya
perubahan/penyesuaian bersifat permanen dan merubah susunan pixel
asli dari gambar bitmap.
» Fitur image adjustment dapat diakses melalui menu image > adjustment
» |con image adjustment diklik maka akan muncul pilihan layer adjustment

yang dibagi 5 kelompok yang berisi 23 image adjustment.
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d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit

Gambar asli

image adjustment levels http://www.photoshopessentials.com

Gambar asli

(efek profesional photoshop cs5)

Menggunakan efek :

-Adjusment - curves
- layer mask

-adjusment - color balance
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2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi
pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
1. Apakah yang maksud efek distruktif
2. Apakah perbedaan jika penerapan layer adjustment — level saat
menggunakan channel RGB-red-green dan blue.
3. Apakah yang terjadi saat suatu gambar diberi efek adjustment — color
balance ?

4. Apakah fungsi eyedropper saat penerapan efek adjustment-level?

f. Lembar Jawaban Tes Formatif
LJ - 01 : efek distruktif
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g. Lembar Kerja Siswa
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15. Kegiatan Belajar 15 : Menerapkan Efek Layer Style pada gambar
bitmap

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 15 ini siswa diharapkan dapat :
1) Memahami macam blending options pada aplikasi pengolah gambar
bitmap
2) Memahami macam style pada aplikasi pengolah gambar bitmap
3) Memahami penerapan efek blending options pada gambar bitmap
4) Memahami penerapan style options pada gambar bitmap
5) Menyajikan hasil pemberian efek blending options dan style pada layer

gambar bitmap

b. Uraian Materi

Layer styles merupakan salah satu cara untuk memberikan spesial efek yang
dapat diterapkan untuk obyek pada layer aplikasi pengolah gambar bitmap
photoshop. Layer Styles berhubungan dengan layer content. Efek blending
option pada layer dapat diubah - ubah layer sesuai dengan kebutuhan desain.
Layer style bisa diberikan ke obyek layer, shape maupun obyek teks.

Layer style secara garis besar dapat dibagi menjadi 2 yaitu style dan
blending options. Saat menggunakan style efek tercipta lebih cepat namun sering
kali efek yang disediakan masih kurang pas dengan yang diinginkan desainer.
Pada kegiatan belajar dibahasa style dan blending options.

1) Blending Options

Bila ingin membuat efek yang detail sesuai dengan keinginanan dpat
menggunakan layer style — blending option sebagai jalan keluarnya. Efek layer
style-blending options dapat bisa dibuat sendiri dengan menggunakan macam
efek pilihan serta seting parameter. Saat layer diberi efek maka akan terlihat

pada layernya

Layers x | Channels | Paths o=
. . Layer dengan

Normal - Opackty: 300% *
Lock: e o - | Fil: 100% *
=i T 2
— er tanpa
- | Sackground & ] - -

Gambar 15.1 tanda layer telah dibeli efek
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Effect blending option hanya bisa diberikan pada layer baru dan tidak bisa
diberikan kepada layer background. Dengan memanfaatkan blending option, bisa
diciptakan pelbagai macam sendiri dengan mengatur parameter — parameternya.

Berikut merupakan bagian dari kotak dialog blending option

Layer Style v

wmsmE= g ) mm———— ——
| General Bleading \ / I
| Sland Mode: Novmal - : Cancel
| Opacty: ook I | Mew Style...
I —-— . . -
T 1 | “Leravew |
I # Opacty: 100 " 11 I
I Channel: VIR VG VB I I . I
I Knockout: peoeg - I I J I
I Perd Irterior Efiects 35 Grovp I L ‘I
] V| Blend Cipped Layers a5 Group | D
v Traruparency Shapes Layer I
| Layer Mask Hides Effects \_/
| Vector Mk Hcen E¥ects :
: Slard I¥: Cray - I
1 Thslayerr 0 255 :
| |
o |
: Undedying Laywr: 0 a5 |
S
. |
i

h---------------

Gambar 15.2 kotak dialog blending option
Keterangan gambar :

A.Style Presets : Kumpulan list layer effects (palett styles)
B. Effects :  macam-macam effect yang dapat diterapkan untuk
layer style.

Dengan click pada name effects akan menerapkan
effect tersebut, dan menampilkan options untuk
obyek layer

C. Options/Settings :  Pilihan nama parameter dari effect yang tercentang,
maka pada options akan diperlihatkan setingan
parameternya

D.Layer Style Preview : Preview dari Layer Style.

Pada bagian Effects (B) dapat diterapkan pada layer dengan cara

mencentangnya, atau sebaliknya. untuk mengedit sebuah effect, anda harus
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men-klick nama efek. Effects settings tersebut akan ditampilkan pada
bagian Options (C). untuk menerapkan effects dan options, klick OK.

Setiap option efek (B) mempunyai setting tersendiri yang satu dengan
lainnya berbeda. Untuk melihat dan merubah settingnya klik salah satu dari
option diatas maka akan muncul setting dari option yang diklik tersebut (muncul
option C) Misal jika dipilih option color overlay maka akan muncul option warna,
ketebalan, dan mode. Berikut pilihan efek yang ada di blending options
Drop Shadow . membuat sebuah bayangan di memberikan bayangan

dibawah obyek layer

Inner Shadow : memberikan bayangan didalam/dari belakang obyek layer
Outer Shadow : memberikan sinar dibawah obyek layer
Inner Glow : memberikan sinar didalam obyek layer

Bevel& Emboss : Membuat pencahayaan unik dan efek bayangan pada obyek

layer sehinnga menjadi efek timbul

Satin : memberikan effect bayangan yang menyeluruh dalam
obyek

Color Overlay : Mengisi obyek layer satu warna,menimpa obyek dengan
warna lain

gradient overlay : menimpa obyek layer dengan warna gradient

Pattern Overlay : Mengisi layer dengan motif.
stroke : membuat outline dari layer contents menggunakan satu

warna, gradient, atau motif.

Menerapkan efek dengan Blending Options

Untuk menerapkan Layer Style — blending option , select Layer yang ingin
digunakan pada layers palette. Berikut pemberian efek pada macam- macam
efek blending options:
Drop shadow
Ada tiga point pengaturan utama yakni distance yang digunakan untuk mengatur
jarak objek dengan bayangan, spread yang mengatur kepekatan bayangan yang
terakhir adalah size yang mengatur ukuran bayangan. Berikut adalah langkah-
langkah untuk menerapkan efek drop shadow pada layer 1 dengan distance 8,

spread 10 dan size 24.
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1. Buat file baru (ctrl + N)
2. Buat obyek dengan ellipse tool

k.

@I. ) Mectangie ook v

j .ww{}roo: U
. erw T}

&, (O Podvgon Too! v

W\ UneTeol v

W, | [ Cumem Shape Yool U

Gambar 15.3 ellips tool dan obyek ellips
3. Klik kanan pada layer shape 1 dan pilih blending options

| Layer; x l Channsis I Paths | -.5
Normy v Opechy: 100% *
I‘&‘“?.nl.f -k e L OPEES =i
. N
& iR ¢ Duplicate Layer...
Delete Layer
Convert to Smart Object

Gambar 15.4 pilih blending options
4. Maka akan terbuka kotak dialog blending options dan centang pada
pilihan drop shadow
5. Klik pada Drop shadow dan atur parameter sebagai berikut distance 8,

spread 10 dan size 24.

Layer Style
Ry Ovep Shodow |'—0K_)
M tere
Eardng Options: Defeutt Bard Modes wicaichy - . Goced
o 5w ——
T Mgie. @ o * e Gibel Light v Prevew
Outter Sow
Irver Glow Ditance: 10 =
bew o b Spreack ' “ ‘
Cortour e R P
s ety
o Cormoun [Z] A- peaed
Color Overley
Gradiart Overley Howe (3 8
Patern Overley v Layer Knocks Out Drop Shadow
Stroke

Gambar 15.5 kotak dialog layer style drop shadow
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6. Klik OK untuk mendapatkan efek blending options dan akan muncul hasil

sebagai berikut

Setelah diberi
efek drop shadow

Gambar 15.6 4 hasil efek drop shadow

Inner Shadow
Inner shadow kebalikan dari drop shadow. Jika drop shadow memberikan suatu
efek bayangan ke arah luar objek/layer maka inner shadow akan memberikan
suatu efek bayangan di dalam objek itu sendiri.Paramter choke untuk mengatur
kepekatan dari bayangan. Berikut langakah untuk menerapkan efek inner
shadow dengan distance 8, choke 10 dan size 24.

1. Buat file baru (ctrl + N)

2. Buat obyek dengan ellipse tool

L3

@I- () Rectangie Too! u
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— JMTW u

,- \)WTW V]

W\ e Teol v
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Gambar 15.7 ellips tool dan obyek ellips
3. Klik kanan pada layer shape 1 dan pilih blending options
| tayers x | Chanpsis | Paths | ~.-5
Noemal v Opachy: 100% *
I“’-“L—J—/’.’f‘.’- - il darclopedies . —

- | Sackground ¢ Duplicate Layer...
Delete Layer
Convert to Smart Object

Gambar 15.8 pilih blending options
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4. Maka akan terbuka kotak dialog blending options dan centang pada
pilihan inner shadow

5. Klik pada inner shadow dan atur parameter sebagai berikut distance 8,
choke 10 dan size 24.

iR Sl
o Tanes Shadow ‘.:h_ ,O_‘S__'
Strach
Blending Optiorn: Default Bland Mode: y4met - Cancal
Orop Shadow Opacty: . T _New ,StY@’... J
g T A 2 reven
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R e i Oncke: w W .
PR Soe: 4 o
Todvre Qualty
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Coler Overlay oot é i R 'w'\
Gradiert Overlay e T
Pattarm Ovecay
Rrcke

Gambar 15.9 kotak dialog layer style inner shadow

6. Klik OK untuk mendapatkan efek inner shadow dan akan muncul hasil sebagai

berikut
| 4
Setelah diberi efek
inner shadow
Gambar 19.10 hasil efek inner shadow
Outer Glow

Outer glow memberikan suatu efek cahaya pada objek/layer.Berikut adalah
langkah penerapan outer glow dengan pengaturan: Blend mode : Linear Burn,
warna glow: merah,spread : 7 dan size : 57

1. Buat file baru (ctrl + N)

2. Buat obyek dengan ellipse tool dan beri warna layer background : merah
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Gambar 15.11 ellips tool dan obyek ellips dengan background merah
3. Klik kanan pada layer shape 1 dan pilih blending options
'1 Vayers = | cnanne | paeil
Normal v Opacky: 100% * _ .
L Y, 1y Qe we -
lending Options... 1 h

s

Duplicate Layer...
Delete Layer

%

Convert to Smart Object
Gambar 15.12 pilih blending options
4. Maka akan terbuka kotak dialog blending options dan centang pada
pilihan outer glow
5. Klik pada outer glow dan atur parameter sebagai berikut : Linear Burn,

warna glow: merah,spread : 8 dan size : 30

5, . -
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e “
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Iter: | ° -

Gambar 15.13 kotak dialog layer style outer glow
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6. Klik OK untuk mendapatkan efek outer glow dan akan muncul hasil sebagai

berikut
Setelah diberi efe
outer glow
Gambar 15.14 hasil efek outer glow
Inner Glow

Outer glow akan memberikan efek cahaya yang keluar dari objek/layer maka
kebalikan dari itu, inner glow akan memberikan efek cahaya dari tepi objek ke
arah dalam objek. Untuk pengaturan-pengaturannya hampir sama dengan outer
glow. Berikut adalah contoh penggunaan dari layer style inner glow adalah
sebagai berikut.

1. Buat file baru (ctrl + N)

2. Buat obyek dengan ellipse tool
I
- _‘mho'

7.Wdodm'{)?od
) o Tool
\)WYW
N\ Une Teol
L Cuatorn Shape Tool
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Gambar 15.15 ellips tool dan obyek ellips
3. Kilik kanan pada layer shape 1 dan pilih blending options

| Layers % | Chanrsls l Paths 1 —.5
Noema v Opachy: 100% *
I‘ﬁ'“——.l./_‘n“.._ LTI 1 RS POY - F YT . —

» ack c Duplicate Layer...
Delete Layer
Convert to Smart Object

Gambar 15.16 pilih blending options
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4. Maka akan terbuka kotak dialog blending options dan centang pada
pilihan inner glow

5. Kiik pada inner glow dan atur parameter sebagai berikut
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Gambar 15.17 kotak dialog layer style inner glow

6. Klik OK untuk mendapatkan efek inner glow dan akan muncul hasil

sebagai berikut

L——

| 44
Setelah diberi efek
inner glow

Gambar 15.18 hasil inner glow

2) Style

Styles merupakan cara cepat untuk memberikan spesial efek yang dapat
diterapkan untuk suatu layer pada aplikasi pengolah gambar bitmap photoshop
dimana efek-efek blending option sudah diramu tinggal digunakan di pilihan style.
Bisa dikatakan bahwa style adalah tambahan efek yang akan diberikan terhadap
suatu layer. Efek — efek pada style tersebut telah disediakan, tinggal memilih dan
menerapkannya pada layer tersebut .

Dengan menggunakan efek layer style dapat mempercantik desain sekaligus

mempercepat pekerjaan karena style yang disediakan pada layer style tinggal di-
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klik makan langsung bisa dilihar hasilnya. Pemberian efek style pada layer
merupakan cara instan untuk mendapat efek pada layer desain.

Berikut ini adalah posisi palette layar pada lembar kerja aplikasi pengolah
gambar bitmap photoshop.
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; Paletté style
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Gambar 15.19 posisi palette layer
Aplikasi pengolah gambar bitmap photoshop menyediakan banyak Layer
Style Presets, semua efek tersebut dapat diakses melalui (Window - Styles).
Maka akan muncul Palette Styles seperti pada gambar berikut

—— —_— - X
| Color | Swatches | Styles x | =
<\Bl:op down
N n . e list menu
style

preview

o
s A
T
_7

) |
&

&——_delete style

BT -

s
-

s BN K

Clear style Crealé new style

Gambar 15.20 palette styles
Keterangan gambar :
Preview style : gambaran style yang bisa langsung digunakan
Clear style : menghilang/menghapus style yang sudah diterapkan pada layer

Create new style : membuat style baru
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Delete style : menghapus style yang terdapat dalam daftar preview style
Drop down list menu style : bila diklik akan muncul list menu style

Bila sudah memberikan layer style pada suatu layer dan ingin menghilangkan

layer style tersebut maka klik tanda Z yang berada di bagian ujung kiri atas
pada pallete styles. Dengan mengklik tanda tersebut maka semua layer style
yang diberikan pada suatu layer akan hilang.

Tidak semua style yang dimiliki oleh photoshop dimasukkan dalam pallete
styles. Untuk memunculkan style dari photoshop yang lain, klik tombol menu ==
dibagian kanan atas pada pallete styles. Kemudian akan muncul option seperti
berikut

g

New Style...
| Co Text Only
E v Small Thumbnail
== Large Thumbnail
- Small List
- Large List

Preset Manager...

Reset Styles...
| L3y Load Styles...
Nor Save Styies...

Kelompok style
Glass Puttons

Replace Styles...

@ || Abstract Styles

Lo

| Coler | Swaﬁs | Styles x | __-:
C L -
M |l CA AT

e | Web Styles
—

l Buttons : r
Glass Buttons _ ————
____________ |
cclompok sol e)l#,m,g, s ! 0 | | |l |l
1 Photographic Effects | ]
- | TotEffects2 1 M| I
T £§ -
,’{’I oxt Effects : L------rv 3
Textures
|
|

Gambar 19.21 list menu syle dan glass buttons style
Dibagian paling bawah terdapat beberapa pilihan kelompok vyaitu
abstract,buttons, dotted strokes, glass buttons, image effects, photographic

effect, text effects 2, , text effects, textures serta web styles.
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Menerapkan style pada layer

Untuk menerapkan Layer Style, select Layer yang ingin digunakan pada
layers palette. Untuk langkah- langkah penerapan style pada layer dapat
dilakukan sebagai berikut :

1. Buat file baru (ctrl + N)

2. Buat obyek teks dengan menggunakan m horizontal type tool dan buat

tulisan misalnya “ style “

Gambar 15.22 obyek shape “styles” sebelum diberi efek
3. Maka akan terbentuk layer yang bernama style(sesuai isi teks) , pastikan layer

yang akan diberi terseleksi
| tayers x | Channes | Paths | =
Normal v Opacity:| 100% * |

w: L 74 @ Fil:| 100%  »
' L - ayer yang
® ‘uﬁ Shape 1 erseleksi

- Dmmw (5]

Gambar 15.23 layer terseleksi

4. KIik salah satu macam style pada palette style maka secara otomatis style akan
berlaku pada obyek yang ada di layer yang terseleksi
| color | swatches | styiesx |

Gambar 15.24 obyek layer yang telah diberi style
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Memanggil list style

Tidak semua style yang dimiliki oleh photoshop dimasukkan dalam pallete
styles. Untuk memunculkan style dari photoshop yang lain, klik tombol menu ==
dibagian kanan atas pada pallete styles. Langkah — langkahnya adalah sebagai
berikut :
1. Arahkan mouse ke dibagian kanan atas pada pallete styles dan klik tombol

menu ==, maka akan muncul pilihan group style

g |

New Style ..

Text Ondy

v Small Thumbnasl
Large Thumbnaad
Semall List
Large Last

i\l
(-]

alnlzkl

Preset Manager...

Reset Styles...
] =% Losd Styles ..
Save Styles...

Noe
- II Abstract Styfes I
I Dotted Strokes

Buttons
Glass Buttons \=\
Image Effects

|
Phot hic Effect X .
=1 PR tenbilis S | ilihan group
1 veaertecs | style
= =] '
L B N N N N N B |

Gambar 15.25 pilihan group style
2. Klik pada web styles maka akan muncul kotak dialog seperti dibawah dan

kemudian kli OK untuk melanjutkan menampilkan group style “web styles”

Adobe Photoshop €53 Exended

Replce cutrent styles with the styles from Wed
“\ Styles asl?

ok ][ cne ADDend

Gambar 15.26 kotak dialog replace current styles

3. Dan setelah itu di preview palette style akan menampilkan group style “web

style”

| Color | Swatches | stytesx | : { coter | swateres | soyes x| 7.2

xlam|aldle - DﬁDQSI:

-...615» R OB A

SEIFIECCE - RIB2BIQ -
@ & 3 =

Gambar 15.27 styles default berganti dengan style “web styles”
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3) Penerapan blending options obyek shape
Berikut adalah langkah-langkah untuk menerapkan obyek shape pada

photoshop

1. Klik custom shape toolﬁg‘dan pada bagian atas akan muncul pilihan

bentuk yang diinginkan

9.
J: » [ ] Reclangle Toal u / y ‘“..
9 ) Rounded Rectangh Too! u
- (D ESpse Tood u
~, () Poivgen Tool u
W N\ U Tool u
3 v\fcm';hm'l{}l u |

r
r
[

Gambar 15.28 custom shape tool

2. Pada layer objek klik kananm sehingga muncul pilihan dan di pilih

blending option dan pilih sehingga muncul popup blending option

Lpens < | Chanoels | Pathe
Morvad W Cpechy: 10w ¥
Lok ] e b

Layer Progertion.

| ::8ianve O

Dusicats Laywr
Dwsnlo Larpor

Gambar 15.29 popup blending options
3. Pilih atau centang gradient overlay dan atur gradient,style,angle dan scale

sehingga mendapatkan gradasi warna yang di inginkan.

Svia o alenet Cvarlig
Prr—— tordent
Parvieg Spters. Swlad
— i Pord Mode 1ony -
(voo Pradow oy Al %
o vt T (e
[ e
e e e VN ey
e Gow AN
Poow wod b mbore iy | D
./
R Crde -
et
e
Coiow Ovwrs
| Sesaimtr N

Gambar 15.30 parameter gradient overlay
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4. Pilih atau centang bevel and emboss dan atur style,depth,size soften dan

angle sehingga mendapatkan efek bevel atau emboss yang diinginkan

Bwwel and babass
Hrotwe

T e Bave v
Todvede: oo w
Cupts 3 ¥ -
Dvatore Py (0w
Sow » o
Sobwry » o
Baday
- - -
S /:'." »::‘u Gl Linge
j iz
Ade e ’In "
o Cantanrs | el [how-dhases
AR )
e ol G PN v
Coschy . ~ -
Shadone Mode: a4 gly - ..
Cowcry ”~ -

Gambar 15.31 parameter bevel and embos
5. Pilih atau centang Stroke dan atur size,position,fill type dan color untuk

menghasilkan efek penebalan yang di inginkan.
Wrake

Streciws
e 0 4 =
Posiony Ovtode v
Phand Mode' s4oe il v
Cpacty J %
F Typel  Cotoe ~
Cote [

Gambar 15.32 parameter stroke

6. Pilih atau centang drop shadow dan atur angle,distance,spread dan size

untuk menghasilkan efek bayangan yang di inginkan.

Cwep Vhudew
Mrediers
Ohend Mode:  wabgidy v -
Cypwity 3 " -
£\ &
Mg | o - o e S g
N
Owvawe - » " y
Soread » 1 -
Sae 3 3 o=
Qualdy
Cardmn ,_{i- [ nvedaed
282
MNoae ] “

[0 wrwe Krachs Ot Dnop Shadine

Gambar 15.33 parameter drop shadow
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7. Klik layer ﬁg‘ dan pilih rasterize dan pada popup menu kanan pilih shape
untuk menghilangkan garis di sekeliling shape

Group Layers G Vactor Mank
Hide Layers

Layer
Al Layers

Gambar 15.34 hasil akhir setelah rasterize shape

4) Penerapan blendf If pada layer gambar
Berikut ini adalah penerapan blend if untuk mendapatkan efek dramatikal
pemandangan dipantai dengan mengatur opacity gray. Berikut ini adalah
langkah-langkahnya.
1. Siapkan 2 file gambar yang berisi pemandangan pantai berawan dan

bulan

Prunum (oGl T et o g B (1AW ol

Gambar 15.35 dua file bula dan pantai berawan
2. Pindahkan gambar bula dengan jalan klik dan drag gambar bulan ke file
yang berisi pantai berawan. Sehingga terdapat 2 layer pada file pantai

berawan
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B upngPatn_sons g & 04T Laye ], REESY)

i v

Gambar 15.36 penggabungan gambar bulan dan pantai
Klik kanan pada layer 1, kemudian klik “blending options”.

4. Atur blend if - gray - this layer dengan cara menggeser slidingnya

sampai mendapatkan hasil background warna hitam pada bulan
menghilang.
Layer Srye ﬁx‘
= 1 L o
e ——
[ S — > Cancel
Dvoo Sredow P - rr—
v SPadon J
Oy Ghowe Aot Moy o Prarvew
S e ¥ Opecey M s
Background RN S e
kotak hitam Comons B Irowrcr Diech m Growo

sudah hilang

Teure Berd Cpoed Leyen » Orove
Treraparency Trape Layw
Loe Mk S § b
Nl Mo sades E8an

[ R Qrey -
el wray
aew 0 )
o S
e

.ww.; Ay L =

N

-

geser slider d
this layer

Gambar 15.37 pengaturan parameter this layer

5. Kemudian blend if > gray - underlying Layer dengan cara menggeser

slidingnya sampai mendapatkan hasil sebagian awan menutupi bulan.
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Gambar 15.38 pengaturan parameter underlying layer
6. Dan klik OK untuk mengakhiri perintah blending option dan didapatkan
hasil akhir seperti berikut

Gambar 15.39 hasil akhir setelah efek blending

c. Rangkuman

Dari uraian materi kegiatan belajar kali dapat dibuat rangkuman sebagai berikut :

= Layer style terdiri dari style dan blending option

= Effect blending option hanya bisa diberikan pada layer baru dan tidak bisa
diberikan kepada layer background

= Layer style bisa diberikan ke obyek layer, shape maupun obyek teks.

= Efek yang ada di blending options diantaranya adalah drop shadowinner
shadow Outer shadow, inner glow, bevel& emboss, satin, color overlay,

gradient overlay, pattern overlay, stroke
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= Efek layer style-blending options dapat bisa dibuat sendiri dengan
menggunakan macam efek pilihan serta seting parameter.

= Styles merupakan cara cepat untuk memberikan spesial efek yang dapat
diterapkan untuk suatu layer pada aplikasi pengolah gambar bitmap
photoshop dimana efek-efek blending option sudah diramu tinggal digunakan
di pilihan style.

= Pilihan efek pada style berupa icon yang menyerupai bentuk efek style itu

sendiri

d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah

dipelajari

Keterangan Obyek setelah di edit

i‘-.v—‘ - Opachyr 00N,
| todhs L) 20 @ LR
|

Susunan layer dan efek blending option

saat pengeditan obyek

Gambar awal terdiri dari gambar pantai

gunung berawan dan bulan
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Gambar asli sebelum diolah Setelah di atur blend if nya,
menggunakan blend-if shadow pada gambar pagar kayu
menghilang.

2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi
pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

e. Tes Formatif
Bagaimana jika suatu obyek diberi efek satin dari blending option?
2. Bandingkan antara efek inner glow dan inner shadow, apakah perbedaan
keduanya ?
3. Bandingkan antara efek contour dan texture, apakah perbedaan
keduanya ?
4. Jika suatu obyek sudah diberi salah efek blending option, menurut Anda

bagaimanakah cara untuk membatalkan efek tersebut

f. Lembar Jawaban Tes Formatif
LJ - 01 : efek satin
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LJ - 02 : efek inner glow dan inner shadow
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g. Lembar Kerja Siswa
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16. Kegiatan Belajar 16 : Menerapkan Efek Layer Mode ada gambar
bitmap

a. Tujuan Pembelajaran

Setelah mengikuti kegiatan belajar 16 ini siswa diharapkan dapat :
1). Memahami jenis layer mode pada aplikasi pengolah gambar bitmap

2). Memahami penerapan efek layer mode pada gambar bitmap

3). Menyajikan hasil pemberian efek layer mode pada layer gambar bitmap

b. Uraian Materi

Layer blending mode adalah bagaimana bagaimana pixel layer yang aktif
bercampur dengan image pixel di bawahnya.seperti halnya slider opacity di
panel layer menjadikan layer yang aktif bercampur dengan layer di bawahnya
dengan cara menjadikan layer yang aktif tersebut menjadi transparan.blend
mode bekerja seperti halnya slider opacity di atas akan tetapi memakai
perhitungan matematis yang berbeda untuk tiap blend mode.

Ada 25 macam blending mode yang ada di photoshop CS3.perubahan yang
terjadi dengan blending mode adalah perubahan secara parameter dan blending
mode dan pengaturan di dalamnya tidak merusak pixel dari image yang asli.

Letak blending mode pada layer photoshop CS3 terletak pada layer palette
dan juga pada dialog box blending option layer

Sleadiy Optrear

Adesncod anding
Pl Opactyy 1 *
e [T [Fla [0

Kok o B w
[ Jnd trdericr Tech @ Grop
[ Jtarnd Qg Lapers o Grine
[ Brwraparency Shapec Lupw
[ vy M 1oden E¥ects
[ wwcrcr Musd bades E%ecn

Ths Layw » =5
= fx O €. a4 a 3 —

Gambar 16.1 letak fitur layer mode
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Blend mode pada layer dapat di bagi menjadi beberapa grup untuk lebih

mudah memahami kesamaan fungsinya antara lain adalah:

Group layer mode  Fungsi Jenis layer mode
Darken modes Berfungsi untuk member efek darken
image menjadi lebih gelap. multiply
color burn

darker color

linear burn
Lighten modes Berfungsi untuk member efek lighten
image menjadi lebih cerah. screen
color dodge
linear dodge

Lighter color

Contrast modes Berfungsi sekaligus Overlay
menggelapkan dan mencerahkan Soft Light
image serta meningkatkan Hard Light
kontras. Vivid Light

Linear Light
Pin Light
Hard Mix

Comparative Berfungsi membandingkan piksel Difference

modes di antara layer.Blend mode ini Exclusion
biasanya sangat jarang sekali di
gunakan terutama untuk foto
editing.

Composite modes Berhubungan dengan warna dan Hue
juga kilau dari image pada layer.  Saturation

color
luminosity
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Dissolve K !

Darken
Multiphy

e Darken Modes

Linear Burn

Light=n

Scresn

Color Dodge Lighten Modes
Linear Dodge

Owerlay

Saoft Light

Hard Light

Vivid Light Contrast Modes
Linear Light

Pin Light

Hard Mix

Difference

— Comparative Modes

Hue

e Composite Modes
2.2 (Hue, Saturaticn, Luminosity)

Luminosity

Gambar 16.2 pengelompokan jenis layer mode
Untuk menerapkan layer mode pada aplikasi pengolah gambar bitmap ini,

sedikitnya dibutuhkan 2 layer agar terlihat efek dari layer mode tersebut. Berikut
adalah langkah-langkah untuk menerapkan layer mode.
1. Buat file baru yang terdiri dari minimal 2 layer. 1 layer berisi gambar

bitmap dan 1 layer diberi warna

| Layers x | Chanoels | Paths |

o B Q

3
[ 2ad

- [ e

Gambar 16.3 persiapan gambar bitmap dan layer
2. Pilih layer aktif pada layer atas ganti layer mode normal dengan blend

mode yang di inginkan
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- B o

Gambar 16.4 pemilihan layer mode

3. Maka gambar asli dilayer 0 akan bepadu dengan warna layer 1

Gambar 16.5 hasil penerapan layer mode darken
Dibawah ini adalah hasil penerapan berbagai jenis layer mode pada darken

group:

1. Darken group
Darken
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Multiply

color burn

Linear burn

Darker color

2.Lighten group

lighten
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screen

color dodge

linear dodge

Lighter color

3.Contras mode

Overlay
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Soft Light

Hard Light

Vivid Light

Linear Light

Pin Light

e

AT g
MR
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Hard Mix

3.Comparative mode

Difference

Exclusion

4.Composite modes

Hue

saturation
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color

Luminosity

Penerapan image adjustment,adjustment layer dan layer blend mode.

Pada penerapan layer mode biasanya tidak berdiri sendiri, melainkan
dipadukan/digabungkan dengan fitur-fitur yang lainya, misalnya adjustment, filter
dan lain sebagainya untuk mendapatkan hasil gambar bitmap sesuai yang
diinginkan. Berikut adalah salah satu contohnya.

1. Buka file gambar bitmap yang akan di olah

Gambar 16.6 asli yang akan di olah

2. Kemudian Image > Adjustment > Curves.
3. Setelah kotak dialog terbuka pilih eyedropper paling kanan dan pilih pada

gambar area paling terang untuk meningkatkan kecerahan foto.
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Gambar 16.7 kotak dialog curves dan eyedropper
4. Klik OK dan perubahannya seperti foto di bawah ini

Gambar 16.8 setelah diberi efek curvés

5. Kemudian pada Layer > New Adjustment layer > Gradient map

6. Klik gradient editor pilih preset blue,red,yellow dan klik OK
: - "y

Gradient Map &
a3t s for Cranic e Magong E
- I l .:w
[a‘h)ww
et Optons
] Outher
[ Roverse

Gambar 16.9 setelah diberi gradient map
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7. Pada layer panel kurangi opacity gradient map menjadi 30 %,dan hasilnya
akan seperti foto di bawah ini:

| Layers x | Channets | Paths | (=
Normal v Opacty: 30% * |

eck: (74 8 Fil: 100% *

Gambar 16.10 setelah diberi opacity

8. Pilih layer >new adjustment layer>curve untuk menambah kecerahan dan
kontras gambar dan pastikan layer tersebut ber ada di bawah layer gradient
map

Gambar 16.11 setelah diberi image adjustment curve
9. Langkah berikutnya adalah menambahkan inner shadow dengan jalan klik

ganda pada layer Background dan klik OK untuk membukanya. Selanjutnya,
pilih Layer> Layer Style> Inner Shadow

10. Dan atur opacity menjadi 50%,angle 120 derajat,distance 0,choke 47 dan
size menjadi 122 seperti pada kotak dialog berikut
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Gambar 16.12 setting parameter layer style

11. Pilih layer>Layer style>Gradient overlay pilih Style menjadi radial dan
gunakan Black & white gradient seperti preset di bawah ini.

Gradient Overlay
G adient
Blend Mode: Owerlay v
Opaciy: o B %
crerts [ ) v
Style: gosy v [-]W"Mhlbw
Angei @ « ©
Scila: o %

Gambar 16.13 kotak dialog gradient overlay

12. Maka akan menghasikan hasil akhir seperti berikut

Gambar awal

Gambar 16.14 hasil akhir pemberian efek layer style
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c. Rangkuman
Dari uraian materi kegiatan belajar kali dapat dibuat rangkuman sebagai berikut :
= Layer blending mode adalah bagaimana bagaimana pixel layer yang aktif
bercampur dengan image pixel di bawahnya.
= Slider opacity di panel layer menjadikan layer yang aktif bercampur
dengan layer di bawahnya.
= Layer blending mode bersifat non distruktif atau tidak merusak pixel dari
image yang asli.
= Ada 25 macam blending mode yang ada di photoshop CS3 yang terbagi
dalam 5 group
= 5 Group layer mode, yaitu darken modes, lighten modes, contrast modes,

Composite modes, Comparative mode.

d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari
Keterangan Obyek setelah di edit
Gambar asli http://www.photoshopessentials.com

Adjustment —level
Adjustment-curves
Layer modes-luminosity
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Terdiri dari 2 gambar

Dan

Layer mode = multiply
Dan altur opacity layer

2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi
pengolah presentasi

3. Presentasikan didepan kelas hasil karya anda

. Tes Formatif

1. Bagaimana jika suatu obyek diberi mode overlay dari layer mode

2. Pada layer mode terdapat 5 group mode, jelaskan perbedaan fungsi
darken mode dan Lighten modes

3. Pada layer mode terdapat 5 group mode, jelaskan perbedaan fungsi
contrast mode dan composite mode

4. Jika suatu obyek sudah diberi salah efek blending mode, menurut Anda

bagaimanakah cara untuk membatalkan efek tersebut
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f. Lembar Jawaban Tes Formatif

LJ - 01 : mode overlay
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LJ - 04 : membatalkan efek layer mode

g. Lembar Kerja Siswa
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17. Kegiatan Belajar 17 : Memahami Efek Filter pada Gambar Bitmap

a. Tujuan Pembelajaran
Setelah mengikuti kegiatan belajar 17 ini siswa diharapkan dapat :
1). Mengenal jenis-jenis filter
2). Mengidentifikasi efek filter pada aplikasi pengolah gambar bitmap

3). Memahami efek filter pada aplikasi pengolah gambar bitmap

b. Uraian Materi

Filter adalah fasilitas yang disediakan oleh aplikasi pengolah gambar bitmap
photoshop untuk memberikan efek tertentu pada obyek gambar bitmap sehingga
desain gambar yang dihasilkan akan lebih hidup . Dengan adanya efek dari filter
desain gambar bitmap yang dibuat akan menjadi special.

Cukup banyak filter yang disediakan oleh aplikasi pengolah gambar bitmap
photoshop jumlahnya mencapai ratusan buah , sehingga pada kegiatan belajar
ini tidak akan dibahas semuanya secara detail, namun akan diajarkan secara
garis besarnya serta cara pemakaian fasilitas filter. Filter yang ada dalam dapat
ditambah lagi macamnya dengan jalan menambahkan plug-ins filter. Plugin filter
bisa didapatkan dengan cara mendownload, mengkopi atau membeli, seperti
perintah digimarc yang terdapat di menu filter.

Tiap - tiap filter mempunyai option untuk mengatur hasilnya sesuai agar
sesuai dengan keinginan desainer grafis. Pada saat memilih salah satu filter
maka akan muncul kotak dialog untuk mengatur parameter — parameter filter
lebih lanjut sehingga nantinya akan didapatkan efek yang sesuai.

Untuk dapat mengaplikasikan salah satu filter maka harus dipilih dahulu
bagian mana dari gambar yang akan diberi effect, lalu bagian tersebut diseleksi.
Efek filter bisa diberikan ke obyek gambar bitmap maupun obyek teks. Untuk
efek filter pada teks akan dibahas lebih lanjut pada kegiatan belajar selanjutnya.

Filter secara garis besar dibagi menjadi 13 jenis filter. Pada kegiatan
belajar ini akan dijelaskan fungsi dari ke 13 jenis filter . Berikut adalah tampilan

menu filter disertai jenis-jenis efek filter
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[Filter] Analysis View Window Help
Embed Watermark Ctri«F

Convert for Smart Filters

Extract... Alte Ctri+ X
Filter Gallery...

Liquify... Shift+ Ctri+ X
Pattern Maker... Alt+Shift=Ctrl+ X
Vanishing Point... Alts Ctrl+V

Artistic »
Blur L4
Brush Strokes >
Distort ’
Noise »

13 Macam
N

Prcelate v
Render »
Sharpen ’
Sketch »
Stylize ’
Texture >
»

»

-

Video
Other

o

~ Filter

Digimarc >

Gambar 17.1 menu filter

Filter - Artistic

—> plugin filter

Filter jenis artistik berfungsi untuk menciptakan kesan artistik pada objek

gambar bitmap maupun teks. Artistic memberi effect untuk merubah gambar

menjadi seperti lukisan. Didalam filter artistic disediakan kurang lebih 15 pilihan

efek filter yaitu : Colored pencil, cutout, dry brush, film grain, fresco, neon glow,

paint daubs, palette knife, plastic wrap, poster edges, rough pastels, smudge

stick, sponge, underpainting, dan water color.

Misalnya pada filter colored pencil, filter ini berfungsi untuk mengubah

gambar menjadi seperti gambar yang dibuat dari arsiran pensil warna. Adapun

langkah — langkah untuk memberikan efek colored pencil adalah sebagai berikut

1. Buka gambar bitmap yang akan diakan diberiki efek filter colored pencil

2. Klik menu filter = artistic = colored pencil
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|[l-“m1 Eknalysis  View Window Help

b e P mBed Watermark Ctrl+F S
Convert for Smart Filters B
Extract.. Alt+Cerl+ X
Filter Gallery...

Liquefy... Shift+Ctri+ X
Pattern Maker... Alt+ Shift+ Ctri+ X
Vanishing Point... Alt+Ceri+V
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Artistic Colored Pencil...
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Brush Strokes » Ory Brush...
Distort > Film Gram...
Noise > Fresco...
Pxelate > Neon Glow...
Render > Paint Daubs...
Sharpen > Palette Knife...
Sketch > Plastic Wrap...
Stylize 4 Poster Edges...
Texture 4 Rough Pastels...
Video g Smudge Stick....
Other L4 Sponge...
e | Underpainting...
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Gambar 17.2 perintah efek colored pensil

3. Setelah itu akan terbuka kotak dialog colored pencil

L mead bous am

b )

R
)

oo pere. "

b

Gambar 17.3 Kotak dialog colored pencil

4. Pada kotak colored pencil terdapat pilihan parameter colored pencil untuk
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- Atrtistik : memilih macam efek artistik

- Colored pencil : memilih warna pencil

- Pencil width : lebar ujung pensil

- Stroke pressure : besarnya Stroke pressure
- Paper brightness : ketajaman kertas

5. Atur parameter tersebut seperti diberikut

=

Qnce
Lok ed Fendd
Pendl Wah 3
>
o Pressure 9
&
Papes Brghiress m

Gambar 17.4 parameter pada colored pencil

6. Klik OK untuk mendapatkan efek colored pencil, maka gambar akan

berubah seperti berikut

Gambar 17.5 obyek bitmap diberi efek filter colored pencil
Berikut adalah contoh dari beberapa obyek gambar bitmap jellyfish.jpeg
yang telah diberi efek artistik

Cokored Pendl -
Pendl Width 3
3
Stroke Pressure S
4
Paper Brightness 25
s
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Cutout v
Number of Levels B
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Pant Daubs -
Brush Sze 14
Sharpness 17)

Y
Palette Knife v
Stroke Size X
d
Stroke Detad 3]
Softness 2
Plastc Wrap v '
Highiight Strength 15
Detad g
2
Smoothness 7
2
| Poster Edges w1
Edge Thidness 1
Edge Intensity S
Posterization 28
3
Blur

Blur sesuai dengan artinya digunakan untuk menghasilkan efek kabur
pada sebuah gambar bitmap. Filter ini terdapat beberapa jenis efek diantaranya
adalah average, blur, blur more, gaussin blur, lens blur, motion blur, radial blur,

shape, smart blur dan surface blur.
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Filter blur merupakan salah satu filter yang paling sering digunakan
didalam membuat desain gambar bitmap. Langkah untuk mendapatkan efek filter
blur sama dengan efek filter artistik.

Dibawah ini meruapak obyek gambar bitmap buah.jpg yang belum
mendapatkan filter

Gambar 17.6 buah.jpg

Sumber : http://www.digaleri.com
Berikut adalah contoh dari beberapa pemberian efek filter blur pada obyek

gambar bitmap

Jenis filter Blur

Gambar bitmap yang telah diberi efek

Blur box

Radis: & pixe’s

1 |

Glaussian blur

Rardaus: ’7” pucels




PENGOLAHAN CITRA DIGITAL

Lens Blur
7] Preview
S Faster ) More AcCOxrate
Depth Mao
Scwurce: | Transparency =]
Bhur Focal Distance o
[T linvert
Iris
shape: | o (S ~]
Radius is
CETEATRE
Blade Curvature 1
>
Rotaton a5
Specular Haghights
EBnghtess <0
>
Threshold 2ss
- -2
Nose
Amount =|
mno:
) Gaussian
" Radisl Bhar
G :
Ameunt 2] '
o [ Canced |
Bur Method:
@ spn Br Conter
) ISP TINENNNY,
oon // o b \§ \\
5/////"":"\\\\\ N
Quaity: ( =3
o I”'E"""'i”'
¥ Good -
o W=
Nan Y

|
wd!
M|
~

e

b il

EOHL
|
i




PENGOLAHAN CITRA DIGITAL

Sensart Bhur

Threshold: 5 levels

Brush stroke

Filter brush stroke memiliki fungsi untuk memberikan efek pada gambar
menjadi seperti lukisan berupa tinta dengan berbagai pilihan alat untuk
melukis.Hal ini hampir sama dengan fungsi filter artistic .

Pada filter brush stroke terdapat delapan efek khusus yaitu : accented edges,
angled strokes, crosshatch, dark strokes, ink outlines, spatter, sparyed strokes,
dan sumi-e.

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum
mendapatkan efek filter brush stroke
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Gambar 17.7 obyek bitmap buah.jpg
Sumber : http://www.digaleri.com
Berikut adalah contoh dari beberapa pemberian efek filter brush stroke pada
obyek gambar bitmap
Jenis filter brush stroke Gambar bitmap yang telah diberi efek
filter brush stroke
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Spatter v
Spray Radius (15}
b
Smoothness S
N
| Sume v
Stroke Wath 3
Stroke Pressure . |
A
Contrast 19
Distort

Filter distort berfungsi untuk mengacak gambar dengan suatu keteraturan
tertentu. Jenis filter distort menghasilkan efek distorsi secara geometris, efek tiga
dimensi atau efek pembentukan ulang pada sebuah gambar. Di dalam filter ini
terdapat 12 efek khusus yaitu : diffuse glow, displace, glass, ocean ripple, pinch,
polar coordinates, ripple, shear, spherize, twirl, wave, dan zigzag.

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter distort

Gambar 17.8 obyek bitmap buah.jpg

Sumber : http://www.digaleri.com
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Berikut adalah contoh dari beberapa pemberian efek filter distort pada obyek
gambar bitmap

Jenis filter distort Gambar bitmap yang telah diberi
efek filter distort

anainl .lllll
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Noise

Filter noise berfungsi untuk memberikan gangguan pada gambar, misalnya
diberikan efek bintik bintik disekitar gambar. Filter noise dapat pula digunakan
untuk mengurangi noise/gangguan dari suatu gambar bitmap. Di dalam filter
noise terdapat beberapa efek diantaranya : Add noise, despeckle, dust &
scraches, median dan reduce noise.

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter noise

Gambar 17.9 obyek bitmap buah.jpg
Sumber : http://www.digaleri.com




PENGOLAHAN CITRA DIGITAL

Berikut adalah contoh dari beberapa pemberian efek filter noise pada obyek
gambar bitmap
Jenis filter noise Gambar bitmap yang telah diberi efek

filter noise

Pixelate

Filter pixelate digunakan untuk memanipulasi pixel-pixel dari suatu
gambar. Jenis filter pixelate merupakan jenis filter yang memiliki seleksi secara
tajam dengan menyeragamkan pixel dengan nilai warna yang sama pada sebuah
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gambar. Di dalam filter terdapat 7 efek khusus yaitu : color halftone, crystalillize,

facet, fragment, mezzotint, mosaic, dan pointillize.

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum
mendapatkan efek filter pixelate

Gambar 17.10 obyek bitmap buah.jpg
Sumber : http://www.digaleri.com
Berikut adalah beberapa contoh dari pemberian efek filter pixelate pada
obyek gambar bitmap
Jenis filter pixelate Gambar bitmap yang telah diberi efek
filter pixelate
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Render

Filter render memberikan efek tiga dimensi terhadap suatu gambar bitmap
selain itu dapat pula memberikan efek pola awan, dan efek sinar khusus pada
sebuah gambar. Di dalam fiter render terdapat lima efek khusus yaitu 3D
transform, clouds, difference clouds, lens flare, dan lighting effect.

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter render

Gambar 17.11 obyek bitmap buah.jpg

Sumber : http://www.digaleri.com
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Berikut adalah beberapa contoh dari pemberian efek filter render pada obyek
gambar bitmap
Jenis filter render Gambar bitmap yang telah diberi
efek filter render

@ Move Prene

Sharpen
Filter sharpen digunakan untuk membantu mempertajam suatu gambar atau

meningkatkan ketajaman sebuah gambar dengan meningkatkan kontras pada
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pixel yang saling berdekatan. Di dalam filter sharpen terdapat empat khusus yaitu
: sharpen, sharpen edges, sharpen more, dan unsharp mask.

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum
mendapatkan efek filter sharpen

Gambar 17.12 obyek bitmap buah.jpg
Sumber : http://www.digaleri.com

Berikut adalah beberapa contoh dari pemberian efek filter sharpen pada
obyek gambar bitmap

Jenis filter sharpen Gambar bitmap yang telah diberi efek

filter sharpen

Sharpen
- Tidak ada pengaturan parameter

Smart sharpen
 Das Advarced
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Remove:  Maton s b

Asghe: 0 '@

More Acouate




PENGOLAHAN CITRA DIGITAL

Sketch

Filter sketch berfungsi untuk memanipulasi permukaan dari suatu gambar
seperti rilief dalam permukaan batu. Jenis filter ini menghasilkan efek tekstur baik
2D maupun 3D pada sebuah gambar. Di samping itu, filter sketch juga sering
digunakan untuk menghasilkan efek gambar tangan. Di dalam filter ini terdapat
14 efek khusus yaitu : bas relief, chalk, & charcoal, charcoal, chrome, conte
crayon, grapich pen, halftone pattern, note paper, photocopy, plaster, reticulation,

stamp, torn edges, dan water paper

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter sketch

Gambar 17.13 obyek bitmap buah.jpg

Sumber : http://www.digaleri.com
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Berikut adalah beberapa contoh dari pemberian efek filter sketch pada obyek
gambar bitmap
Jenis filter sketch ~ Gambar bitmap yang telah diberi efek
filter sketch

Stylize

filter stylize memberikan effect tiga dimensi dan mengubah tekstur dari suatu
gambar bitmap. Stylize Jenis filter menghasilkan efek lukisan atau impressionistic
dengan melakukan pengantian pixel dan meningkatkan nilai kontras pada
sebuah gambar. Di dalam filter ini terdapat 9 efek khusus seperti : diffuse,
emboss, extrude, finde edges, glowing edges, solarize, tiles, trace countur, dan

wind.
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Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter stylize

Gambar 17.14 obyek bitmap buah.jpg
Sumber : http://www.digaleri.com
Berikut adalah beberapa contoh dari pemberian efek filter stylize pada obyek
gambar bitmap
Jenis filter stylize Gambar bitmap yang telah diberi efek
filter stylize

Wind

o wnd

Stagoer

From the Right
& From the Left
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Texture

Filter texture mempunyai fungsinya hampir sama dengan filter sketch vyaitu
memanipulasi permukaan dari suatu gambar. Jenis filter texture menghasilkan
efek tekstur pada sebuah gambar. Di dalam filter ini terdapt 6 efek yaitu :
craquelure, grain, mosaic tiles, patchwork, stained glass, dan texturizer.

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter texture

Gambar 17.15 obyek bitmap buah.jpg
Sumber : http://www.digaleri.com
Berikut adalah beberapa contoh dari pemberian efek filter texture pada obyek
gambar bitmap
Jenis filter texture Gambar bitmap yang telah diberi efek
filter texture

-y
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Jenis filter ini terdapat 2 efek khusus yaitu De-Interlace merupakan filter yang
digunakan untuk menghilangkan garis interlace yang terdapat pada gambar yang
diperoleh dari video dengan melakukan duplikasi atau interpolasi garis dan NTSC
( National Television Standars Commiteeb ). Filter video merupakan filter yang
digunakan untuk membatasi jumlah nada dengan warna yang dapat ditampilkan
oleh televisi pada sebuah ambar dengan tujuan untuk mencegah terjadinya
oversaturasi. Filter video terdiri atas

Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter video

Gambar 17.16 obyek bitmap buah.jpg

Sumber : http://www.digaleri.com
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Berikut adalah beberapa contoh dari pemberian efek filter video pada obyek

gambar bitmap

Jenis filter video Gambar bitmap yang telah diberi

efek filter video

De-Interlace

NTSC colors

Other

Pada filter kategori other terdapat 5 efek khusus yaitu : custom, high
pass, maximum, minimum, dan offset.
Dibawah ini merupakan obyek gambar bitmap buah.jpg yang belum

mendapatkan efek filter other

Gambar 17.17 obyek bitmap buah.jpg
Sumber : http://www.digaleri.com
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Berikut adalah beberapa contoh dari pemberian efek filter other pada obyek

gambar bitmap

Jenis filter other : Gambar bitmap yang telah diberi

efek filter other

High Pass
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Maximum
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c. Rangkuman

Berdasarkan uraian materi diatas dapat dibuat rangkuman sebagai berikut :

» Filter adalah fasilitas untuk memberikan efek tertentu pada obyek gambar
bitmap sehingga desain gambar yang dihasilkan akan lebih hidup .

= Tiap - tiap filter mempunyai option untuk mengatur hasilnya sesuai agar
sesuai dengan keinginan desainer grafis.

= Filter secara garis besar dibagi menjadi 13 jenis filter, yaitu : artistic, blur,
brush strokes, distort, noise, pixelate, render, sharpen, sketch, stylize,
texture, video, other

= Filter yang ada dalam dapat ditambah lagi macamnya dengan jalan
menambahkan plug-ins filter dengan cara mendownload, mengkopi atau

membeli, seperti perintah digimarc yang terdapat di menu filter.

d. Tugas
Sebelum mengerjakan tugas berikut, bentuklah kelompok belajar yang terdiri dari
2-3 orang.

1. Sebutkan sedikitnya 5 jenis efek filter yang dapat diberikan pada gambar

bitmap

2. Jelaskan fungsi efek filter yang telah anda sebutkan pada soal 1

3. Bandingkan hasil efek filter yang telah anda sebutkan pada soal 1
Kemudian presentasikan didepan kelas hasil identifikasi anda menggunakan

software presentasi
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e. Tes Formatif
1. Apakah manfaat dari penggunaan filter pada software aplikasi pengolah
gambar bitmap ?
2. Bandingkan tentang penggunaan dari efek filter artistik dan texture
terhadap gambar bitmap
3. Bagaimana menurut Anda jika suatu gambar bitmap diberi lebih dari satu
efek filter ?

f. Lembar Jawaban Tes Formatif
LJ - 01 : manfaat filter
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g. Lembar Kerja Siswa
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18. Kegiatan Belajar 18 : Menerapkan Efek filter pada Gambar
Bitmap

a. Tujuan Pembelajaran

Setelah mengikuti kegiatan belajar 18 ini siswa diharapkan dapat :
1). Memahami proses pemberian efek filter pada obyek gambar bitmap
2). Menerapkan Efek filter pada gambar bitmap
3). Menyajikan hasil pemberian efek filter pada obyek gambar bitmap

b. Uraian Materi

Seperti diterangkan dibab sebelumnya bahwa filter merupakan salah satu
fitur yang disediakan oleh aplikasi pengolah gambar bitmap photoshop untuk
memberikan efek tertentu pada obyek gambar bitmap sehingga akan menjadi
special.

Cukup banyak filter yang disediakan oleh aplikasi pengolah gambar bitmap
photoshop, dan tiap - tiap filter mempunyai option untuk mengatur hasilnya
sesuai agar sesuai dengan keinginan desainer grafis. Untuk dapat
mengaplikasikan salah satu filter maka harus dipilih dahulu bagian mana dari
gambar yang akan diberi effect, lalu bagian tersebut diseleksi.

Saat mengolah gambar bitmap fitur filter dapat dikombinasikan dengan fitur —
fitur yang lainnya, misalnya selection, pewarnaan, layer mask, quick masking,
adjusment image maupun adjusment layer dan lain sebagainya. Pada kegiatan
belajar kali akan dipelajari bagaimana cara menerapkan filter yang dipadukan

dengan fitur lainnya pada gambar bitmap.

Penerapan filter - clipping mask — adjusment layer

Clipping mask merupakan suatu fitur untuk membuat sebuah gambar
menyesuaikan dengan bentuk objek yang berada di bawahnya. Clipping Mask
dapat diberikan ke semua tipe objek diantaranya shape, gambar bitmap, maupun

teks. _
-

Gambar 18.1 clipping mask
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Untuk membuat suatu layer menjadi clipping mask tekan dapat dilakukan
dengan menekan tombol Alt dan gerakkan kursor mouse diantara “layer 1” dan
layer “clipping mask” sampai kursor berubah menjadi icon clipping mask.

Pengunaan adjusment kali ini bersifat non distruktif. Pada percobaan kali ini
akan menyajikan hasil pengolahan gambar bitmap bunga yang sebagian bungan
diberi bingkai sehingga tampak fokus, bingkai diolah menggunakan clipping
mask, obyek diluar bingkai akan nampak blur. Berikut ini adalah pengolahan
gambar bitmap filter dan clipping mask.

1. Buka gambar bitmap yang akan di edit sebagai background layer, misal
gambar bunga

2. Kemudian background layer (tekan ctrl+J) atau dengan cara klik kanann?
pada layer lalu pilih duplicate layer

v 0
.. lock: L]l 7+ @ Fil: 100‘6?}
’
QEx*ywad a
1 O a2 2 3

Gambar 18.2 duplicate layer

Layer From Sackpraund .

R —

Carvent to Sewt Qi

3. Buat layer baru di bawah /layer 1 dengan cara klik create new layer pada
bagian bawah layers palette sambil menekan Ctrl sehingga otomatis akan
membuat layer baru di bawah layer yang sedang di pilih dan beri nama

clipping mask.

lock: LI 7 0 Al e »

- "‘ Layer 1
® ' Layer 1 L
§ -
- S
® Buckground a

se fx O ©. 2 *“\3

Gambar 18.3 create new layer clipping mask
4. Pilih layer clipping mask pada layer palette dan klik Rectangle tool

atau tekan U pada keyboard. buat bentuk Rectangle pada bagian yang

ingin di fokuskan
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GEry-e

Gambar 18.4 obyek rectangle diatas gambar yang akan diolah

5. Langkah berikutnya me-clipping mask layer clipping mask dengan cara tekan
Alt dan gerakkan kursor mouse diantara “layer 1” dan layer “clipping mask”
sampai kursor berubah menjadi icon clipping mask.

6. Ketika icon clipping mask sudah muncul maka klik dengan mouse untuk
membuat clipping mask.terlihat tidak terjadi apa-apa pada image akan tetapi
pada layer palette “layer 17 akan ada tanda indent ke kanan yang berarti

telah di potong oleh vector shape di bawahnya.

1
.
(R
q_T-
® Efects

Gambar 18.5 layer dengan clipping mask

7. Pastikan layer “clipping mask” masih terpilih kemudian klik pada icon layer
styles pada bagian bawah palette dan pilih Stroke dari daftar layer styles
dan atur size sesuaikan dengan ukuran image,position set pada Inside
yang berarti border berada di dalam shape kemudian atur juga ganti color

dengan warna putih.

- Mrobe
Lyress « | Chanoels | Pate | . Wrmtere
Moy bl Nanrdos sagpy ¥ P R
Blending Options I -~ .
Ladk o, o -
r;co ,:‘.\A‘n.‘ = Do Modet  run ‘ v
- o Shadkom Opencity s w =
Outor Glows... ~
e Gom ... " Taoet | Cokoe ~
® &
Bervnd o Enviboss
> Coo
S
Color Overlay
Gradent Overtay
- ' Patem Overlyy )
~
R

Gambar 18.6 pengaturan parameter stroke
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8. Maka akan menghasilkan gambar seperti di bawah ini:

Gambar 18.7 stroke pada gambar bitmap

9. Tambahkan bayangan dengan menambahkan drop shadow pada blending
option,atur angle,distance & opacity
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Gambar 18.8 pengaturan parameter drop shadow

-

10. Gunakan free transform atau tekan Ctrl+T untuk merotasi objek “clipping
mask” dan juga menskala sesuai dengan yang di kehendaki.tekan enter jika

sudah mendapatkan skala dan rotasi yang inginkan.

Gambar 18.9 perubahan posisi bingkai
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11. Copy background layer kemudian gunakan eyedropper tool untuk mengambil
sampel warna yang nantinya akan di gunakan untuk mewarnai layer

background copy.
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Gambar 18.10 penggunaan eyedropper

12. Pilih layer background copy kemudian klik pada New adjustment layer pada
bagian bawah palette layer dan pilih Hue/saturation dan ketika muncul kotak

dialog hue/saturation centang bagian colorize.
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Gambar 18.11 pemberian efek adjusment layer
13. Dari hasil hue/saturation akan terlihat gambar bitmap seperti berikut

Gambar 18.12 hasil pengolahan hue/saturation
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14. Tetap pada layer background copy tambahkan filter blur pilih blur
radial,pada dialog box blur radial pilih zoom dan atur juga nilai amount dari

radial blur.
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Gambar 18.13 filter blur

15. Klik Ok untuk mengakhiri perintah dan terlihat hasil seperti gambar dibawah

Gambar 18.14 hasil akhir pemberian efek blur

Penerapan efek pada penggabungan gambar menggunakan filter-
adjusment-quick masking.

Pada percobaan kali ini dimulai dengan pembuatan gambar petir yang dibuat
dari layer yang diberi warna gradient kemudia diberi efek filter > difference clouds
kemudian di adjusment > invert dan ditambahkan fitur color balance untuk
memberikan efek visual petir. Setelah itu obyek petir digabung dengan gambar
sawah dimana tujuan percobaan ini seakan-akan ada petir yang menyambar
ditengah sawah. Untuk menghaluskan penggabungan kedua gambar maka perlu
dilakukan masking. Langkah detail untuk membuat efek petir adalah sebagai
berikut.
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1. Buat dokumen baru dengan ukuran 200 x 500 px. Seperti pada gambar di

bawah :

Gambar 18.15 hasil dokumen baru

2. Pastikan foreground berwarna hitam dan background berwarna putih

3. Kilik gradient tool dan klik geser menyamping, yang hasilnya seperti di

bawah ini:

Gradient
tool

Foreground &
background

Gambar 18.16 gradasi hitam putih pada obyek
4. Langkah berikutnya adalah Render dan beri efek difference clouds dengan
cara klik pada menu filter > render > difference clouds.
5. Kemudian gunakan image > adjusment > invert (Ctrl+i), maka akan

menghasilkan tampilan seperti ini :

=)

Gambar 18.17 efek filter diffrence dan adjusment cloud
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6. Atur level pada petir agar terlihat lebih jelas, caranya klik pada menu image >

adjusment > level (Ctrl+L) sehingga akan muncul menyerupai petir yang
-]

| B mret-1 © .

0

QUDut Levels:

0

Gambar 18.18 setting adjusment level
5. Atur warna petir hitam putih menjadi putih kebiruan agar lebih menarik,

dengan cara klik menu image > Adjusment > color balance (Ctrl+B) dan atur

seperti pada gambar di bawah :

Color Byance
Color Lovels: 25
Cyan
Magonta

Yollow

Tone Balance
Shadows o Mgunes
v Prasinyd Lusingany

Gambar 18.19 setting color balance
6. Buka file gambar yang akan dijadika obyek yang terkena petir, misalnya

gambar sawah dengan cara klik File > Open (Ctrl+O) dan pilih gambar.

Untuk contoh obyek sawah sibawah ini diambil dari de jong photography.

=
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.

Gambar 18.20 obyek gambar yang terkena petir
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7. Drag and drop gambar petir dengan gambar yang akan diberi efek petir
(sawah).

g

Gambar 18.21 obyek petir dan sawah
8. KIik layer obyek petir dan ganti layer mode dari normal menjadi screen.

b

creen

Layer
mode

Layer
petir

Gambar 18.22 setting I:ayer mode screen
9. Setelah layer diubah menjadi layer mode — screen maka tampilan akan
berubah seperti gambar dibawah

.~

Gambar 18.23 hasil setting layer mode screen

10. Klik quick mask 2 di pojok kanan bawah tool bar untuk merapikan obyek

petir dengan cara menyembunyika bagian yang tidak digunakan
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Layer yang terkena
Quick mask

A 5 A

Gambar 18.23 menambahkan quick mask pada layer

11. Rapikan ujung petir dengan Brush dan Eraser tool, bila ingin menggandakan
petir klik kanan pada layer 2, pilih duplicate layer ( Ctrl+J )

— ~Duplicate

laver

B

Gambar 18.24 duplicate layer
12. Atur posisi petir sampai mendapatkan komposisi dan posisi yang diinginkan,
misalnya saja seperti gambar berikut.

B ot 4 g BTN | gy S —

Gambar 18.25 hasil akhir penerapan efek petir
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Penerapan perpaduan efek filter dengan brush tool

Pada percobaan kali ini bertujuan untuk membuat efek lukisan dari sebuah
gambar bitmap. Efek lukisan ini didapat dari menu filter . ada beberapa jenis filter
yang digunakan, diantaranya adalah find edges, dry brush, texturizer. Selain fitur
filter, digunakan juga fitur layer masking, opacity layer serta brush yang berfungsi
sebagai kuas untuk melukis. Langkah detail untuk membuat efek lukisan adalah

sebagai berikut.

Gambar 18.26 gambar yang akan diedit
2. Kemudian duplikat layer ganti nama layer menjadi sket.

; L‘f'l', L} 'ch.ﬂm l "m l .‘-'| ] Layers x l ':Nﬂf't!i l pau-‘i _.'_
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Gambar 18.27 membuat layer duplikat sket
3. Klik menu Filter-> Stylize-> Find Edges.

o Is

Gambar 18.28 hasil efek filter find edges
4. Tekan tombol ctrl+shift+u, untuk memberi efek warna hitam putih
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Gambar 18.29 hasil efek hitam putih
5. Kemudian ganti Blending layer (layer mode) pada layer sket menjadi multiply

dan atur nilai opacity nya.

o [ -
| Layers x | Channets | Paths | —
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Gambar 18.30 layer multiply
6. Kembali ke layer 0, tambahkan efek dari menu Filter > Artistic > dry brush

dengan seting parameter seperti dibawah ini

Dry ne

frush Sae

Teature

Gamba 18.31 parameter dan efek dry brush

7. Buat layer baru, beri warna putih
8. Dan kemudian klik layer mask
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9. Klik pada brush tool ] pada toolbar dan load brush pilih wet media brushes,
atur diameter brush sesuai dengan gambar yang diedit

b Mager Diarvater 59 o ?
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Gambar 18.32 pilihan brush
10. Sapukan brush ke gambar bitmap pada layer lukis.
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Gambar 18.33 hasil sapuan brush layer mask pada layer brush

11. Pastikan warna foreground : hitam dan background putih.
12. Klik menu filter > texture > texturizer dengan parameter seperti berikut
fenvre: Coarrvas - »
ke 160 %
v 3
Redef 20
yone e
bno

Gambar 18.34 parameter texturizer

13. Maka akan menghasilkan output sebagai berikut
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s

Gambar 18.35 hasil akhir pemberian efek filter

c. Rangkuman
Pada kegiatan belajar yang terakhir ini dapat dibuat rangkuman materi
sebagai berikut :
= Filter merupakan salah satu fitur yang disediakan oleh aplikasi pengolah
gambar bitmap photoshop untuk memberikan efek tertentu
= Tiap filter mempunyai option untuk mengatur hasilnya sesuai agar sesuai
dengan keinginan desainer grafis
= Saat mengolah gambar bitmap fitur filter dapat dikombinasikan dengan
fitur — fitur yang lainnya, misalnya selection, pewarnaan, layer mask,
quick masking, adjusment image maupun adjusment layer dan lain
sebagainya.
= Clipping mask merupakan suatu fitur untuk membuat sebuah gambar

menyesuaikan dengan bentuk objek yang berada di bawahnya
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d. Tugas
1. Buat dan olah obyek — obyek berikut menggunakan perintah yang telah
dipelajari

Keterangan Obyek setelah di edit |

U & ~ T =
Menggunakan : http://www.photoshopessentials
- Filter >Radial blur .com/

- Layer mask

Efek menggunakan : http://www.photoshopessentials.co
- Adjusment layer - black and white | m/

- Filter - diffuse glow
- opacity

Gambar asli

Efek yang digunakan:
-filter - polar coordinates
2. Tuliskan langkah-langkah untuk menyajikan obyek tersebut pada aplikasi

pengolah presentasi
3. Presentasikan didepan kelas hasil karya anda
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e. Tes Formatif
1. Bagaimana proses penerapan filter sampai bisa memberikan efek pada
gambar?
2. Apa yang menjadi pertimbanganmu untuk memilih jenis filter yang akan
digunakan untuk memberi efek pada gambar bitmap ?
3. Apakah efek bila pada suatu layer diberikan perintah untuk clipping

mask?

f. Lembar Jawaban Tes Formatif

LJ - 01 : proses penerapan filter pada gambar bitmap
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g. Lembar Kerja Siswa
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